Installation and Upgrade Guide

R75.40

2 May 2013

Classification: [Protected]
Important Information

Latest Software
We recommend that you install the most recent software release to stay up-to-date with the latest functional improvements, stability fixes, security enhancements and protection against new and evolving attacks.

Latest Documentation
The latest version of this document is at:
(http://supportcontent.checkpoint.com/documentation_download?ID=13948)

For additional technical information, visit the Check Point Support Center (Check Point Support Center - http://supportcenter.checkpoint.com).

For more about this release, see the home page at the Check Point Support Center (http://supportcontent.checkpoint.com/solutions?id=sk67581).

Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
</table>
| 2 May 2013         | • Added: USB Installation (on page 10)  
• Deleted: references to non supported versions ("Upgrading Standalone" on page 62)  
• Updated: Description of the Export option of UnixInstallScript ("Export" on page 91) |
• Added upgrade instructions via WebUI for Standalone, Security Management Server and Security Gateway deployments on open server.  
• Updated Multi-Domain Server in place upgrade ("SecurePlatform to SecurePlatform" on page 96). Remove the media before rebooting. |
| 30 July 2012       | Updated image of SmartDomain Manager screen ("Post-Installation Configuration" on page 52).                                                                 |
| 03 June 2012       | Fixed instructions for exporting a Multi-Domain Server ("Exporting a Multi-Domain Server Deployment" on page 97).  
Added explanation about Sufficient Disk Space ("Disk Space" on page 13). |
| 08 May 2012        | General updates.  
UTM-1 removed from installation/upgrade as server only. It can be standalone or gateway. |
| 19 April 2012      | Clarified FTP server requirements for IPSO to Gaia installation and upgrade.  
Fixed filename of IPSO bootmanager in instructions for Gaia to IPSO rollback (in installation and upgrade sections). |
| 16 April 2012      | First release of this document.                                                                                                                  |

Feedback
Check Point is engaged in a continuous effort to improve its documentation.
Please help us by sending your comments
(mailto:cp_techpub_feedback@checkpoint.com?subject=Feedback on Installation and Upgrade Guide R75.40 ).
Contents

Important Information........................................................................................................3
Getting Started..................................................................................................................9
  Welcome .............................................................................................................................9
  R75.40 Documentation .....................................................................................................9
  For New Check Point Customers.....................................................................................10
  Downloading R75.40 .......................................................................................................10
  USB Installation ..............................................................................................................10
  Glossary ...........................................................................................................................10
  Compatibility Tables .......................................................................................................12
  Licensing ..........................................................................................................................12
    Software Licensing ........................................................................................................12
    Licensing Multi-Domain Security Management .........................................................13
  Disk Space .......................................................................................................................13
  Gaia Automatic Software Updates ...............................................................................13
  Deployment Options .......................................................................................................14
Installing Security Management Server and Security Gateways .........................................15
  Installing Standalone .....................................................................................................16
    Installing Standalone on Appliances ..........................................................................16
    Installing Standalone on Open Servers ....................................................................29
  Installing Security Management Server .......................................................................32
    Installing Security Management Server on Appliances .........................................32
    Installing Security Management Server on Open Servers ...................................34
  Installing Log Server .....................................................................................................36
  Installing Security Gateway ..........................................................................................37
    Installing Security Gateway on Appliances .............................................................37
    Installing Security Gateway on Open Servers .........................................................39
  Installing Full High Availability Appliances ................................................................42
    Gaia Appliances ..........................................................................................................42
    SecurePlatform Appliances ......................................................................................44
    Configuring Standalone Full High Availability .......................................................45
  Post-Installation Configuration .......................................................................................45
    Logging in to SmartConsole .......................................................................................46
    Where to Go From Here .............................................................................................46
    Uninstalling R75.40 .....................................................................................................46
Installing Multi-Domain Security Management ...................................................................47
  Basic Architecture .........................................................................................................47
  Setting Up Multi-Domain Security Management Networking .....................................48
  Installing Multi-Domain Server ....................................................................................49
    Smart-1 Appliances ......................................................................................................49
    SecurePlatform Open Servers ....................................................................................50
  Installing the Gateways .................................................................................................51
  Installing Multi-Domain Security Management GUI Clients ......................................51
  Post-Installation Configuration .......................................................................................52
    Launching the SmartDomain Manager ......................................................................52
    Adding Licenses using the SmartDomain Manager ...................................................53
    Demo Mode ..................................................................................................................53
    Uninstalling Multi-Domain Security Management ....................................................53
    Where To From Here? ................................................................................................53
Introduction to the Upgrade Process ..................................................................................54
  Contract Verification ......................................................................................................54
  Upgrade Tools .................................................................................................................54
  Using the Pre-Upgrade Verifier Tool .............................................................................54
Common Operations ................................................................. 108
Upgrading Packages ................................................................ 109
  Prerequisites for Remote Upgrades ........................................ 109
  Retrieving Data from Check Point Security Gateways ............. 109
  Adding New Packages to the Package Repository .................... 109
  Verifying the Viability of a Distribution .................................. 110
  Transferring Files to Remote Devices ..................................... 110
  Distributions and Upgrades .................................................. 110
  Upgrading UTM-1 Edge Firmware with SmartUpdate ............. 111
  Cancelling and Uninstalling .................................................. 111
  Restarting the Check Point Security Gateway ......................... 112
  Recovering from a Failed Upgrade ........................................ 112
  Deleting Packages from the Package Repository ...................... 112
Managing Licenses .................................................................. 112
  Licensing Terminology ....................................................... 113
  License Upgrade ................................................................. 114
  The License Attachment Process .......................................... 114
  Detaching Licenses ............................................................. 115
  Deleting Licenses from the License & Contract Repository ....... 115
  Viewing License Properties ................................................. 116
  Checking for Expired Licenses ............................................. 116
  Exporting a License to a File ............................................... 116
  Managing Licenses Using SmartUpdate ................................. 116
  Web Security License Enforcement ....................................... 117
Service Contracts .................................................................. 117
Generating CPInfo ................................................................. 117
The SmartUpdate Command Line .......................................... 118
Advanced Upgrade and Database Migration .............................. 119
Overview ............................................................................. 119
  Supported Upgrade Paths, Platforms and Products ................. 120
Migration Workflow .............................................................. 120
  General Workflow ............................................................. 120
  Preparing the Source Server for New IP Address .................... 121
  Getting the Migration Tools Package ................................... 122
  Using the Pre-Upgrade Verification Tool ............................... 122
  Exporting the Database ....................................................... 123
  Importing the Database ...................................................... 124
  Migrating the Database of a Secondary Security Management Server ... 125
  Completing Migration to a New IP Address ............................ 125
  Migrating to a Server with a Different Platform ...................... 125
  SmartReporter Database Migration ...................................... 126
  SmartEvent Events Database Migration .................................. 127
Migrate Command Reference .................................................. 128
Upgrading ClusterXL Deployments .......................................... 130
Planning a Cluster Upgrade .................................................... 130
  Permanent Kernel Global Variables ....................................... 130
  Ready State During Cluster Upgrade/Rollback Operations ....... 130
  Upgrading OPSEC Certified Cluster Products ......................... 131
Minimal Effort Upgrade on a ClusterXL Cluster ....................... 131
Zero Downtime Upgrade on a ClusterXL Cluster ...................... 131
  Installing a Policy during Cluster Upgrade ............................. 131
  Zero Downtime Upgrade of SecurePlatform ClusterXL to Gaia ClusterXL ... 132
Full Connectivity Upgrade on a ClusterXL Cluster .................... 132
  Understanding a Full Connectivity Upgrade .......................... 133
  Supported Modes .............................................................. 133
  Full Connectivity Upgrade Prerequisites ............................... 133
  Full Connectivity Upgrade Limitations ................................. 133
  Performing a Full Connectivity Upgrade ............................... 134
  Displaying Upgrade Statistics (cphaprob fcustat) .................... 134
Welcome

Thank you for choosing Check Point software blades for your security solution. We hope that you will be satisfied with this solution and our support services. Check Point products provide your business with the most up to date and secure solutions available today.

Check Point also delivers worldwide technical services including educational, professional, and support services through a network of Authorized Training Centers, Certified Support Partners, and Check Point technical support personnel to ensure that you get the most out of your security investment.

To extend your organization’s growing security infrastructure and requirements, we recommend that you consider adopting the OPSEC platform (Open Platform for Security). OPSEC is the industry’s open, multi-vendor security framework, which has over 350 partners and the largest selection of best-of-breed integrated applications and deployment platforms.

For additional information on the Internet Security Product Suite and other security solutions, go to: http://www.checkpoint.com or call Check Point at 1(800) 429-4391. For additional technical information, visit the Check Point Support center (Check Point Support Center - http://supportcenter.checkpoint.com).

Welcome to the Check Point family. We look forward to meeting all of your current and future network, application, and management security needs.

R75.40 Documentation

This guide is intended for administrators responsible for installing and upgrading Check Point security products on the corporate network.

Technical documentation is available on your DVD. These documents can also be found at the Check Point Support Center (Check Point Support Center - http://supportcenter.checkpoint.com). To find out about what's new in R75.40, refer to the R75 Release Notes (http://supportcontent.checkpoint.com/documentation_download?ID=13079).
For New Check Point Customers

New Check Point customers can access the Check Point User Center (http://usercenter.checkpoint.com) to:

- Manage users and accounts
- Activate products
- Get support offers
- Open service requests
- Search the Technical Knowledge Base

Downloading R75.40

You can download the R75.40 software images from the R75.40 home page (http://supportcontent.checkpoint.com/solutions?id=sk67581). There are different software images for each operating system.

To use a software image, download it and copy it to the media in one of these ways:

- Create a removable USB device (for installing SecurePlatform or Gaia).
- Burn it to a DVD.

USB Installation

You can install a SecurePlatform or Gaia appliance or open server using an ISO on a removable USB device. To create the removable device, download the Check Point ISOMorphic utility (http://supportcontent.checkpoint.com/solutions?id=sk65205).

Glossary

Check Point product names and technologies, and industry standard terms:

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Migration</td>
<td>Installing the latest Security Management Server or Multi-Domain Server version from the distribution media on separate computer and then migrating the database from the existing Security Management Server or Multi-Domain Server. This method minimizes upgrade risks for an existing deployment.</td>
</tr>
<tr>
<td>ClusterXL</td>
<td>A software-based, load sharing and high availability solution for Check Point gateway deployments. It distributes traffic between clusters of redundant gateways so that the computing capacity of multiple machines may be combined to increase total throughput. In the event that any individual gateway becomes unreachable, all connections are re-directed to a designated backup without interruption. Tight integration with Check Point's Security Management server and security gateway solutions ensures that ClusterXL deployment is a simple task for security gateway administrators.</td>
</tr>
<tr>
<td>Distributed Deployment</td>
<td>The gateway and the Security Management server are deployed on different computers.</td>
</tr>
<tr>
<td>Standalone Deployment</td>
<td>The Check Point components responsible for managing the Security Policy (the Security Management Server and the Security Gateway) are installed on the same machine.</td>
</tr>
<tr>
<td>Gateway or Check Point Gateway</td>
<td>A gateway is the software component which actively enforces the Security Policy of the organization.</td>
</tr>
</tbody>
</table>
### Term | Definition
--- | ---
**Open Server** | A computer made and distributed by a third party, such as Intel, and its operating system, such as RHEL or Windows, that is certified by Check Point to support Check Point products.

**In-Place Upgrade** | Upgrading a Security Management Server or Multi-Domain Server to the latest version on the existing computer.

**SmartProvisioning** | Enables enterprises to easily scale, deploy, and manage VPNs and security for thousands of remote locations.

**Package Repository** | A SmartUpdate repository on the Security Management server that stores uploaded packages. These packages are then used by SmartUpdate to perform upgrades of Check Point Gateways.

**SmartLSM Security Gateway** | A Remote Office/Branch Office Gateway, previously known as ROBO Gateway

**SmartLSM Profile** | (previously ROBO Profile): An object that you define to represent properties of multiple SmartLSM Security Gateways. Profile objects are version dependent. When you plan to upgrade SmartLSM Security Gateways to a new version, first define new Profile objects. In general, it is recommended that you keep the Profile objects of the previous versions until all SmartLSM Security Gateways of the previous version are upgraded.

**Security Policy** | Used to regulate the incoming and outgoing flow of communication.

**Security Management Server** | Used to manage the Security Policy. The databases and policies of the organization are stored on the Security Management server, and are downloaded from time to time to the gateways.

**SmartConsole Clients** | GUI applications used to manage different aspects of the Security Policy. For example, SmartView Tracker is a SmartConsole client used to view logs.

**SmartDashboard** | SmartConsole client that is used to create Security Policies.

**SmartUpdate** | SmartConsole client used to centrally upgrade and manage Check Point software and licenses.

### Multi-Domain Security Management specific terms:

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
</table>
**Active Domain Management Server** | In a High Availability deployment, the only Domain Management Server that can manage a specific Domain. |

**Active Multi-Domain Server** | The only Multi-Domain Server in a High Availability deployment from which you can add, change or delete global objects and global policies. By default, this is the primary Multi-Domain Server. You can change the active Multi-Domain Server. |

**Administrator** | Security administrator with permissions to manage elements of a Multi-Domain Security Management deployment. |

**Domain** | A network or group of networks belonging to a specified entity, such as a company, business unit or organization. |

**Domain Log Server** | Virtual log server for a specified Domain. |
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Objects</td>
<td>Network objects used in global policy rules. Examples of global objects include hosts, global Domain Management Servers, and global VPN communities.</td>
</tr>
<tr>
<td>Global Policy</td>
<td>Policies that are assigned to all Domains, or to specified groups of Domains.</td>
</tr>
<tr>
<td>Internal Certificate Authority (ICA)</td>
<td>Check Point component that authenticates administrators and users. The ICA also manages certificates for Secure Internal Communication (SIC) between Security Gateways and Multi-Domain Security Management components.</td>
</tr>
<tr>
<td>Multi-Domain Log Server</td>
<td>Physical log server that hosts the log database for all Domains.</td>
</tr>
<tr>
<td>Multi-Domain Security Management</td>
<td>Check Point centralized management solution for large-scale, distributed environments with many different network Domains.</td>
</tr>
<tr>
<td>Multi-Domain Server</td>
<td>Multi-Domain Security Management server that contains all system information as well as the security policy databases for individual Domains.</td>
</tr>
<tr>
<td>Primary Multi-Domain Server</td>
<td>The first Multi-Domain Server that you define and log into in a High Availability deployment.</td>
</tr>
<tr>
<td>Secondary Multi-Domain Server</td>
<td>Any subsequent Multi-Domain Server that you define in a High Availability deployment.</td>
</tr>
<tr>
<td>Standby Domain Management Server</td>
<td>In a High Availability deployment, any Domain Management Server for a specified Domain that is not designated as the active Domain Management Server.</td>
</tr>
<tr>
<td>Standby Multi-Domain Server</td>
<td>All other Multi-Domain Servers in a High Availability deployment, which cannot manage global policies and objects. Standby Multi-Domain Servers are synchronized with the active Multi-Domain Server.</td>
</tr>
</tbody>
</table>

**Compatibility Tables**

If the existing Check Point implementation contains products that are not supported by R75.40, the installation process terminates. For a list of compatible products by platform, refer to the R75.40 Release Notes (http://supportcontent.checkpoint.com/solutions?id=sk67581).

**Licensing**

Most of the software on this DVD is automatically enabled for a 15-day evaluation period. To obtain a permanent license, or to extend the evaluation period, visit the Check Point User Center (http://usercenter.checkpoint.com).

If you are new to Check Point, we recommend that you visit the Check Point User Center.

For further licensing assistance, contact Account Services (mailto:AccountServices@checkpoint.com). Or call: US +1 972-444-6600, option 5.

**Software Licensing**

If you have not yet migrated to Software Blade licenses, use the migration options from Check Point’s website (http://www.checkpoint.com/products/promo/software-blades/upgrade/index.html). Migration to
Software Blades is free of charge to purchasers of the Software Subscription service (Enterprise Base Support).

Licenses are required for management servers and Security Gateways.

Check Point software is activated using a certificate key. The certificate key is used to generate a license key for products that you want to evaluate or purchase. To purchase Check Point products, contact your reseller.

To get a license key from the Check Point User Center:
1. Add the required Check Point products/evaluations to your User Center account: select Accounts & Products > Add Products.
2. Generate a license key for your products/evaluations: select Accounts & Products > Products. Select your products and click Activate License. The selected product evaluations are assigned license keys.
3. Complete installation and configuration:
   a) Read and accept the End Users License Agreement.
   b) Import the product license key. Using the Check Point Configuration Tool or SmartUpdate to import the license. SmartUpdate lets you centrally upgrade and manage Check Point software and licenses. The certificate keys associate the product license with the Security Management server:
      - The new license remains valid even if the IP address of the Security Gateway changes.
      - Only one IP address is needed for all licenses.
      - A license can be detached from one Security Gateway and assigned to another.

**Licensing Multi-Domain Security Management**
- Multi-Domain Security Management licenses are associated with the IP address of the licensed entity.
- To add a Management domain, you must add a Domain license to Multi-Domain Security Management.
- To add a Management Software Blade to a Multi-Domain Server, you must add the required blade licenses to Multi-Domain Security Management.
- Multi-Domain Security Management licenses can be imported using the Check Point command-line licensing tool or the SmartDomain Manager.

**Disk Space**
When you install R75.40, the installation wizard makes sure that there is sufficient space on the hard disk to install the product on the computer or appliance.

If there is not sufficient space on the hard disk, an error message is shown. The message states:
- The amount of disk space necessary to install the product.
- The directory where the product is installed.
- The amount of free disk space that is available in the directory.
After there is sufficient disk space, install the product.

**Gaia Automatic Software Updates**
After you install or upgrade to R75.40 on Gaia, you can update software automatically.

Gaia automatically locates and shows the available software update packages for Check Point products and the Gaia OS. The updates packages are for minor releases and hotfixes. Only packages that are applicable to the Gaia computer are shown. The packages can be downloaded from the Check Point Support center and installed.

For instructions, see the Gaia Administration Guide (http://supportcontent.checkpoint.com/solutions?id=sk67581), "Software Updates" chapter.
Deployment Options

There are different deployment scenarios for Check Point software products.

- **Standalone Deployment** - The Security Management Server and the Security Gateway are installed on the same computer or appliance.
  
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Standalone computer</td>
</tr>
<tr>
<td></td>
<td>Security Gateway component</td>
</tr>
<tr>
<td></td>
<td>Security Management Server component</td>
</tr>
</tbody>
</table>

- **Distributed Deployment** - The Security Gateway and the Security Management Server are installed on different computers or appliances.
  
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Security Gateway</td>
</tr>
<tr>
<td>2</td>
<td>Network connection</td>
</tr>
<tr>
<td>3</td>
<td>Security Management Server</td>
</tr>
</tbody>
</table>

- **Standalone Full HA** - Security Management Server and Security Gateway are each installed on one appliance, and two appliances work in High Availability mode.
  
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Primary appliance</td>
</tr>
<tr>
<td>2</td>
<td>Direct appliance to appliance connection</td>
</tr>
<tr>
<td>3</td>
<td>Backup appliance</td>
</tr>
</tbody>
</table>

- **Bridge Mode** - Add a Security Gateway to an existing environment without changing IP Routing.
  
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 and 2</td>
<td>Switches</td>
</tr>
<tr>
<td></td>
<td>Security Gateway Firewall bridging Layer-2 traffic over the one IP address, with a subnet on each side using the same address.</td>
</tr>
</tbody>
</table>
Chapter 2

Installing Security Management Server and Security Gateways

In This Chapter

Installing Standalone 16
Installing Security Management Server 32
Installing Security Gateway 37
Installing Full High Availability Appliances 42
Post-Installation Configuration 45

Check Point software runs on many platforms and pre-configured appliances. Installations differ by deployment option, product and platform. For about supported platforms and operating systems, see the R75.40 Release Notes (http://supportcontent.checkpoint.com/solutions?id=sk67581).

⚠️ Important - If you are using a VSX deployment, you cannot upgrade your VSX Gateways or VSX clusters to R75.40.

To install VSX Gateways or clusters in an R75.40 deployment, see VSX R67 Installation and Upgrade Guide (http://supportcontent.checkpoint.com/documentation_download?ID=11689).

You can manage VSX R67 using R75.40 SmartConsole and R75.40 SmartDomain Manager.

✉️ Note - You must install, configure and activate the TCP/IP network protocol before you run the installation program.
Installing Standalone

In This Section

Installing Standalone on Appliances
Installing Standalone on Open Servers

Standalone Deployment - The Security Management Server and the Security Gateway are installed on the same computer or appliance.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Standalone computer</td>
</tr>
<tr>
<td></td>
<td>Security Gateway component</td>
</tr>
<tr>
<td></td>
<td>Security Management Server component</td>
</tr>
</tbody>
</table>

**Installing Standalone on Appliances**

You can install a Standalone deployment on UTM-1 appliances, certain 2012 Models, and IP appliances. You can install the Gaia or SecurePlatform operating system. For more about supported appliances, see the R75.40 Release Notes.

**UTM-1 and 2012 Models**

In UTM-1 and 2012 model appliances, the first step to installation is to install the operating system.

Download the R75.40 ISO file for the relevant operating system and burn it on a DVD disc. Use the ISO to do a clean install of SecurePlatform or Gaia on the appliance.

**To install R75.40 SecurePlatform or Gaia:**

2. Burn the ISO file on a DVD.
3. Turn off the appliance.
4. Connect an external DVD drive to the USB socket on the appliance.
   Make sure that the DVD with the R75.40 ISO file is in the DVD drive.
5. Connect the supplied DB9 serial cable to the console port on the front of the appliance.
6. Connect to the appliance using a terminal emulation program such as Microsoft HyperTerminal or PuTTY.
7. Configure the terminal emulation program:
   - In the HyperTerminal **Connect To** window, select a port from the **Connect using** list.
   - In PuTTY select the **Serial** connection type.
8. Define the serial port settings: 9600 BPS, 8 bits, no parity, 1 stop bit.
9. From the **Flow control** list, select None.
10. Connect to the appliance.
11. Turn on the appliance.
    The appliance begins the boot process and status messages show in the terminal emulation program.
12. Press Enter. You must press the Enter key within 90 seconds or the appliance boots from the hard drive.
    The R75.40 ISO file is installed on the appliance.
13. Reboot the appliance.
    - For Gaia - Press CTRL+C.
Installing Security Management Server and Security Gateways

- For SecurePlatform - Turn off the appliance and then turn it on again.
  
  When the model number is shown on the LCD screen, the installation process is complete.

**Gaia**

To install Check Point products on Gaia UTM-1 and 2012 model appliances, use the First Time Configuration Wizard.

![Note - The internal interface (INT) on a UTM-1 appliance is used as the management interface.]

**To start the First Time Configuration Wizard:**

1. Connect a standard network cable to the appliance management interface and to your management network.
   
   The management interface is marked **MGMT**. This interface is preconfigured with the IP address 192.168.1.1.

2. Connect to the management interface from a computer on the same network subnet.
   
   For example: IP address 192.168.1.x and net mask 255.255.255.0. This can be changed in the WebUI, after you complete the First Time Configuration Wizard.

3. To access the management interface, open a connection from a browser to the default management IP address: https://192.168.1.1

4. The login page opens. Log in to the system using the default username and password: **admin** and **admin**

5. Click **Login**.

   ![Note - The features configured in the First Time Configuration Wizard are accessible after completing the wizard using the WebUI menu. The WebUI menu can be accessed by navigating to https://<appliance_ip_address>.]

6. The **First Time Configuration Wizard** runs.

**To configure Gaia standalone appliances:**

1. In the First Time Configuration Wizard, set the password for **admin** and then click **Next**.

2. Set the date and time (manually, or enter the hostname or IP address of the NTP server) and then click **Next**.

3. Set the **host name** for the appliance.

4. **Optional:** Set the **domain name**, and IPv4 addresses for the **DNS servers**.
   
   You can use the Gaia WebUI to configure IPv6 DNS servers.

   Click **Next**.

5. Set the IPv4 address for the management interface.
   
   If you change the management IP address, the new IP address is assigned to the interface. The old IP address is added as an alias and is used to maintain connectivity.

6. **Optional:** Configure the appliance as a DHCP server.

   Click **Next**.

7. Select **Security Gateway** and **Security Management** and then click **Next**.

8. Set the username and password for the Security Management Server administrator account and then click **Next**.

9. Define the GUI Clients that can log in to the Security Management Server and then click **Next**.

10. Click **Finish** and then click **OK**.

11. If the **Help Check Point Improve Software Updates** window shows, click **Yes** or **No** as necessary.

    Gaia R75.40 is installed on the appliance.

12. If necessary, download SmartConsole from the Gaia WebUI.

    a) Open a connection from a browser to the WebUI at https://<management_ip_address>.

    b) In the **Overview** page, click **Download Now!**
SecurePlatform

Use the SecurePlatform First Time Configuration Wizard to configure the new image on the appliance.

Note - The internal interface (INT) on a UTM-1 appliance is used as the management interface.

To start the First Time Configuration Wizard:
1. Connect a standard network cable to the appliance management interface and to your management network.
   The management interface is marked MGMT.
2. Open Internet Explorer to the default management IP address, https://192.168.1.1:4434
3. Log in to the system using the default login name/password: admin/admin.
   Note - You can use the WebUI menu to configure the appliance settings. Navigate to https://<appliance_ip_address>:4434.
4. Set the username and password for the administrator account.
5. Click Save and Login.
   The First Time Configuration Wizard opens.

To configure SecurePlatform standalone:
1. In the First Time Configuration Wizard, set the date and time and then click Next.
2. Configure the settings for the management and other interfaces and then click Next.
3. Configure the settings for the routing table and then click Next.
4. Set the host name, domain name, and DNS servers and then click Next.
5. Select Locally Managed and then click Next.
6. Do not configure the appliance as part of a cluster and then click Next.
7. Set the clients that can manage the appliance using a web or SSH connection and then click Next.
8. Optional: Download SmartConsole and then click Next.
   The Summary window shows the settings for the appliance.
9. Click Finish.
   SecurePlatform R75.40 is installed on the appliance.

IP Appliances

For the IP Appliance models that are supported for this release, see the R75.40 Release Notes.

Gaia

You can install the Gaia operating system and Check Point Standalone, Security Management Server, and Security Gateway deployments on IP appliances. This section tells you how to install a Standalone deployment.

This is a clean installation. The IPSO and Check Point product configurations are not imported into Gaia.

Note - You cannot upgrade an IPSO Standalone or Security Management Server appliance to Gaia.
Preparing for Installation

Set up this environment.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1 IP Appliance with  
  - IPSO  
  - IPSO to Gaia installation package or upgrade package. |
| 2 FTP Server with a Gaia ISO image mounted. The ISO is copied to the IP Appliance as part of the installation or upgrade process. The FTP server can be Linux-based or Windows-based ("Step 2: Putting the Gaia ISO on an FTP Server" on page 21). In this example, the FTP Server is at 192.0.2.2. |
| 3 Optional: FTP Server used as a location for one or more of the following:  
  - Backup of IPSO and the Security Gateway configuration. (recommended)  
  - A special SmartUpdate package that can be to distribute the IPSO to Gaia installation and upgrade package to multiple Security Gateways.  
  - A special package that can be used to install or upgrade Security Gateways, one at a time, without having to answer any questions. This package is created using the answers supplied when running the installation and upgrade package. You can use the same FTP server as for the Gaia ISO, or a different one. In this example, the FTP Server is at 192.0.2.3. |
| 4 Computer with console access to the IP appliance and to the FTP server(s). Console access is recommended because it allows you to keep the connection to the IP Appliance throughout the installation or upgrade. If you connect via SSH you lose the connection after the IP Appliance reboots, and you will not be able to track the installation or upgrade progress. |
Installation Procedure Overview

**Important** - This is an overview of the steps, not the actual instructions. Detailed instructions follow.

**Step 1:** Get the IPSO to Gaia installation and upgrade package (tgz) and the Gaia ISO image.

**Step 2:** Put the Gaia ISO on an FTP server.

**Step 3:** Install the installation and upgrade package on the IP Appliance using Network Voyager or clish.

**Step 4:** Run the script:
- Clean install - run-install-gaia
- Upgrade - run-upgrade-to-Gaia

**Step 5:** Enter FTP server details and the ISO location. The script tests the FTP Server environment:
- a) Route to the FTP server
- b) Interface speed and duplex settings
- c) FTP access with the given credentials
- d) FTP access to the specified path
- e) Path contains the Gaia ISO and the user has Read/Write access to the directory
- f) Multiple simultaneous connections (>20) to the FTP server are allowed
- g) Timeout on FTP server is not too low
- h) FTP access to files downloaded by the Gaia boot manager

**Step 6:** Optional, but recommended: Enter data for an FTP server to hold IPSO system and configuration backup.

**Step 7:** Optional: Enter data to make a customized IPSO to Gaia upgrade package. Use this to upgrade multiple Security Gateways with SmartUpdate.
- a) Upgrade one Security Gateway with the standard IPSO to Gaia upgrade package. Enter the required data to create the special upgrade package.
- b) Upgrade all other Security Gateways simultaneously, using the special upgrade package, without more data. All IP Appliances must be able to access the same ftp servers as the first Security Gateway.

**Step 8:** Confirm your selections.

**Step 9:** The installation or upgrade package now runs automatically:
- a) If you made a backup package: The backup tar files are copied from the IP Appliance to the FTP server.
- b) If you made a customized installation or upgrade package: The package is copied from the IP Appliance to the FTP server.
- c) The Gaia image is copied from the FTP server to the IP Appliance.
- d) The Gaia image is installed.
- e) The Gaia boot manager is installed.
- f) The IP Appliance reboots.

You see the Gaia prompt on the IP Appliance.

**Step 10:** Run the First Time Configuration Wizard and select the products to install.
Step 1: Getting the Upgrade Package and the Gaia Image

   You will see two packages:
   - Gaia ISO image
   - IPSO to Gaia installation and upgrade package. The file name is Check_Point_Install_and_Upgrade_IPSO6.2_to_Gaia_R75.40.tgz

2. Prepare the installation and upgrade packages:
   Copy the packages to an FTP server, in a directory of your choice. Or transfer the packages by FTP to the IP Appliance.

Step 2: Putting the Gaia ISO on an FTP Server

Network Requirements

- **Important** - High network traffic or large transfers (more than 10/100 Mbps links) can interfere with the FTP transfers for installation.

- Make sure the appliance can reach the FTP server.
- Make sure there is no Firewall which blocks incoming FTP requests from the appliance to the FTP server.
- Configure the FTP server to allow more than 100 (or an unlimited number of) concurrent connections.
- Make sure the Gaia ISO file is mounted on a directory to which the user has access permissions.

On a Linux-based FTP Server:

1. Upload the Gaia ISO file to the FTP server
2. On the FTP server, run:
   ```bash
   mount -o loop -t iso9660 <ISO_filename> <mounting_destination_dir>
   ```

On a Windows-based FTP Server:

1. Upload the Gaia ISO file to the FTP server
2. Extract the Gaia ISO file to a folder on the FTP Server. Use 7-zip, Winzip, WinRAR or similar.
3. In the folder, run the file copyrpms.bat
   This batch file copies installation files, to give a required workaround to Windows’ inability to support soft links.
4. Give FTP credentials to the folder, so the folder can be accessed via FTP.

Step 3: Installing the Package on the IP Appliance

1. Log in to the IP Appliance using a console.
2. Run clish
   To use clish:
   - If the IPSO to Gaia package is on an FTP server, run:
     ```clish
     add package media ftp addr <FTP_IP> user <uname> password <pass> name <full_path>/Check_Point_Upgrade_Package_R75.40.IPSO6.2_to_Gaia.tgz
     ```
   - If using anonymous ftp, change `ftp` to `anonftp`.
   - If the IPSO to Gaia package is on the IP Appliance, go to the directory where the package is located, and run the clish command:
     ```clish
     add package media local name ./Check_Point_Upgrade_Package_R75.40.IPSO6.2_to_Gaia.tgz
     ```

The installation and upgrade package is installed.
Trying to install package: ./package_name.tgz

Package Information --
Name : IPSO to Gaia Upgrade
Version : <version>
Release : <Release>
Description: IPSO to Gaia Upgrade Package (<package_version>)
Package will be installed under: /opt
Package installed and activated successfully.
End of package installation.

The installation success message is Package installed and activated successfully.
The package is reported to be activated, but there are no background processes running.

4. Show the installed and active packages:

show package active

<table>
<thead>
<tr>
<th>Name</th>
<th>Ver</th>
<th>Rel</th>
<th>Dir</th>
<th>Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>{Check Point CPinfo }</td>
<td>10</td>
<td></td>
<td>/opt/CPinfo-10</td>
<td>{Check Point CPinfo}</td>
</tr>
<tr>
<td>{Check Point R70}</td>
<td>R70</td>
<td></td>
<td>/opt/CPsuite-R70</td>
<td>{Check Point R70}</td>
</tr>
<tr>
<td>{IPSO to Gaia Upgrade}</td>
<td>&lt;ver&gt;</td>
<td>&lt;rel&gt;</td>
<td>/opt/&lt;package_name&gt;</td>
<td>{IPSO to Gaia Upgrade Package (&lt;upgrade_package_version&gt;)}</td>
</tr>
</tbody>
</table>

5. Exit clish. Run: exit

Step 4: Running the Installation and Upgrade Script

1. Go to the location of the package
cd /opt/<package_name>/

2. To upgrade, run
./run-upgrade-to-Gaia
To do a clean installation, run
./run-install-Gaia

If you are upgrading multiple appliances from a special upgrade package that was previously saved, the
installation or upgrade runs automatically. Continue with Step 9 ("Step 9: Upgrade Runs Automatically"
on page 81).
If you are upgrading or installing one appliance, continue here.
The script runs. The following shows an upgrade. If you do a clean installation, the IPSO configuration is
not transferred to Gaia.
Welcome to the IPSO to Gaia Install/Upgrade procedure.

Checking platform...OK
Checking IPSO OS version ...OK
Checking hostname ... OK
Checking your configuration

Summary:
Errors:      0
Warnings:    0
Information: 14
Total Grade: 94
Details in file " /var/tmp/verify-IPSO-for-Gaia.msgs".

A newer version of this script may be available.
Contact the Check Point UserCenter at https://usercenter.checkpoint.com and see SK66569.

Do you want to continue with the upgrade ? [y] y

The following types of information are needed to prepare your IPSO appliance for the upgrade:

- info about downloading the Gaia image.
- info about transferring the verification reports (optional).
- info about transferring an IPSO backup (optional).
- info about transferring a special upgrade package with your answers (optional).

Answer the prompts for this info and then the upgrade is performed.

Hit 'Enter' to continue or Ctrl-C to exit

3. Supply the information for downloading the Gaia image

Note - If you have run the upgrade script before, the previously entered values are shown in square brackets [ ]. Press Enter to accept the values, or type in the new values and press Enter.

Step 5: Verifying the FTP Server

Enter the requested FTP server data and the path to the Gaia installation file.

<table>
<thead>
<tr>
<th>Required Directory Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>If ISO is mounted to a non-FTP directory</td>
</tr>
<tr>
<td>If ISO is mounted to /var/ftp, and FTP user account is used to install</td>
</tr>
<tr>
<td>If ISO is mounted to /var/ftp, and non-FTP user account is used to install</td>
</tr>
</tbody>
</table>

The script runs some tests to verify the FTP environment. If errors are detected, correct the FTP server configuration and then instruct the program to verify the FTP environment again.

Here is an example of a successful test:
Info for download of the Gaia image:
IP address of FTP server [192.0.2.2]:
User name [gwhite]:
Password [******]:
Directory [/mnt/fiber292]:
Performing tests of access to FTP server and Gaia ISO
Checking route to 192.0.2.2 ... OK
Interface: eth-s4p1 speed 100M, duplex full
Checking FTP access with given credentials ... OK
Checking FTP access to /mnt/fiber292 ... OK
Checking /mnt/fiber292 is Gaia ISO ... Yes
Checking multiple simultaneous connections to 192.0.2.2 ... OK
Checking timeout to 192.0.2.2 ... OK
Checking FTP access to files downloaded by Gaia boot-manager
  system/ramdisk.pxe ... OK
  system/base/stage2.img ... OK

Step 6 (Optional, Recommended): Supplying Reports and Backup Server Information

The script will request details of the FTP server to store reports and backup data. The same path-rules apply here as in Step 5 (“Step 5: Verifying the FTP Server” on page 23). The backup creates two tgz files, for:

- IPSO operating system configuration files, user directories, and log files.
- Security Gateway backup files.

Here is an example:

A complete backup of the IPSO system can performed including system configuration, user home directories, log files and files from packages.

Do you want to perform this backup? [y]

Use IP address '192.0.2.2' and user 'root' for the backup? [n]

Details for transferring the IPSO Backup:
IP address of FTP server []: 192.0.2.3
User name []: ftp
Password []: ***
Directory []: /backupdir

Checking FTP access to 192.0.2.3 (it may take a minute) ... done

Step 7: (Optional): Supplying Special Package Server Information

Enter data of the destination FTP server for the special upgrade package. Enter a destination directory, with the same rules as in Step 5 (“Step 5: Verifying the FTP Server” on page 23).

A package with your answers to the previous prompts can be created. This package can be used on other IPSO gateways for unattended conversion to Gaia.

Do you want to create such a package? [y]

Details for transferring the package with your answers:
IP address of FTP server [192.0.2.3]:
User name [ftp]:
Password [***]:
Directory [packagedir]:
Checking FTP access to 192.0.2.3 (it may take a minute) ... done

Step 8: Confirming Your Selections

You see a summary of all your answers.
Information for download of the Gaia image:
FTP Server IP Address = 192.0.2.2
FTP Server user name = root
Directory on FTP Server = /imagedir

Information for transferring the IPSO Backup:
FTP Server IP Address = 192.0.2.3
FTP Server user name = ftp
Directory on FTP Server = /backupdir

Information for transferring the package with your answers:
FTP Server IP Address = 192.0.2.3
FTP Server user name = ftp
Directory on FTP Server = /packagedir

Are these values correct? [y]

1. Click n to change the selections you made before, or type y to start the upgrade.
   The backup file and the special upgrade package file, if you chose to create them, are created.

   Writing values to file
   Performing IPSO backup (file <ipso_backup_file_name>.tgz) ... done
   Performing Check Point Security Gateway backup (file <Security
   Gateway_backup_file_name>.tgz) ... done
   Transferring IPSO and Check Point Security Gateway backup files ... done
   Creating a package with your answers (<package_name>_AUTO.tgz) ... done
   Transferring package with your answers ... done
   Installing Gaia Boot Manager ... done

2. You have 30 seconds to abort. To stop the upgrade, press Enter.
   IP appliance reboots in 30 seconds to complete the upgrade.
   Hit 'Enter' to abort.

   Important - If you want to make changes, press Enter now.
   This stops the upgrade to Gaia. To complete the upgrade to Gaia, reboot the IP
   Appliance.

Step 9: Installation Runs Automatically

The installation runs unattended.

- The IP Appliance reboots.
- The Gaia Boot Manager runs.
  Important - After reboot, the system sometimes shows the Boot Manager prompt.
  To complete installation, type INSTALL at the Boot Manager prompt, and enter the requested
  data. Installation continues.

- The Gaia image is installed.

  - The IPSO and R75.40 configurations are not imported into Gaia.
  - The Gaia prompt shows.
    Important - The HTTPS port for the WebUI is set to 443 after an installation or upgrade.
    To change this, you must use SmartDashboard > Gateway Properties > Portal Settings.
Step 10: Selecting Check Point Products

To configure Check Point products on Gaia, use the First Time Configuration Wizard. Configure the operating system and install the products in one wizard.

To configure standalone products on Gaia:
1. Using your Web browser, go to the WebUI:
   https://<Gaia management IP address>
2. In the Gaia Portal window, log in using the administrator name and password that you defined during the installation procedure.
3. The WebUI shows the First Time Configuration Wizard. Click Next.
4. Set the date and time (manually, or enter the hostname or IP address of the NTP server) and then click Next.
5. Set the host name for the appliance.
6. Optional: Set the domain name, and IPv4 addresses for the DNS servers.
   You can use the Gaia WebUI to configure IPv6 DNS servers.
   Click Next.
7. Set the IPv4 address for the management interface.
   If you change the management IP address, the new IP address is assigned to the interface. The old IP address is added as an alias and is used to maintain connectivity.
8. Optional: Configure the appliance as a DHCP server.
   Click Next.
9. Set the username and password for the Security Management Server administrator account and then click Next.
10. Select Security Gateway and Security Management and then click Next.
11. Define the GUI Clients that can log in to the Security Management Server and then click Next.
12. Click Finish and then click OK.
13. If the Help Check Point Improve Software Updates window shows, click Yes or No as necessary.

After some minutes, you can use the WebUI to configure your standalone environment.

Rollback from Gaia to IPSO

You can roll back from Gaia to IPSO 6.2. You can also restore the Check Point Security Gateway and/or Security Management Server configuration.

Before doing a rollback from Gaia to IPSO:

Make sure that:
1. The IPSO boot manager installer is available. Download it from the R75.40 home page (http://supportcontent.checkpoint.com/solutions?id=sk67581).
2. An IPSO image is available. Put the IPSO image on an FTP server, and make sure that the FTP server is accessible from the Gaia IP Appliance.
3. A backup of the Check Point Security Gateway on the Gaia IP Appliance is available. Put the backup tar file on an FTP server, and make sure the FTP server is accessible from the Gaia IP Appliance.

To roll back from Gaia to IPSO:
1. At the Gaia command line prompt, login as the administrator.
2. Go to expert mode. Type expert and supply the credentials.
3. Download the IPSO boot manager installer Check_Point_R75.40_Install_IPSOBootmanager.sh from the R75.40 home page on the Support Center.
4. Copy the IPSO boot manager installer to a location of your choice on the Gaia IP Appliance. For example, to /var/tmp.
5. Change file attributes to give executable permissions. Run chmod 777 Check_Point_R75.40_Install_IPSOBootmanager.sh
6. Install the IPSO boot manager. At the command prompt run ./Check_Point_R75.40_Install_IPSOBootmanager.sh /dev/hda
   The script asks if you want to roll back to
1. IPSO 4.2
2. IPSO 6.2

7. Choose 2

8. Type reboot

After the reboot, the system is running the IPSO boot manager.

9. At the \texttt{BOOTMGR>} prompt, install the IPSO image. Run \texttt{install}

10. Enter this data:
    - IP address of the IP Appliance.
    - Default gateway of the IP Appliance.
    - IP address of the FTP server with the IPSO image.
    - User credentials.
    - Directory path.
    - Various configuration questions (about the chassis serial number, whether the system is part of a VRRP cluster, and whether IGMP and BGP are enabled).

The system automatically reboots into IPSO.

11. Configure the IP Appliance:
    - Hostname
    - New password for \texttt{admin}
    - Enable the management port physical interface
    - IP address for the management interface
    - Default gateway

\textbf{To restore the Check Point Security Gateway configuration:}

1. Log in to the newly installed and configured IPSO IP Appliance as \texttt{admin}

2. Use FTP to transfer the backup archive file containing the Check Point Security Gateway to the IP Appliance, and then uncompress the archive. In the following example,
   - The name of the backup archive is \texttt{CP_archive_nms71_20101124.tgz}
   - The IP address of the FTP server containing the backup archive is 192.0.2.3.

   \begin{verbatim}
   cd /tmp
   ftp ftp://192.0.2.3>/pub/CP_archive_nms71_20101124.tgz
   tar xzf /tmp/CP_archive_nms71_20101124.tgz
   \end{verbatim}

3. Restore the IPSO backup file using the \texttt{set restore} CLI commands. In the following example,
   - The IP address of the FTP server containing the IPSO backup file is 192.0.2.2
   - The IPSO backup file is in the \texttt{pub} directory.

   \begin{verbatim}
   clish
   set restore remote ftp-site ftp://192.0.2.2
   set restore remote ftp-user <username e.g. anonymous> 
   set restore remote ftp-pass <password> 
   set restore remote ftp-dir pub 
   set restore remote filename i2g_backup_<hostname and timestamp>.tgz
   \end{verbatim}

   IPSO automatically reboots.

4. Log out.
5. Log in as \texttt{admin}.
6. Verify the configuration has been restored.

\textit{IPSO}

Before you begin, download the release package for your platform. Put the package on an FTP site or on a local disk.
**Important** - If you install the incorrect package, you can damage the platform.

<table>
<thead>
<tr>
<th>IP Appliance Platform type</th>
<th>Package</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk based</td>
<td>Check_Point_R75.40.IPSO6.2.tgz (<a href="http://supportcontent.checkpoint.com/solutions?id=sk67581">http://supportcontent.checkpoint.com/solutions?id=sk67581</a>)</td>
</tr>
<tr>
<td>Flash based</td>
<td>Check_Point_R75.40_Security_Gateway_for_IPSO6_2.tgz (<a href="http://supportcontent.checkpoint.com/solutions?id=sk67581">http://supportcontent.checkpoint.com/solutions?id=sk67581</a>)</td>
</tr>
</tbody>
</table>

**Note** - This package does not include CPinfo. For download information, see sk30567 (http://supportcontent.checkpoint.com/solutions?id=sk30567).

After you download the correct package to an FTP site or local disk, use Network Voyager to put the package on the appliance. In Network Voyager of the appliance, open **Configuration > System Configuration > Packages > Install Package**. Use the upload procedure that fits: FTP or local disk (the Network Voyager computer).

To upload from an FTP site:
1. In the Voyager **Install Package** window, select **FTP**.
2. Enter the name or IP address of the FTP server.
3. Enter the path to the directory on the FTP server where the packages are stored.
4. If necessary, enter the applicable user name and password.
5. Click **Apply**. The names of the available packages show in the **Site Listing** window.
6. Select the package and click **Apply**.
7. In the **Information** window, click **Install**.

To upload from a local disk:
1. In the Voyager **Install Package** window, select **Upload**.
2. Click **Browse** and navigate to the package .tgz file.
3. Click **Apply**.
4. Select the package .tgz file in the **Unpack Package** window and click **Apply**.
5. In the **Information** window, click **Upgrade**.

After you install R75.40 on an IP appliance, you must configure it. Before you begin, get the IP address of the SmartConsole (GUI client) that will connect to this server.

**To configure standalone IP appliance for the first time:**
1. From the IPSO command line, run `cpconfig`.
2. Read and accept the license agreement.
3. Select **Stand Alone**.
   - A Security Management Server and a Security Gateway will be installed on this computer. You can also install a log server.
4. On the **Configuring Licenses and Contracts** pane, press **N** to enter your licenses later (recommended) using SmartUpdate or the WebUI.
5. Add administrators accounts.
6. Add GUI clients.
7. Configure permissions.
8. Enter an administrator group name or press **Enter** to accept the default value (superuser).
9. Save the certificate fingerprint to a text file.
10. Press **Enter**.
11. Restart the computer when prompted.
12. After restart, define and install a policy for this Security Management Server.
Installing Standalone on Open Servers

A standalone deployment can be installed on any computer that meets the minimum requirements (see the Release Notes). For Gaia and SecurePlatform, first install and configure the operating system. Then install Check Point products. You can also install on Windows.

Gaia

This procedure explains how to install the Gaia operating system on an open server. Then you configure the Standalone Check Point products.

To install Gaia on an open server:
1. Start the computer using the installation DVD.
2. When the first screen shows, select Install Gaia on the system and press Enter.
3. You must press Enter in 60 seconds, or the computer will try to start from the hard drive. The timer countdown stops once you press Enter. There is no time limit for the subsequent steps.
4. Press OK to continue with the installation.
5. Select a keyboard language. English US is the default.
6. Make sure the disk space allocation is appropriate for the environment.
7. Enter and confirm the password for the admin account.
8. Select the management interface (default = eth0).
9. Configure the management IP address, net mask and default gateway. You can define the DHCP server on this interface.
10. Select OK to format your hard drive and start the installation.
11. Press reboot to complete the installation.

To configure Check Point products on Gaia, use the First Time Configuration Wizard. Configure the operating system and install the products in one wizard.

To configure standalone products on Gaia:
1. Using your Web browser, go to the WebUI: https://<Gaia management IP address>
2. In the Gaia Portal window, log in using the administrator name and password that you defined during the installation procedure.
3. The WebUI shows the First Time Configuration Wizard. Click Next.
4. Set the date and time (manually, or enter the hostname or IP address of the NTP server) and then click Next.
5. Set the host name for the appliance.
6. Optional: Set the domain name, and IPv4 addresses for the DNS servers.
   You can use the Gaia WebUI to configure IPv6 DNS servers.
   Click Next.
7. Set the IPv4 address for the management interface.
   If you change the management IP address, the new IP address is assigned to the interface. The old IP address is added as an alias and is used to maintain connectivity.
8. Optional: Configure the appliance as a DHCP server.
   Click Next.
9. Set the username and password for the Security Management Server administrator account and then click Next.
10. Select Security Gateway and Security Management and then click Next.
11. Define the GUI Clients that can log in to the Security Management Server and then click Next.
12. Click Finish and then click OK.
13. If the Help Check Point Improve Software Updates window shows, click Yes or No as necessary.
   After some minutes, you can use the WebUI to configure your standalone environment.
14. If necessary, download SmartConsole from the Gaia WebUI.
   a) Open a connection from a browser to the WebUI at https://<management_ip_address>.
b) In the Overview page, click Download Now!

Installing SecurePlatform Using the DVD

To install on SecurePlatform using the DVD:
1. Put the installation DVD into the drive and boot the computer from the DVD.
2. When the boot screen shows, press Enter to continue. You must press Enter in 90 seconds, or the computer will try to boot from the hard drive.
3. If error messages show during the hardware compatibility scan, correct the problems and then restart the procedure from step 1.
4. When the SecurePlatform Installation screen opens, do these optional steps if necessary. Select OK to continue with the installation.
   - Device List: Select to open the Hardware Scan Details window, which includes options for saving the hardware scan results. This is useful for resolving hardware compatibility issues.
   - Add Driver: Select to install a device driver from a floppy disk. Use this option only in consultation with Technical Support.
5. In the Keyboard Selection window, select a keyboard language and then select OK.
6. From the Networking Device window, select an interface to be the management interface and then select OK.
7. In the Network Interface Configuration window, define these settings for the management interface and then select OK:
   - IP address
   - Net mask
   - Default gateway
8. In the HTTPS Server Configuration window, activate or deactivate web-based connections to the WebUI. Define an IP port (default is 443) to connect to the WebUI client. Select OK.
   Note - If you are going to deploy remote access or Endpoint Security software, you must select a port other than the default value (443).
9. Select OK to format your hard drive and install SecurePlatform.
   Important - This action deletes all data on your hard drive.
   The installation program can run for a long time.
10. When the Complete window opens, remove the DVD and press Enter to reboot.

When the computer reboots, you can configure SecurePlatform and install Check Point Software Blades and products.

Installing Gateway & Management Features

To Install R75.40 on a Windows platform:
1. Log in to Windows using Administrator credentials.
2. Put the installation DVD in the drive.
   The installation wizard starts automatically.
3. Click Next in the Thank you window.
4. Accept the terms of the License Agreement and click Next.
5. Select one of these installation options:
   - New installation
   - Installation using imported configuration
     Click Next.
6. If you selected Installation using imported configuration, select the location of the imported configuration file and click Next.
   a) Select an option for obtaining the latest upgrade utilities and click Next.
b) Go to step 10.
   For more information, see Advanced Upgrade on a Windows Platform.

7. If you selected **New Installation**, select the installation type:
   - **Typical** - includes two options:
     - **Security Management and SmartConsole** - Installs and automatically configures Security Management, SmartReporter, Correlation Unit and SmartConsole. This is the standard distributed deployment.
     - **Security Management, Security Gateway and SmartConsole** - Installs and automatically configures Security Management, SmartReporter, Correlation Unit, Security Gateway and SmartConsole. This is the standard standalone deployment.
       - **Note** - Both *typical* installation options include compatibility packages that support:
         - Check Point Security Gateway 80 Series
         - Check Point UTM-1 Edge
         - Check Point NGX R65
         - Check Point R70.x and R71.x
   - **Custom** - Lets you select components to install and configure.

1. Click **Next**.
2. If you selected one of the **Typical** options, a list of the components that will be installed shows. Click **Next** and go to step 10.
3. For **Custom installations**, select the components to install:
   - Security Gateway
   - Security Management Server
     - **Note** - If you select the Security Management Server:
       * If you select Security Management Server but do not select SmartEvent and SmartReporter, Security Management Blades will be automatically installed together with Security Management.
       * If you do not select Security Management but select SmartEvent and SmartReporter Suite, Security Management will be installed and configured by default as a Log Server.
     - SmartEvent and SmartReporter
     - SmartConsole clients
     - Endpoint Security
     - Management Portal.
4. Select a destination folder to install the components and click **Next**.
   - **Note** - If required version of the Microsoft.Net framework has not been installed on the target computer, the installation program installs it automatically before installing the Check Point components.
5. If prompted, select the Security Management Server type.
6. If prompted, select the SmartEvent and Reporter Suite server types.
7. If you are installing Endpoint Security, go directly to the Installing Endpoint Security section. Otherwise, review your selections, and click **Next**.
Installing Security Management Server

In This Section

- Installing Security Management Server on Appliances
- Installing Security Management Server on Open Servers
- Installing Log Server

Distributed Deployment - The Security Gateway and the Security Management Server are installed on different computers.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Security Management Server</td>
</tr>
<tr>
<td>2</td>
<td>Network connection</td>
</tr>
<tr>
<td>3</td>
<td>Security Gateway</td>
</tr>
<tr>
<td></td>
<td>Security Gateway component</td>
</tr>
<tr>
<td></td>
<td>Security Management Server component</td>
</tr>
</tbody>
</table>

This section explains how to install the Security Management Server.

**Installing Security Management Server on Appliances**

You can install a Security Management Server on Smart-1 appliances. The appliance platform can be Gaia or SecurePlatform. For more about supported appliances, see the R75.40 Release Notes.

**Smart-1**

1. Make sure that you have the correct ISO file.
2. Install the Gaia or SecurePlatform operating system on Smart-1. See instructions in *UTM-1 and 2012 Models* (on page 16).
3. **Smart-1 50 only**: Smart-1 50 appliances have two images: Security Management Server and Multi-Domain Server. To select the Security Management Server image:
   a) While the appliance is restarting, open the terminal emulation program.
   b) When prompted, press any key to enter the boot menu.
   c) Select *Reset to factory defaults - Security Management Server* and press Enter.
   d) Type *yes* and press Enter.
   The Security Management Server image is selected for the appliance and then the appliance resets.

**Gaia**

To install the Security Management Server on Smart-1, use the First Time Configuration Wizard.

**To start the First Time Configuration Wizard:**

1. Connect a standard network cable to the appliance management interface and to your management network.
   The management interface is marked **MGMT**. This interface is preconfigured with the IP address **192.168.1.1**.
2. Connect to the management interface from a computer on the same network subnet.
For example: IP address 192.168.1.x and net mask 255.255.255.0. This can be changed in the WebUI, after you complete the First Time Configuration Wizard.

3. To access the management interface, open a connection from a browser to the default management IP address: https://192.168.1.1

4. The login page opens. Log in to the system using the default username and password: admin admin

5. Click Login.

   Note - The features configured in the First Time Configuration Wizard are accessible after completing the wizard using the WebUI menu. The WebUI menu can be accessed by navigating to https://<appliance_ip_address>.

6. The First Time Configuration Wizard runs.

To configure Gaia Security Management on appliances:

1. In the First Time Configuration Wizard, set the password for the administrator account and then click Next.

2. Set the date and time (manually, or enter the hostname or IP address of the NTP server) and then click Next.

3. Set the host name for the appliance.

4. Optional: Set the domain name, and IPv4 addresses for the DNS servers.
   You can use the Gaia WebUI to configure IPv6 DNS servers.
   Click Next.

5. Set the IPv4 address for the management interface.
   If you change the management IP address, the new IP address is assigned to the interface. The old IP address is added as an alias and is used to maintain connectivity.

6. Optional: Configure the appliance as a DHCP server.
   Click Next.

7. For the appliance type, select Smart-1 appliance and then click Next.

8. In the Products section, make sure that Security Management and Primary are selected and then click Next.

9. Set the username and password for the Security Management Server administrator account for SmartConsole clients and then click Next.

10. Define the GUI Clients that can log in to the Security Management Server and then click Next and then click OK.

11. Click Finish and then click OK.

12. If the Help Check Point Improve Software Updates window shows, click Yes or No as necessary.
   Gaia R75.40 is installed on the appliance.

13. If necessary, download SmartConsole from the Gaia WebUI.
   a) Open a connection from a browser to the WebUI at https://<management_ip_address>.
   b) In the Overview page, click Download Now!

To configure a secondary Gaia Security Management on appliances:

Do steps 1 - 10 with these changes:

- Step 4 - Use a different IP address for the management interface on the secondary appliance. Make sure that the primary and secondary appliances are on the same subnet.
- Step 7 - Make sure that Security Management and Secondary are selected.
- Define the Secure Internal Communication (SIC) Activation Key that is used by the gateway object in SmartDashboard and then click Next.
   This key is necessary to configure the appliances in SmartDashboard.

SecurePlatform

To install the Security Management Server on Smart-1 appliances, use the First Time Configuration Wizard.
To start the First Time Configuration Wizard:
1. Connect a standard network cable to the appliance management interface and to your management network.
   The management interface is marked MGMT.
2. Open Internet Explorer to the default management IP address, https://192.168.1.1:4434
3. Log in to the system using the default login name/password: admin/admin.
   *Note* - You can use the WebUI menu to configure the appliance settings. Navigate to https://<appliance_ip_address>:4434.
4. Set the username and password for the administrator account.
5. Click Save and Login.
   The First Time Configuration Wizard opens.

To configure a SecurePlatform R75.40 Security Management configuration:
1. In the First Time Configuration Wizard, set the date and time and then click Next.
2. Configure the settings for the management and other interfaces and then click Next.
3. Configure the settings for the routing table and then click Next.
4. Set the host name, domain name, and DNS servers and then click Next.
5. For Security Management installation type, select Primary Security Management and then click Next.
6. Set the clients that can manage the appliance using a web or SSH connection and then click Next.
7. Optional: Download SmartConsole and then click Next.
   The Summary window shows the settings for the appliance.
8. Click Finish.
   SecurePlatform R75.40 is installed on the appliance.

To configure a secondary SecurePlatform Security Management on appliances:
Do steps 1 - 8 above with these changes:
- Step 2 - Use a different IP address for the management interface on the secondary appliance. Make sure that the primary and secondary appliances are on the same subnet.
- Step 5 - Select Secondary Security Management.
- Define the Secure Internal Communication (SIC) Activation Key that is used by the gateway object in SmartDashboard and then click Next.
  This key is necessary to configure the appliances in SmartDashboard.

**Installing Security Management Server on Open Servers**

A Security Management Server can be installed on any computer that meets the minimum requirements (see the Release Notes). For Gaia and SecurePlatform, first install and configure the operating system. Then install Check Point products. You can also install on Linux and Windows.

**Gaia**

This procedure explains how to install a Security Management Server in a distributed deployment after you install the operating system ("Gaia" on page 29).

**To configure a Security Management Server on Gaia:**
1. Using your Web browser, go the WebUI:
   https://<Gaia management IP address>
2. In the Gaia Portal window, log in using the administrator name and password that you defined during the installation procedure.
3. The WebUI shows the First Time Configuration Wizard. Click Next.
4. Set the date and time (manually, or enter the hostname or IP address of the NTP server) and then click Next.
5. Set the host name for the appliance.
6. Optional: Set the domain name, and IPv4 addresses for the DNS servers.
You can use the Gaia WebUI to configure IPv6 DNS servers. Click Next.

7. Set the IPv4 address for the management interface. If you change the management IP address, the new IP address is assigned to the interface. The old IP address is added as an alias and is used to maintain connectivity.

8. Optional: Configure the appliance as a DHCP server. Click Next.

9. Set the username and password for the Security Management Server administrator account and then click Next.

10. Select Security Management and then click Next.

11. Define the GUI Clients that can log in to the Security Management Server and then click Next.

12. Click Finish and then click OK.

13. If the Help Check Point Improve Software Updates window shows, click Yes or No as necessary.

14. If necessary, download SmartConsole from the Gaia WebUI.

   a) Open a connection from a browser to the WebUI at https://<management_ip_address>.

   b) In the Overview page, click Download Now!

SecurePlatform

This procedure explains how to install a Security Management Server in a distributed deployment when you install the operating system ("Installing SecurePlatform Using the DVD" on page 30).

To install Security Management Server on SecurePlatform:

1. To import a product configuration file from a TFTP server, enter 1 and do the instructions on the screen. Otherwise, enter n to continue.

2. In the Welcome window, enter n to continue.

3. Enter y to accept the End User License agreement.

4. Do one of these actions:
   - New product installation - Select New Installation and then enter n.
   - Use the imported installation file - Select Installation Using Imported Configuration and then enter n.

5. Select the Check Point management Software Blade to install, and enter n.

6. In the SmartEvent window, select the components to install and enter n.

7. Enter n to enter your licenses later (recommended) using SmartUpdate or the WebUI.

8. Do the on-screen instructions to add administrators and GUI clients.


10. Restart the computer.

Windows

You can do a clean installation of Security Management Server on a Windows open server. If you have a configuration file from a supported upgrade path, you can import the configuration to the new R75.40 installation.

Note - If the required version of Microsoft.Net framework is not installed, it is installed during installation. This can take several minutes. If necessary, the Windows Imaging Component is installed during installation.

To install on Windows:

1. Log in to Windows using Administrator credentials.

2. Put the installation media in the drive. The installation wizard starts automatically.
   - Click Next.

3. Accept the License Agreement
Click **Next**.
4. Select **New installation**
5. Click **Next**.
6. Select **Custom** and click **Next**.
7. Select **Security Management** and **SmartConsole**.
8. Optional: Select **SmartEvent and Reporter Suite**.
9. Click **Next**.
10. If prompted, confirm or change the destination folder and click **Next**.
11. Select **Primary** or **Secondary Security Management as** applicable. Click **Next**.
12. Review your selections, and click **Next**.
13. Click **Finish**.
14. When prompted, restart the computer.

**To install on Windows with a configuration file:**
1. In the first window after the License Agreement, select **Installation using imported configuration** and click **Next**.
2. Select the path of the imported configuration file and click **Next**.
3. Select an option for obtaining the latest upgrade utilities and click **Next**.
4. Continue with step 6 above.

### Installing Log Server

You can install a log server for a distributed deployment. Install the operating system and start to install the products as for a Security Management Server, but stop at the step where you select components.

**To install a Log Server:**

Do the steps for installing a Security Management Server ("Installing Gateway & Management Features" on page 30) with these changes:

- In step 7, select **Security Management**.
- In step 8, do not select **SmartEvent and Reporter Suite**.
- In step 11, select **Log Server**.
Installing Security Gateway

In This Section
- Installing Security Gateway on Appliances
- Installing Security Gateway on Open Servers

Distributed Deployment - The Security Gateway and the Security Management Server are installed on different computers.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Security Management Server</td>
</tr>
<tr>
<td>2</td>
<td>Network connection</td>
</tr>
<tr>
<td>3</td>
<td>Security Gateway</td>
</tr>
<tr>
<td></td>
<td>Security Gateway component</td>
</tr>
<tr>
<td></td>
<td>Security Management Server component</td>
</tr>
</tbody>
</table>

This section explains how to install the Security Gateway.

**Installing Security Gateway on Appliances**

You can install a Security Gateway on UTM-1 appliances, Power-1 appliances, certain 2012 Models, and IP appliances. The appliance operating system can be Gaia or SecurePlatform. For more about supported appliances, see the *R75.40 Release Notes*.

**UTM-1, Power-1, and 2012 Models**

After you install the Gaia or SecurePlatform operating system (*"UTM-1 and 2012 Models"* on page 16), install the Security Gateway.

**Gaia**

To install the Security Gateway on Gaia appliances, use the First Time Configuration Wizard.

**Note** - The internal interface (INT) on a UTM-1 appliance is used as the management interface.

**To start the First Time Configuration Wizard:**

1. Connect a standard network cable to the appliance management interface and to your management network.
   
   The management interface is marked MGMT. This interface is preconfigured with the IP address 192.168.1.1.

2. Connect to the management interface from a computer on the same network subnet.
   
   For example: IP address 192.168.1.x and net mask 255.255.255.0. This can be changed in the WebUI, after you complete the First Time Configuration Wizard.

3. To access the management interface, open a connection from a browser to the default management IP address: https://192.168.1.1

4. The login page opens. Log in to the system using the default username and password: admin and ad

5. Click Login.
6. The First Time Configuration Wizard runs.

To configure Gaia Security Gateway appliances:

1. In the First Time Configuration Wizard, set the username and password for the administrator account and then click Next.
2. Set the date and time (manually, or enter the hostname or IP address of the NTP server) and then click Next.
3. Set the host name for the appliance.
4. Optional: Set the domain name, and IPv4 addresses for the DNS servers.
   You can use the Gaia WebUI to configure IPv6 DNS servers. Click Next.
5. Set the IPv4 address for the management interface.
   If you change the management IP address, the new IP address is assigned to the interface. The old IP address is added as an alias and is used to maintain connectivity.
6. Optional: Configure the appliance as a DHCP server. Click Next.
7. Select Security Gateway and then click Next.
8. Define the Secure Internal Communication (SIC) Activation Key that is used by the gateway object in SmartDashboard and then click Next.
   The Summary window shows the settings for the appliance.
9. Click Finish.
   Gaia R75.40 is installed on the appliance.

SecurePlatform

To install the Security Gateway on SecurePlatform appliances, use the First Time Configuration Wizard.

Note - The internal interface (INT) on a UTM-1 appliance is used as the management interface.

To start the First Time Configuration Wizard:

1. Connect a standard network cable to the appliance management interface and to your management network.
   The management interface is marked MGMT.
2. Open Internet Explorer to the default management IP address, https://192.168.1.1:4434
3. Log in to the system using the default login name/password: admin/admin.
   Note - You can use the WebUI menu to configure the appliance settings. Navigate to https://<appliance_ip_address>:4434.
4. Set the username and password for the administrator account.
5. Click Save and Login.
   The First Time Configuration Wizard opens.

To configure a Security Gateway on SecurePlatform appliance:

1. In the First Time Configuration Wizard, set the date and time and then click Next.
2. Configure the settings for the management and other interfaces and then click Next.
3. Configure the settings for the routing table and then click Next.
4. Set the host name, domain name, and DNS servers and then click Next.
5. Select Centrally Managed and then click Next.
6. Set the clients that can manage the appliance using a web or SSH connection and then click Next.
7. Select the type of gateway for the appliance and then click Next.
8. Define the Secure Internal Communication (SIC) **Activation Key** that is used by the gateway object in SmartDashboard and then click **Next**.
9. Click **Finish**.
   SecurePlatform R75.40 is installed on the appliance.

**IP Appliances**

**Gaia**
You can install the Gaia operating system and Check Point Security Gateway on IP appliances.
This is a clean installation. The IPSO and Check Point product configurations are not imported into Gaia.
To install, do the procedure for installing Gaia operating system and Check Point Standalone on IP appliances ("Gaia" on page 18). The only difference between the procedures is when running the First Time Configuration Wizard ("Step 10: Selecting Check Point Products" on page 26). When choosing the products to install, select **Security Gateway**. Do *not* select **Security Management**.

**IPSO**
This procedure explains how to set up an IP appliance as a Security Gateway in a distributed deployment after you install the package.

**To configure an IP appliance Security Gateway:**
1. From the IPSO command line, run `cpconfig`.
2. Read and accept the license agreement.
3. Select **Distributed**.
4. Select to install **Security Gateway**.
5. On the **Configuring Licenses and Contracts** pane, press `n` to enter your licenses later (recommended) using SmartUpdate or the WebUI.
6. Press **Enter** to complete the installation and configuration.
7. Restart the computer when prompted.

**Installing Security Gateway on Open Servers**
A Security Gateway can be installed on any computer that meets the minimum requirements (see the **Release Notes**). For Gaia and SecurePlatform, first install and configure the operating system. Then install Check Point products. You can also install on Windows.

**Gaia**
This procedure explains how to install a Security Gateway in a distributed deployment after you install the operating system ("Gaia" on page 29).

**To configure a Security Gateway on Gaia:**
1. Using your Web browser, go to the WebUI: https://<Gaia management IP address>
2. In the Gaia Portal window, log in using the administrator name and password that you defined during the installation procedure.
3. The WebUI shows the First Time Configuration Wizard. Click Next.
4. Set the date and time and then click **Next**.
5. Set the **host name, domain name**, and **DNS servers** for IPv4 addresses and then click **Next**.
6. Make sure that the IPv4 address for the management interface is correct.
7. **Optional:** Configure the appliance as a DHCP server.
   Click **Next**.
8. Select **Security Gateway**.
9. **Optional:** Configure these settings if the Security Gateway is a cluster member:
   - Select **Unit is part of a cluster**
   - Select **Cluster XL** or **VRRP** as applicable.
- Select **Primary** or **Secondary** as applicable.

Click **Next**.

10. Define the Secure Internal Communication (SIC) **Activation Key** that is used by the gateway object in SmartDashboard and then click **Next**.

The Summary window shows the settings for the appliance.

11. Click **Finish**.

Gaia R75.40 is installed on the computer.

---

### SecurePlatform

This procedure explains how to install a Security Gateway in a distributed deployment when you install the operating system ("Installing SecurePlatform Using the DVD" on page 30).

When you complete this procedure, IP forwarding is automatically disabled on the Security Gateway. A default security policy is enforced. This policy blocks all inbound connections, except for control connections. This policy is used until you install a new security policy.

**To install products on a standalone SecurePlatform computer:**

1. To import a product configuration file from a TFTP server, enter 1 and do the instructions on the screen. Otherwise, enter **n** to continue.
2. In the **Welcome** window, enter **n** to continue.
3. Enter **y** to accept the End User License agreement.
4. Do one of these actions:
   - New product installation - Select **New Installation** and then enter **n**.
   - Use the imported installation file - Select **Installation Using Imported Configuration** and then enter **n**.
5. Select the Check Point Security Gateway Software Blade to install, and enter **n**.
6. Enter **n** to enter your licenses later (recommended) using SmartUpdate or the WebUI.
7. Press **Enter**.
8. Restart the computer.

---

### Windows

You can do a clean installation of Check Point products on a Windows open server. If you have a configuration file from a supported upgrade path, you can import the configuration to the new R75.40 installation.

---

**Note** - If the required version of Microsoft.Net framework is not installed, it is installed during installation. This can take several minutes. If necessary, the Windows Imaging Component is installed during installation.

**To install on Windows:**

1. Log in to Windows using **Administrator** credentials.
2. Put the installation media in the drive.
   The installation wizard starts automatically.
   Click **Next**.
3. Accept the **License Agreement**
   Click **Next**.
4. Select **New installation**
5. Click **Next**.
6. Select **Custom** and then click **Next**.
7. Select Security Gateway and clear all other options. Click **Next** to continue.
8. If prompted, confirm or change the destination folder and then click **Next**.
9. Click **Next**.
10. Click **Finish**.
11. In the Licenses and Contracts screen, you can add a license now or use the trial period license. Make your selection and then click **Next**.

12. In the Clustering window, specify whether or not this Security Gateway is cluster member. Click **Next** to continue.

13. In the Secure Internal Communication window, enter and confirm the activation key.

14. Click **Finish**.

15. Restart the computer.

**To install on Windows with a configuration file:**

1. In the first window after the License Agreement, select **Installation using imported configuration** and click **Next**.

2. Select the path of the imported configuration file and click **Next**.

3. Select an option for obtaining the latest upgrade utilities and click **Next**.

4. Continue with step 6 above.
Installing Full High Availability Appliances

In This Section

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gaia Appliances</td>
<td>42</td>
</tr>
<tr>
<td>SecurePlatform Appliances</td>
<td>44</td>
</tr>
<tr>
<td>Configuring Standalone Full High Availability</td>
<td>45</td>
</tr>
</tbody>
</table>

Standalone Full HA - Security Management Server and Security Gateway are each installed on one appliance, and two appliances work in High Availability mode. One is active, and one is standby.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Primary appliance</td>
</tr>
<tr>
<td>2</td>
<td>Direct appliance to appliance connection</td>
</tr>
<tr>
<td>3</td>
<td>Backup appliance</td>
</tr>
</tbody>
</table>

- If the active member has a failure that affects the Security Management Server and the Security Gateway, they failover to the standby.
- If the Security Management Server on the active member experiences a failure, only the Security Management Server fails over to the standby. The Security Gateway on the first member continues to function.
- If the Security Gateway on the active member experiences a failure, only the Security Gateway fails over to the standby. The Security Management Server on the first member continues to function.

After you install the Gaia or SecurePlatform operating system ("UTM-1 and 2012 Models" on page 16), configure Standalone Full HA. First, configure each of the two standalone appliances with its First Time Configuration Wizard. Then configure the High Availability options in SmartDashboard.

Gaia Appliances

Some appliances have a dedicated SYNC interface that is used to synchronize with the other appliance. If there is no SYNC interface on the appliance, use the ETH1 interface.

*Note* - The internal interface (INT) on a UTM-1 appliance is used as the management interface.

To start the First Time Configuration Wizard:

1. Connect a standard network cable to the appliance management interface and to your management network.
   - The management interface is marked **MGMT**. This interface is preconfigured with the IP address 192.168.1.1.
2. Connect to the management interface from a computer on the same network subnet.
   - For example: IP address 192.168.1.x and net mask 255.255.255.0. This can be changed in the WebUI, after you complete the First Time Configuration Wizard.
3. To access the management interface, open a connection from a browser to the default management IP address: https://192.168.1.1
4. The login page opens. Log in to the system using the default username and password: admin and admin
5. Click **Login**.
6. The First Time Configuration Wizard runs.

To configure Gaia Full HA appliances:
1. In the First Time Configuration Wizard, set the username and password for the administrator account and then click Next.
2. Set the date and time (manually, or enter the hostname or IP address of the NTP server) and then click Next.
3. Set the host name for the appliance.
4. Optional: Set the domain name, and IPv4 addresses for the DNS servers.
   You can use the Gaia WebUI to configure IPv6 DNS servers. Click Next.
5. Set the IPv4 address for the management interface.
   If you change the management IP address, the new IP address is assigned to the interface. The old IP address is added as an alias and is used to maintain connectivity.
6. Optional: Configure the appliance as a DHCP server. Click Next.
8. Configure these Advanced settings:
   - Select Unit is part of a cluster
   - Select Cluster XL
   - Select Primary
   Click Next.
9. Set the username and password for the Security Management Server administrator account and then click Next.
10. Define the GUI Clients that can log in to the Security Management Server and then click Next.
11. Click Finish and then click OK.
12. If the Help Check Point Improve Software Updates window shows, click Yes or No as necessary.
    Gaia R75.40 is installed on the appliance.
13. Log in to the Gaia WebUI with the new management IP address that you entered in the First Time Configuration Wizard.
14. Double-click the SYNC or eth1 interface and configure the settings. This interface is used to synchronize with the other appliance. Click Apply.
15. Configure the settings for other interfaces that you are using.
16. Use a cross-over cable to connect the SYNC or eth1 interfaces on the appliances.
17. Do steps 1 - 15 again for the secondary appliance, with these changes:
   - Step 5 - It is not necessary to change the management IP address.
   - Step 7 - Select Secondary.
   - Define the Secure Internal Communication (SIC) Activation Key that is used by the gateway object in SmartDashboard and then click Next.
     This key is necessary to configure the appliances in SmartDashboard.
   - Step 14 - Use a different IP address for the SYNC or eth1 interface on the secondary appliance. Make sure that the primary and secondary appliances are on the same subnet.
18. If necessary, download SmartConsole from the Gaia WebUI.
   a) Open a connection from a browser to the WebUI at https://<management_ip_address>.
   b) In the Overview page, click Download Now!
SecurePlatform Appliances

Some appliances have a dedicated SYNC interface that is used to synchronize with the other appliance. If there is no SYNC interface on the appliance, use the ETH1 interface.

Note - The internal interface (INT) on a UTM-1 appliance is used as the management interface.

To start the First Time Configuration Wizard:
1. Connect a standard network cable to the appliance management interface and to your management network.
   The management interface is marked MGMT.
2. Open Internet Explorer to the default management IP address, https://192.168.1.1:4434
3. Log in to the system using the default login name/password: admin/admin.
   Note - You can use the WebUI menu to configure the appliance settings. Navigate to https://<appliance_ip_address>:4434.
4. Set the username and password for the administrator account.
5. Click Save and Login.
   The First Time Configuration Wizard opens.

To configure Full High Availability:
1. In the First Time Configuration Wizard, set the date and time and then click Next.
2. Configure the settings for the network connections.
   a) Click the Mgmt interface and configure the settings and then click Apply.
   b) Click the SYNC or eth1 interface and configure the settings and then click Apply. This interface is used to synchronize with the other appliance.
   c) Configure the settings for other interfaces that you are using.
      Click Next.
3. Configure the settings for the routing table and then click Next.
4. Set the host name (required), domain name (optional), and DNS servers (optional) and then click Next.
5. Select Locally Managed and then click Next.
6. Configure the appliance as the primary cluster member.
   a) Select This appliance is part of a Check Point Cluster.
   b) Select Primary cluster member.
      Click Next.
7. Set the clients that can manage the appliance using a web or SSH connection and then click Next.
8. Optional: Download SmartConsole and then click Next.
   The Summary window shows the settings for the appliance.
9. Click Finish.
   SecurePlatform R75.40 is installed on the primary appliance.
10. Use a cross-over cable to connect the SYNC or eth1 interfaces on the appliances.
11. Do steps 1 - 9 again for the secondary appliance, with these changes:
   a) Step 2b - Use a different IP address for the SYNC or eth1 interface on the secondary appliance. Make sure that the primary and secondary appliances are on the same subnet.
   b) Step 6b - Select Secondary cluster member.
   c) Define the Secure Internal Communication (SIC) Activation Key that is used by the gateway object in SmartDashboard and then click Next.
      This key is necessary to configure the appliances in SmartDashboard.
Configuring Standalone Full High Availability

After you set up the appliances for Standalone Full High Availability, configure this deployment in SmartDashboard. You must configure both cluster members before you open the cluster configuration wizard in SmartDashboard.

The LAN1 interface serves as the SYNC interface between cluster members. If not configured, SYNC interfaces are automatically set to 10.231.149.1 and 10.231.149.2. If these addresses are already in use, their values can be manually adjusted. If you manually adjust the default IP SYNC addresses, verify that both reside on the same subnet.

Note - All interfaces in the cluster must have unique IP addresses. If the same IP address is used twice, policy installation will fail. A Load on gateway failed error message is displayed.

The cluster has a unique IP address, visible to the internal network. The unique Virtual IP address makes the cluster visible to the external network, and populates the network routing tables. Each member interface also has a unique IP address, for internal communication between the cluster members. These IP addresses are not in the routing tables.

To configure Standalone Full High Availability:

1. Open SmartDashboard.
2. Connect to the primary appliance and then click Approve to accept the fingerprint as valid.
   The Security Cluster wizard opens.
   Click Next.
3. Enter the name of the Standalone Full High Availability configuration and then click Next.
4. Configure the settings for the secondary appliance.
   a) In Secondary Member Name, enter the hostname.
   b) In Secondary Member Name IP Address, enter the IP address of the management interface.
   c) Enter and confirm the SIC activation key.
   Click Next.
5. Configure the IP address of the paired interfaces on the appliances. Select one of these options:
   • Cluster Interface with Virtual IP - Enter a virtual IP address for the interface.
   • Cluster Sync Interface - Configure the interface as the synchronization interface for the appliances.
   • Non-Cluster Interface - Use the configured IP address of this interface.
   Click Next.
6. Do step 5 again for all the interfaces.
7. Click Finish.

Post-Installation Configuration

You can use the Check Point configuration tool (cpconfig) to configure settings after installation:

• Licenses and Contracts: Add or delete licenses for the Security Management Server and Security Gateways.
• Administrators: Define administrators with Security Management Server access permissions. These administrators must have Read/Write permissions to create the first security policy.
• GUI Clients: Define client computers that can connect to the Security Management Server using SmartConsole clients.
• Certificate Authority: Starts the Internal Certificate Authority, which allows makes connections between the Security Management Server and gateways. For Windows, you must define the name of the ICA host. You can use the default name or define your own. The ICA name must be in the host name.domain format, for example, ica.checkpoint.com.
• Fingerprint: Save the certificate fingerprint when you log in to SmartConsole clients for the first time.
Logging in to SmartConsole

You connect to the Security Management Server using SmartDashboard or other SmartConsole clients. Security Management Server authenticates the connection when you log in for the first time.

You can create a new certificate for future logins. For more about certificates, see the R75.40 Security Management Administration Guide (http://supportcontent.checkpoint.com/solutions?id=sk67581).

To log in to SmartConsole clients:

1. Open the SmartConsole from the Start menu.
2. Enter your credentials:
   - To use a password, enter the Security Management Server host name or IP address. Then enter your administrator user name and password.
   - To use a certificate, enter the Security Management Server host name or IP address. Then click Certificate and select the certificate.
   - To start without credentials, select Demo mode.
   - Optional: Enter a description of this session.
   - Optional: Select Read Only. This option lets you connect to the Security Management Server while other administrators are connected. You cannot change settings in this mode.
3. Click Login.
4. If necessary, confirm the connection using the fingerprint generated during installation. You see this only the first time that you log in from a client computer.

Where to Go From Here

You have learned the basics necessary to get started. Your next step is to get more advanced knowledge of your Check Point software.

Documentation is available on your Check Point DVD and on the R75.40 home page (http://supportcontent.checkpoint.com/solutions?id=sk67581).

For more technical information about Check Point products, go to the Check Point Support Center (http://supportcenter.checkpoint.com).

Uninstalling R75.40

A command line uninstall utility, available for all platforms, performs a silent uninstallation of the release on IP appliances and Windows open servers.

To uninstall the release on SecurePlatform or Gaia appliances and computers, use the built-in Backup and Restore (see "Backing Up" on page 55) functionality.

To uninstall R75.40:

<table>
<thead>
<tr>
<th>Platform</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>1. Open Start &gt; Check Point &gt; Uninstall R75.40</td>
</tr>
<tr>
<td></td>
<td>2. At the prompt, enter Y to continue.</td>
</tr>
<tr>
<td>IP appliance</td>
<td>1. Change directory to: /opt/CPUninstall/R75.40/</td>
</tr>
<tr>
<td></td>
<td>2. Run: ./UnixUninstallScript</td>
</tr>
</tbody>
</table>

If a package fails to uninstall, the script shows the log on screen.
Chapter 3

Installing Multi-Domain Security Management

In This Chapter

Basic Architecture 47
Setting Up Multi-Domain Security Management Networking 48
Installing Multi-Domain Server 49
Installing the Gateways 51
Installing Multi-Domain Security Management GUI Clients 51
Post-Installation Configuration 52

Multi-Domain Security Management is a centralized management solution for large-scale, distributed environments with many different network Domains. This best-of-breed solution is ideal for enterprises with many subsidiaries, branches, partners and networks. Multi-Domain Security Management is also an ideal solution for managed service providers, cloud computing providers, and data centers.

Centralized management gives administrators the flexibility to manage policies for many diverse entities. Security policies should be applicable to the requirements of different departments, business units, branches and partners, balanced with enterprise-wide requirements.

Basic Architecture

Multi-Domain Security Management uses tiered architecture to manage Domain network deployments.

- The **Security Gateway** enforces the security policy to protect network resources.
- A **Domain** is a network or group of networks belonging to a specified entity, such as a company, business unit, department, branch, or organization. For a cloud computing provider, one Domain can be defined for each customer.
- A **Domain Management Server** is a virtual Security Management Server that manages security policies and Security Gateways for a specified Domain.
- The **Multi-Domain Server** is a physical server that hosts the Domain Management Server databases and Multi-Domain Security Management system databases.
- The **SmartDomain Manager** is a management client that administrators use to manage domain security and the Multi-Domain Security Management system.
The Multi-Domain Servers and SmartDomain Manager are typically located at central **Network Operation Centers** (NOCs). Security Gateways are typically located together with protected network resources, often in another city or country.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>USA Development Domain</td>
</tr>
<tr>
<td>B</td>
<td>Headquarters Domain</td>
</tr>
<tr>
<td>C</td>
<td>UK Development Domain</td>
</tr>
<tr>
<td>1</td>
<td>Security Gateway</td>
</tr>
<tr>
<td>2</td>
<td>Network Operation Center</td>
</tr>
<tr>
<td>3</td>
<td>Multi-Domain Server</td>
</tr>
<tr>
<td>4A</td>
<td>USA Development Domain Management Server</td>
</tr>
<tr>
<td>4B</td>
<td>Headquarters Domain Management Server</td>
</tr>
<tr>
<td>4C</td>
<td>UK Development Domain Management Server</td>
</tr>
</tbody>
</table>

**Setting Up Multi-Domain Security Management Networking**

The Multi-Domain Server and Domain Security Gateway computers should be ready to connect to the network. The Multi-Domain Server must have at least one interface with a routable IP address. It also must be able to query a DNS server and resolve other network components.

Make sure that you configure routing to allow IP communication between:

- Domain Management Server, Domain Log Server and their Domain Security Gateways.
- All Multi-Domain Servers in the deployment.
Installing Multi-Domain Server

You can install a Multi-Domain Server on certain Smart-1 appliances or SecurePlatform computers. The appliance platform must be SecurePlatform. For more about supported appliances and platforms, see the R75.40 Release Notes.

Smart-1 Appliances

Install a Multi-Domain Server on supported Smart-1 models. Make sure that you use the Smart-1 ISO file when you install the operating system.

To install Multi-Domain Server on an appliance:
1. Install the SecurePlatform operating system on the appliance, as described for the UTM-1 and 2012 Models (on page 16).
2. While the appliance restarts, open the terminal emulation program.
3. When prompted, press any key to enter the boot menu.
4. Select Reset to factory defaults - Multi-Domain Server and press Enter.
5. Type yes and press Enter.
Multi-Domain Server is installed on the appliance and then the appliance resets.

To start the First Time Configuration Wizard:
1. Connect a standard network cable to the appliance management interface and to your management network.
The management interface is marked MGMT.
3. Log in to the system using the default login name/password: admin/admin.
   Note - You can use the WebUI menu to configure the appliance settings. Navigate to https://<appliance_ip_address>:4434.
4. Set the username and password for the administrator account.
5. Click Save and Login.
The First Time Configuration Wizard opens.

To configure Multi-Domain Server R75.40 on appliances:
1. In the First Time Configuration Wizard, set the date and time and then click Next.
2. Configure the settings for the management and other interfaces and then click Next.
3. Configure the settings for the routing table and then click Next.
4. Set the host name, domain name, and DNS servers and then click Next.
5. Set the clients that can manage the appliance using a web or SSH connection and then click Next.
6. Select Multi-Domain Server and then click Next.
7. Select Primary Multi-Domain Server and then click Next.
8. Define the Multi-Domain Server administrator that is a Multi-Domain Server Superuser and then click Apply.
   Click Next.
9. Optional: Download SmartConsole and SmartDomain Manager and then click Next.
The Summary window shows the settings for the appliance.
10. Click Finish.
   Multi-Domain Server R75.40 is installed on the appliance.
To configure a secondary Multi-Domain Server R75.40 on appliances:
Do steps 1 - 10 with these changes:

- Step 2 - Use a different IP address for the management interface on the secondary appliance. Make sure that the primary and secondary appliances are on the same subnet.
- Step 7 - Select **Secondary Multi-Domain Server**.
- Define the Secure Internal Communication (SIC) **Activation Key** that is used by the gateway object in SmartDashboard and then click **Next**.
  
  This key is necessary to configure the appliances in SmartDashboard.

To configure a Multi-Domain Server R75.40 log server on appliances:
Do steps 1 - 10 with these changes:

- Step 6 - Select **Multi-Domain Log Server**.
- Define the Secure Internal Communication (SIC) **Activation Key** that is used by the gateway object in SmartDashboard and then click **Next**.
  
  This key is necessary to configure the appliances in SmartDashboard.

**SecurePlatform Open Servers**

Install Multi-Domain Server on a dedicated SecurePlatform open server.

Configure the Multi-Domain Server when you install SecurePlatform on the open server. This procedure starts after you configure the date and time in the SecurePlatform installation.

Use this procedure to install these Multi-Domain Server types:

- Primary Multi-Domain Server - The first Multi-Domain Server that you install and log on to.
- Secondary Multi-Domain Server
- Standalone log servers - Domain Log Server or Multi-Domain Log Servers.

To install a Primary Multi-Domain Server:

1. Install the SecurePlatform operating system ("Installing SecurePlatform Using the DVD" on page 30) using the Multi-Domain Security Management DVD or ISO file.
3. In the Multi-Domain Security Management welcome screen, enter yes.
4. Select **Multi-Domain Server**.
5. Enter yes when prompted to install a Primary Multi-Domain Server.
   - You must install the **Primary Multi-Domain Server** first.
   - You can install a secondary Multi-Domain Server or a Multi-Domain Log Server later.
6. When prompted, enter yes to confirm installation of a **Primary Multi-Domain Server**.
   
   You cannot change this installation setting later.
7. At the **Are you sure** prompt, enter yes to continue.
8. When prompted, press the space bar to scroll through the license agreement and then press y.
9. If there is more than one interface on the Multi-Domain Server, enter the interface that connects Domain Management Servers to their managed networks and gateways. This is typically the management interface.
   
   You can only have one interface for this purpose.
10. In **Configuring Licenses**, enter n to continue using the 15 day trial license.
    
    We recommend that you get and attach your licenses when configuring Multi-Domain Security Management with the SmartDomain Manager.
11. In **Configuring Groups**, press Enter and then press y to assign the root user group by default. You can define groups later.
12. Press Enter to start the Certificate Authority.
13. Press y to save the certificate fingerprint to a file.
   You must define the first administrator as a **Multi-Domain Security Management Superuser**. You can
   add this administrator to a group.
   You can define more administrators, but we recommend that you use the SmartDomain Manager to do
   this later.
15. Enter `n` when prompted to add this administrator to an administrators group. You can do this later.
16. Define at least one GUI client (SmartDomain Manager) to manage this Multi-Domain Server.
17. When prompted, press **Enter**.
18. Restart the Multi-Domain Server.

**To install a secondary Multi-Domain Server:**
Do the steps in the above procedure with these exceptions:
   - In step 5, enter `no` when prompted to install a Primary Multi-Domain Server.
   - In step 6, do the action to confirm this choice.

**To install a Multi-Domain Server log server:**
Do the steps in the above procedure with these exceptions:
   - In step 4, select **Multi-Domain Log Server**.
   - In step 5, enter `no` when prompted to install a Primary Multi-Domain Server.
   - In step 6, do the action to confirm this choice.

**Installing the Gateways**
Install the Network Operation Center (NOC) and Domain gateways using R75.40 DVD.

**Installing Multi-Domain Security Management GUI Clients**
The SmartDomain Manager is automatically installed together with Check Point SmartConsole. If you have
not yet installed SmartConsole, do so now.

**To install the SmartConsole clients on Windows platforms:**
1. Insert the R75.40 distribution media or download the SmartConsole application from the Support Center
   ([http://supportcenter.checkpoint.com](http://supportcenter.checkpoint.com)).
2. If you are using the installation media, go to the `Linux\linux\windows` folder.
3. Run the **SmartConsole** executable.
4. Continue with the instructions on the screen.
Post-Installation Configuration

Use the SmartDomain Manager to configure and manage the Multi-Domain Security Management deployment. Make sure to install SmartDomain Manager on a trusted GUI Client. You must be an administrator with appropriate privileges (Superuser, Global Manager, or Domain Manager) to run the SmartDomain Manager.

To start the SmartDomain Manager:
1. Click Start > All Programs > Check Point SmartConsole R75.40 > SmartDomain Manager.
2. Enter your credentials:
   - To use a password, enter the Multi-Domain Server host name or IP address. Then enter your administrator user name and password.
   - To use a certificate, enter the Multi-Domain Server host name or IP address. Then click Certificate and select the certificate.
   - To start without credentials, select Demo mode.
   - Optional: Enter a description of this session.
3. Click Login.
   SmartDomain Manager connects to the Multi-Domain Server. When SmartDomain Manager opens, it shows the network objects and options that you have permission to work with.
4. If necessary, confirm the connection using the fingerprint generated during installation.
   You see this only the first time that you log in from a client computer.

Launching the SmartDomain Manager

To start the SmartDomain Manager:
1. Click Start > All Programs > Check Point SmartConsole R75.40 > SmartDomain Manager.
2. Optional: Select Demo mode.
3. If you are not using the Demo mode:
   a) Enter the SmartDomain Manager host name or IP address.
   b) Do one of these authentication steps:
      ▪ Enter an administrator name and password.
      ▪ Click Certificate and then select or navigate to the applicable certificate.
   c) Optional: Enter a session description in the applicable field.
4. Click Login.
   - The SmartDomain Manager connects to the Multi-Domain Server.
The SmartDomain Manager opens, showing all network objects and menu commands that you have permission to work with.

5. If necessary, confirm the connection using the fingerprint generated during installation. This only occurs the first time that you log in to a Security Management Server or SmartDomain Manager from a client computer.

**Adding Licenses using the SmartDomain Manager**

You can add a license to a Multi-Domain Server or Multi-Domain Log Server using the SmartDomain Manager.

1. In the SmartDomain Manager, open the General View > Multi-Domain Server Contents page.
2. Double-click a Multi-Domain Server or Multi-Domain Log Server. The Multi-Domain Server Configuration window opens.
3. Open the License tab.
4. Install licenses using Fetch or Add:
   - **Fetch License File**
     a) Click Fetch From File.
     b) In the Open window, browse to and double-click the desired license file.
   - **Add License Information Manually**
     a) Click Add.
     b) In the email message that you received from Check Point, select the entire license string (starting with 'cplic ...' and ending with the last SKU/Feature) and copy it to the clipboard.
     c) In the Add License window, click Paste License to paste the license details you have saved on the clipboard into the Add License window.
     d) Click Calculate to display your Validation Code. Compare this value with the validation code that you received in your email. If validation fails, contact the Check Point licensing center, providing them with both the validation code contained in the email and the one displayed in this window.

**Demo Mode**

You can open the SmartDomain Manager in Demo mode. This mode does not require authentication or a connection to the Multi-Domain Server. Use the Demo mode to experiment with different objects, views, modes and features before you create a production system. The Demo mode includes several pre-configured sample Domains, Domain Management Servers, Security Gateways and policies.

Operations performed in Demo mode are stored in a local database. You can continue a Demo session from the point at which you left off in a previous session.

**Uninstalling Multi-Domain Security Management**

To uninstall a Multi-Domain Server on SecurePlatform
1. Back up the databases if you want to reinstall the Multi-Domain Server on this or another computer.
2. Reformat the hard disk or re-install a Multi-Domain Server from the DVD.

To uninstall the SmartDomain Manager and SmartConsole applications:
- Use Add/Remove Programs to uninstall the clients.

**Where To From Here?**

Check Point documentation provides additional information and is available in PDF format on the Check Point DVD as well as on the Check Point Support Center (Check Point Support Center - http://supportcenter.checkpoint.com).
Chapter 4

Introduction to the Upgrade Process

In This Chapter

Contract Verification 54
Upgrade Tools 54
Using the Pre-Upgrade Verifier Tool 54
Upgrading Successfully 55
Uninstalling Packages 55
Backing Up 55
Restoring a Deployment 57
Service Contract Files 60

Before you upgrade:

- For information about supported upgrade paths, see the R75 Release Notes (http://supportcontent.checkpoint.com/documentation_download?ID=13079).
- Make sure that you have the latest version of this document (http://supportcontent.checkpoint.com/documentation_download?ID=13948).

Contract Verification

Contract verification is now an integral part of the Check Point licensing scheme. Before upgrading to the latest version, your licensing agreements are verified through the User Center.

See: Service Contract Files (on page 60) for more information.

Upgrade Tools

Various upgrade tools are provided for migration and compatibility verification of your current deployment. These tools help you successfully upgrade to R75.40.

The upgrade tools can be found in the R75.40 directory $FWDIR/bin/upgrade_tools.

The upgrade tools can also be downloaded from the Check Point Support site (http://supportcenter.checkpoint.com).

Using the Pre-Upgrade Verifier Tool

The Pre-upgrade Verifier runs automatically during the upgrade process. You can also run it manually with this command.

Syntax:

pre_upgrade_verifier.exe -p ServerPath -c CurrentVersion (-t TargetVersion | -i) [-f FileName] [-w]

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-p</td>
<td>Path of the installed Security Management Server (FWDIR)</td>
</tr>
</tbody>
</table>
## Introduction to the Upgrade Process

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-c</td>
<td>Currently installed version</td>
</tr>
<tr>
<td>-t</td>
<td>Target version</td>
</tr>
<tr>
<td>-i</td>
<td>If -i is used, only the INSPECT files are analyzed, to see if they were customized.</td>
</tr>
<tr>
<td>-f</td>
<td>Output report to this file</td>
</tr>
<tr>
<td>-w</td>
<td>Output report to a web format file</td>
</tr>
</tbody>
</table>

### Upgrading Successfully

Note that:

- Only Check Point Suite Products from version NGX R65 and above can be upgraded to R75.40.
- When upgrading NGX R65, only the following Plug-ins may be present: Connectra, SmartProvisioning, VSX, and Messaging Security. The presence of any other Plug-in will cause the upgrade process to fail.
- When upgrading a Security Management Server to R75.40, IPS profiles will remain in effect on pre-R70 gateways and can be managed from the IPS tab.
- When upgrading a Security Gateway to R75.40, remember to change the gateway's object in SmartDashboard to version R75.40. The gateway will continue to enforce the previously configured IPS profile, but the inspection will be conducted using the new IPS inspection engine. You can apply an R75.40 IPS profile to the upgraded gateway at any time.

If you encounter unforeseen obstacles during the upgrade process, contact your Reseller or consult the Support Center (Check Point Support Center - http://supportcenter.checkpoint.com).

### Uninstalling Packages

Some upgrade procedures require an uninstall of certain packages. You must uninstall Check Point packages in the opposite order from which they were installed. For example, CPsuite is the first package installed, so it is the last package uninstalled.

To see a list of the installed packages:

- SecurePlatform: `rpm -e <package name>`
- Windows: Use the Control Panel > Add / Remove Programs utility

### Backing Up

Before you upgrade, it is recommended to back up the Security Management Servers and Security Gateways. Use the tools appropriate for each platform.

Use the snapshot mechanism if it is available. SecurePlatform on an open server does not have snapshot, so use backup instead.

### Windows and IP Appliance Export

Before you upgrade a Windows computer or IP appliance, back up the current configuration.

Use the Export utility tool of the version for which you are creating a backup file. The backup file has the current system configuration (for example, objects, rules, and users).

**Note** - Operating system configurations (for example, network configuration) are not exported.

If upgrade ends with issues, you can restore the computers and appliances with the Import utility.
To back up your current deployment:
1. In the original Security Management server, insert the product DVD for the version you are backing up.
2. Select the Export option in the installation wizard, or use the Export tool located in the relevant operating system directory on the product DVD.
   Once the Export utility process is complete, the configuration file is created in the chosen destination path in a tar gzip format (.tgz).

   **Important** - The configuration file (.tgz) contains your product configuration. We recommend you delete it after completing import.

### SecurePlatform Backup Command

SecurePlatform has a command line or Web GUI utility for backups of your system settings and product configuration. The backup utility can store backups locally on the Security Management Server, or remotely to a TFTP server or an SCP server. You can run the backup manually, or schedule backups.

The backups are TGZ files. When saved locally, the default path is: `/var/CPbackup/backups`

Backup and Restore commands require expert permissions.

**Syntax:**

```plaintext
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-h</td>
<td>See help on the command</td>
</tr>
<tr>
<td>-d</td>
<td>Debug flag</td>
</tr>
<tr>
<td>-l</td>
<td>Enables VPN log backup (by default, VPN logs are not backed up)</td>
</tr>
<tr>
<td>--purge</td>
<td>Deletes older backup files, from the number of days given</td>
</tr>
<tr>
<td>--sched</td>
<td>Schedule backups</td>
</tr>
<tr>
<td></td>
<td>• On - enter time and day of week, or date of month</td>
</tr>
<tr>
<td></td>
<td>• Off - disable schedule</td>
</tr>
<tr>
<td></td>
<td>Example: --sched on 03:00 1</td>
</tr>
<tr>
<td>--tftp</td>
<td>Back up to TFTP. Enter IP addresses of TFTP servers</td>
</tr>
<tr>
<td></td>
<td>Optional: -path pathname of backup on TFTP</td>
</tr>
<tr>
<td></td>
<td>Example: --tftp 192.0.2.3 -path /var/backups/mybckup.tgz</td>
</tr>
<tr>
<td>--scp</td>
<td>Back up to SCP. Enter IP addresses of SCP servers, username (with access to SCP server), password, and optionally the filename</td>
</tr>
<tr>
<td></td>
<td>Example: --scp 192.0.2.4 usr 123 mybckup.tgz</td>
</tr>
<tr>
<td>--file</td>
<td>For local backups, enter an optional filename, or -path parameter and pathname</td>
</tr>
</tbody>
</table>

### SecurePlatform Snapshot Image Management

You can back up the entire SecurePlatform operating system and installed configuration with the snapshot command. A snapshot is made automatically during upgrade with the SafeUpgrade option. You can take a snapshot manually with the snapshot command.
The **snapshot** and **revert** commands can use a TFTP server or an SCP server to store snapshots. Snapshots can also be stored locally.

**Syntax:**

```
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-h</td>
<td>See help on the command</td>
</tr>
<tr>
<td>-d</td>
<td>Debug flag</td>
</tr>
<tr>
<td>--tftp</td>
<td>Back up to TFTP. Enter IP addresses of TFTP servers. Optional: -path pathname of backup on TFTP. Example: <code>--tftp 192.0.2.3 -path /var/backups/mybckup.tgz</code></td>
</tr>
<tr>
<td>--scp</td>
<td>Back up to SCP. Enter IP addresses of SCP servers, username (with access to SCP server), password, and optionally the filename. Example: <code>--scp 192.0.2.4 usr 123 mybckup.tgz</code></td>
</tr>
<tr>
<td>--file</td>
<td>For local backups, enter an optional filename, or -path parameter and pathname</td>
</tr>
</tbody>
</table>

**Restoring a Deployment**

There are different ways to restore a deployment or revert a snapshot. Use the one that fits the backup you made.

**To restore a deployment with an export file:**

1. Copy the `exported.tgz` file to the target Security Management server.
2. In the Security Management server, insert the product DVD for the version being restored.
3. Using the available options, install using an imported configuration file.

**SecurePlatform Revert**

If you saved a snapshot of a SecurePlatform appliance or computer, you can revert the entire system image. The revert command run without parameters, uses default settings, and restarts the system from a local snapshot.

**To revert to an earlier version (R70 or R6X):**

1. Before upgrading to the newer version, take a snapshot.
2. Copy the snapshot file from `/var/CPsnapshot/snapshots` to an external server.
3. Reinstall the machine with the relevant software (R70 or R6X).
4. Copy the snapshot file taken in step 1 above to `/var/CPsnapshot/snapshots` using TFTP, FTP or SCP server.
5. Use the Revert command to restore your configuration.

**To revert to snapshots of later versions, run the revert command.**

**Syntax:**

```
revert [-h] [-d] [(--tftp <Server IP> <Filename>) | (--scp <Server IP> <Username> <Password> <Filename>) | --file <Filename>]]
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>-h</td>
<td>Obtain usage</td>
</tr>
<tr>
<td>-d</td>
<td>Debug flag</td>
</tr>
</tbody>
</table>
Introduction to the Upgrade Process

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| --tftp    | Revert from snapshot on TFTP server  
Enter IP address of the server and filename of the snapshot |
| --scp     | Revert from snapshot on SCP server  
Enter IP address of the server, username, password, and filename of the snapshot |
| --file    | Revert from local snapshot  
Enter the filename of the snapshot |

The revert command functionality can also be accessed from the **Snapshot image management** boot option.

**SecurePlatform Restore**

SecurePlatform has a command line or Web GUI utility for backups of your system settings and product configuration. The **backup** utility can store backups locally on the Security Management Server, or remotely to a TFTP server or an SCP server. You can run the backup manually, or schedule backups.

The backups are TGZ files. When saved locally, the default path is: `/var/CPbackup/backups`

Backup and Restore commands require expert permissions.

**Syntax:**
```
restore [-h] [-d] [(--tftp <Server IP> <Filename>) | (--scp <Server IP> <User name> <Password> <Filename>) | --file <Filename>]
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>-h</td>
<td>See help on the command</td>
</tr>
<tr>
<td>-d</td>
<td>Debug flag</td>
</tr>
</tbody>
</table>
| --tftp    | Restore from a file on a TFTP server  
Enter the TFTP server IP address and the filename of the backup file |
| --scp     | Restore from a file on a SCP server  
Enter the SCP server IP address, username, password, and filename of the backup file |
| --file    | Restore from a local file  
Enter the filename of the backup file |

For more about the **backup** and **restore** utilities, see the **System Commands** section in the **R75.40 SecurePlatform Administration Guide** (http://supportcontent.checkpoint.com/solutions?id=sk67581).

**Restoring Other Platforms**

You can restore a computer to a version that was active before it was upgraded to R75.40. This will uninstall the last active version only, and leave the previously installed version as the now-active version.

**To an Earlier Version on an IP Appliance**

You can revert to an earlier version that is compatible with IPSO version 6.2, such as R70 or R71.

**Note** - The **clish** shell cannot be used on a system that was previously accessed by Network Voyager or another user, because the system is locked. To unlock the system, run: `set config-lock on override`

**To revert to an earlier version on an IP appliance using Voyager:**
1. Go to Configuration > System Configuration > Packages > Manage Packages.
2. Clear the **Enable** checkbox for the current package, Check Point R75.40 and click **Apply**.
3. Click the link **Click to check the status of the operation**.
   There is no check in the checkbox.

4. In the **Enable** column, select:
   - All packages that have the required version number in the package name
   - Any required compatibility packages suitable for the reverted version

5. Click **Apply**.

6. Click the link **Click to check the status of the operation**. There is no check in the checkbox.
   The revert starts.

7. Upon completion, a success message appears.

8. Save the configuration. At the bottom of the page, click **Save**.

9. Reboot the appliance.

**To revert to an earlier version on an IP appliance using the CLI:**

1. At the CLI command prompt, run: `clish`
2. Run: `show package active`
3. To set the active package to inactive, run: `set package name <directory_name> off`
   
   For example:
   `set package name /opt/CPsuite-R71 off`

4. To revert to a previous package, run: `set package name <directory_name> on`
   
   For example:
   `set package name /opt/CPsuite-R65 on`

5. When prompted, reboot the appliance.

**To an Earlier Version on a Windows Open Server**

**To restore to an earlier version on a Windows platform:**

1. In Add/Remove Programs, select **Check Point <product> R75.40**.
2. Click **Remove**.
   
   The latest version is uninstalled, and the previous version is active.

**ICA Considerations**

When a computer or appliance installation is restored, certificates issued during the use of R75.40 remain valid. But they cannot be processed by the Internal CA.

**To resume management of older certificates after the Revert process:**

1. Back up the **InternalCA.NDB and ICA.crl files** (located in the `$FWDIR/conf` directory) and all
   `*.crl` files (located in the `$FWDIR/conf/crl` directory) from the version prior to R75.40 to a suitable
   location.

2. Copy the R75.40 **InternalCA.NDB, ICA.crl and the `*.crl` files** (located in the `$FWDIR/conf` directory)
   from the current R75.40 version and use them to overwrite the files in the location specified in
   the `$FWDIR/conf` directory).
   
   **Note** - If the Upgrade process was performed on a machine that runs a different
   operating system than the original machine, the InternalCA.NDB file must be
   converted after it is copied to the reverted environment. To do this, run the
   `cpca_dbutil d2u` command from the reverted environment.

3. When the Revert process is complete, use the ICA Management Tool to review certificates created
   using R75.40 in the reverted environment. For example, the subject to which a specific certificate was
   issued may no longer exist. In such a case, you may want to revoke the specific certificate.
Service Contract Files

Introduction

Before upgrading a gateway or Security Management Server to R75.40, you need to have a valid support contract that includes software upgrade and major releases registered to your Check Point User Center account. The contract file is stored on Security Management Server and downloaded to Security Gateways during the upgrade process. By verifying your status with the User Center, the contract file enables you to easily remain compliant with current Check Point licensing standards.

Working with Contract Files

As in all upgrade procedures, first upgrade your Security Management Server or Multi-Domain Server before upgrading the gateways. Once the management has been successfully upgraded and contains a contract file, the contract file is transferred to a gateway when the gateway is upgraded (the contract file is retrieved from the management).

Note - Multiple user accounts at the User Center are supported.

Installing a Contract File

On Gaia, SecurePlatform and Windows

When upgrading Security Management server, the upgrade process checks to see whether a contract file is already present on the server. If not, the main options for obtaining a contract are displayed. You can download a contract file or import it.

If the contract file does not cover the Security Management server, a message on Download or Import informs you that the Security Management server is not eligible for upgrade. The absence of a valid contract file does not prevent upgrade. Download a valid contract at a later date using SmartUpdate.

- Download a contracts file from the User Center
  If you have Internet access and a valid user account, download a contract file directly from the User Center. This contract file conforms to the terms of your licensing agreements. If you choose to download contract information from the User Center, you are prompted to enter your:
  - User name
  - Password
  - Proxy server address (if applicable)

- Import a local contract file
  If the server does not have Internet access:
  a) On a machine with Internet access, log in to the User Center (http://usercenter.checkpoint.com).
  b) Click Support in the top menu.
  c) Click Additional Services in the secondary menu.
  d) In the Service Contract File Download section, click Download Now.
  e) Transfer the downloaded file to the management server. After selecting Import a local contracts file, enter the full path to the location where you stored the file.

- Continue without contract information
  Select this option if you intend to get and install a valid contract file at a later date. Note that at this point your gateway is not strictly eligible for an upgrade; you may be in violation of your Check Point Licensing Agreement, as shown in the final message of the upgrade process.

On IPSO

Contract verification on IPSO is not interactive. When upgrading an IPSO Security Management server to R70, the upgrade process will check to see if there is a valid contract already present on the Security
Management server. If a contract is not present, the upgrade process proceeds as normal. After successfully upgrading the gateway, the following message is displayed:

The upgrade process requires a valid contract file in order to verify that your gateway complies with Check Point licensing agreements. While the absence of a contract file does not prevent this upgrade, it is recommended that you obtain a contract file via SmartUpdate (Licenses & Contracts menu -> Update Contracts).

For further details see: http://www.checkpoint.com/ngx/upgrade/contract/

At the earliest opportunity, obtain a valid contract file from the Check Point user center.

**On Security Gateways**

After you accept the End User License Agreement (EULA), the upgrade process searches for a valid contract on the gateway. If a valid contract is not located, the upgrade process attempts to retrieve the latest contract file from the Security Management server. If not found, you can download or import a contract.

If the contract file does not cover the gateway, a message informs you (on Download or Import) that the gateway is not eligible for upgrade. The absence of a valid contract file does not prevent upgrade. When the upgrade is complete, contact your local support provider to obtain a valid contract. Use SmartUpdate to install the contract file.

Use the download or import instructions for installing a contract file on a Security Management Server.

If you continue without a contract, you install a valid contract file later. But the gateway is not eligible for upgrade. You may be in violation of your Check Point Licensing Agreement, as shown in the final message of the upgrade process. Contact your reseller.
Upgrading Standalone Appliances

You can upgrade a Standalone deployment on UTM-1 appliances, certain 2012 Models, and IP appliances.

UTM-1 and 2012 Models

When you upgrade the Check Point release version on the appliance you can also upgrade from SecurePlatform to Gaia. Alternatively, you can upgrade Check Point release version and stay with the SecurePlatform operating system.

SecurePlatform to Gaia

Note - When upgrading from SecurePlatform to Gaia, the size of the disk partitions does not change. To have larger disk partitions, you need to do a clean installation of Gaia.

You can upgrade from the SecurePlatform operating system to the Gaia operating system.

To upgrade a SecurePlatform appliance:

1. Upgrade product licenses to R75 or higher, and attach the licenses to the appliance.
2. Download the appliance upgrade package.
   Check_Point_upg_WEBUI_and_SmartUpdate_R75.40.Gaia.tgz
3. Connect to the SecurePlatform appliance from a Web browser to https://<appliance_ip_address>.
4. In the login page, enter an administrator username and password.
5. Go to the Upgrade page.
6. Upload the appliance upgrade package to the appliance.
7. Ignore any warning messages.
8. Continue according to the on-screen instructions.
   After the upgrade is complete, the appliance boots to Gaia.

Note - The connection to the SecurePlatform WebUI closes after Gaia is installed.
9. Install the Policy on the Security Gateway. This is highly recommended. The Security Gateway enforces the Initial Policy until you install the Policy:
   a) Using SmartDashboard of the correct version, connect to the Security Management Server.
   b) Open the General Properties page of the Gateway object.
   c) Click Get to update the Platform details.
   d) Install the policy on the Gateway.

If the Gaia appliance has more than 4 GB of memory, it automatically boots to the 64-bit edition. Otherwise, it boots to the 32-bit edition.

If you upgrade and the appliance has more than 4 GB, the appliance boots to the 32-bit edition. You can configure Gaia to automatically boot to the 64-bit edition.

**To configure Gaia to automatically boot to the 64-bit edition:**
1. Run `set edition default 64-bit`
2. Run `save config`
3. Reboot

   **Note** - The appliance must have at least 6 GB of memory for this to work.

**To see which edition is running:**
- Go to the WebUI System Overview pane. The edition shows in the System Overview widget.
  or
- Run: `show version os edition`

**SecurePlatform to SecurePlatform**

Use the WebUI of the appliance to upgrade Standalone UTM-1 and 2012 Model appliances.

**To upgrade appliances using the WebUI:**
1. Open Internet Explorer and log in to the appliance.
2. Select Appliance > Upgrade.
3. Click Check Point Download Center.
   The Internet browser opens to the Check Point Support Center.
4. Search for and download the R75.40 upload package file.
5. In the WebUI, click **Upload upgrade package to appliance**.
   The **Upload Package to Appliance** window opens.
6. Select the upgrade file:
   `Check_Point_upg_WEBUI_and_SmartUpdate_R75.40.SecurePlatform.tgz`
7. Click **Upload**.
8. Click **Start Upgrade**.
9. Before the upgrade begins, an image is created of the system and is used to revert to in the event the upgrade is not successful.
   The **Save an Image before Upgrade** page, displays the image information.
   Click **Next**.
10. In the **Safe Upgrade** section, select **Safe upgrade** to require a successful login after the upgrade is complete. If no login takes place within the configured amount of time, the system will revert to the saved image.
    Click **Next**.
11. The **Current Upgrade File on Appliance** section displays the information of the current upgrade.
12. To begin the upgrade, click **Start**.

**Upgrading Standalone Open Servers**

Before you upgrade:
• Back up your current configuration (see "Backing Up" on page 55).
• See the Release Notes to make sure that you have enough disk space (http://supportcontent.checkpoint.com/solutions?id=sk67581).

SecurePlatform to Gaia
Use this procedure to upgrade a SecurePlatform computer on to a Gaia computer. Upgrade the operating system and the installed products.

Note - When upgrading from SecurePlatform to Gaia, the size of the disk partitions does not change. To have larger disk partitions, you need to do a clean installation of Gaia.

To upgrade an open server using the DVD:
1. Upgrade your product licenses to R75 or higher, and attach the licenses to the Security Gateway or standalone server.
2. Insert R75.40 DVD into the drive.
3. At the command prompt, enter: patch add cd
4. Select the Gaia upgrade package.
5. Confirm the MD5 checksum.
6. If relevant, when prompted, create a backup image for automatic revert.
7. After extracting files, the Installation program opens.
8. Accept the license agreement.
9. Select upgrade.
10. Configure your contract options.
    You can also continue without contract information and configure it later using SmartUpdate.
11. Select a source for the upgrade utilities.
    Wait for the pre-upgrade verifier to complete successfully.
12. Select Stop Check Point processes.
13. Select Upgrade installed products, or upgrade installed products and add new products, and confirm.
14. Wait while the required installation files are extracted.
    a) Part one of the upgrade procedure saves data and upgrades the operating system.
    b) Part two upgrades Check Point products.
15. After the upgrade completes successfully, remove the DVD from the drive.
16. Reboot when prompted.
17. Install the Policy on the Security Gateway. This is highly recommended. The Security Gateway enforces the Initial Policy until you install the Policy:
    a) Using SmartDashboard of the correct version, connect to the Security Management Server.
    b) Open the General Properties page of the Gateway object.
    c) Click Get to update the Platform details.
    d) Install the policy on the Gateway.

To upgrade a SecurePlatform Open Server using the WebUI:
1. Open Internet Explorer and log in to the SecurePlatform WebUI.
2. Select Device > Upgrade.
3. Click Check Point Download Center.
    The Internet browser opens to the Check Point Support Center.
4. Search for and download the R75.40 file for upgrades via the WebUI.
5. Click Browse and select the upgrade file: Check_Point_upg_WEBUI_and_SmartUpdate_R75.40.Gaia.tgz
6. Click Upload package to device.
    The package is uploaded to the SecurePlatform computer.
After the Upgrade Status shows that the Uploading is Completed you can start the upgrade.

7. **Recommended:** In the Safe Upgrade section, click Save snapshot of the current system before the upgrade. The snapshot is used to revert the system if the upgrade is not successful.

8. Click Start Upgrade.
   Follow the Upgrade Status. After the upgrade, the computer automatically reboots.
   
   **Note** - The connection to the SecurePlatform WebUI closes after Gaia is installed.

9. Install the Policy on the Security Gateway. This is highly recommended. The Security Gateway enforces the Initial Policy until you install the Policy:
   a) Using SmartDashboard of the correct version, connect to the Security Management Server.
   b) Open the General Properties page of the Gateway object.
   c) Click Get to update the Platform details.
   d) Install the policy on the Gateway.

### SecurePlatform to SecurePlatform

Use this procedure to upgrade a SecurePlatform installation on the same computer. Upgrade the operating system and the installed products.

**To upgrade a SecurePlatform Open Server using a DVD:**
1. Insert R75.40 DVD into the drive.
2. At the command prompt, enter: `patch add cd`
4. Press y to accept the checksum calculation.
5. Optional: When prompted, create a backup image so that you can restore the old version.
   
   **Note** - Creating the snapshot image can take a long time. Check Point products are stopped during this time.
6. Press N at the welcome message.
7. Press Y to accept the license agreement.
8. In the next window, select Upgrade and then press N.
9. In the next window, press N to continue.
10. If prompted to download or import a valid support contract, select Continue without contract information. Press N to continue.
11. If a message shows that says your gateway is not eligible for upgrade, press N to continue.
    You can safely ignore this message and use SmartUpdate to update your service contract later.
12. In the next window, select Download most updated files.
13. In the Pre-Upgrade Verification Results window, press N to continue.
    If the Pre-Upgrade Verification fails, do the suggested steps to correct the problem. Start this procedure again from step 2.
14. When prompted, select Stop Check Point processes and press N to continue.
15. When prompted, select Upgrade installed products and press N to continue.
16. In the Validation window, press N.
17. When the upgrade completes successfully, restart the computer.

**To upgrade a SecurePlatform Open Server using the WebUI:**
1. Open Internet Explorer and log in to the SecurePlatform WebUI.
2. Select Device > Upgrade.
3. Click Check Point Download Center.
   The Internet browser opens to the Check Point Support Center.
4. Search for and download the R75.40 file for upgrades via the WebUI.
5. Click Browse and select the upgrade file: `Check_Point_upg_WEBUI_and_SmartUpdate_R75.40.SecurePlatform.tgz`
6. Click **Upload package to device**.  
The package is uploaded to the SecurePlatform computer.  
After the **Upgrade Status** shows that the **Uploading** is **Completed** you can start the upgrade.

7. **Recommended**: In the **Safe Upgrade** section, click **Save snapshot of the current system before the upgrade**. The snapshot is used to revert the system if the upgrade is not successful.  
Your browser will automatically try to perform the first login immediately after the upgrade. To allow this, do not close the browser window or browse to another page.

8. Click **Start Upgrade**.  
Follow the **Upgrade Status**. After the upgrade, the computer automatically reboots.

9. Install the Policy on the Security Gateway. This is highly recommended. The Security Gateway enforces the Initial Policy until you install the Policy:
   a) Using SmartDashboard of the correct version, connect to the Security Management Server.
   b) Open the **General Properties** page of the Gateway object.
   c) Click **Get** to update the **Platform** details.
   d) Install the policy on the Gateway.

**Windows to Windows**

Use this procedure to upgrade a Windows installation on the computer. Upgrade the installed products.

**To upgrade a Windows standalone computer:**
1. Insert the R75.40 DVD into the drive. The Installation Wizard starts automatically.  
   If the wizard does not start automatically, manually run setup.exe from the DVD drive.
2. Click **Next** at the welcome message.
3. Accept the license agreement and click **Next**.
4. Select **Upgrade** and click **Next**.
5. On the next screen, click **Next**.
6. If prompted to download or import a valid support contract, select **Continue without contract information**. Click **Next** to continue.
7. If a message shows that says your gateway is not eligible for upgrade.  
   You can safely ignore this message and use SmartUpdate to update your service contract later. Click **Next**.
8. Select **Download most updated files** and click **Next**.
9. In the **Pre-Upgrade Verification Results** window, click **Next**.  
   If the Pre-Upgrade Verification fails, do the suggested steps to correct the problem. Start this procedure again from step 2.
10. When prompted to add new products, clear **Add new products** and then click **Next**.  
    You can add new products at a later time.
11. Click **Next** at the confirmation message.
12. When the installation completes successfully, click **Finish**.
13. When prompted, restart the computer.

**Upgrading the Security Management Server**

You do not have to upgrade the Security Management server and all of the gateways at the same time.  
When the Security Management server is upgraded, you can still manage gateways from earlier versions (though the gateways may not support new features).

⚠️ **Important** - To upgrade to R76 Gaia, there must be at least 4GB free disk space in `/var/log`. 

---

Installation and Upgrade Guide R75.40 | 66
Use the Pre-Upgrade Verification tool to reduce the risk of incompatibility with your existing environment. The Pre-Upgrade Verification tool generates a detailed report of the actions to take before an upgrade (see "Using the Pre-Upgrade Verifier Tool" on page 54).

There are different upgrade methods for the Security Management server:

- Upgrade Production Security Management server
- Migrate and Upgrade to a New Security Management server ("Advanced Upgrade and Database Migration" on page 119)

⚠️ Important - After upgrade, you cannot restore a version with a database revision that was made with the old version. You can see old version database saves in Read-Only mode.

### Upgrading Security Management Server on Appliances

You can upgrade a Security Management Server on some Smart-1 appliances, 2012 Models and open servers.

#### Smart-1 and 2012 Models

**SecurePlatform to Gaia**

 FileNotFoundError - When upgrading from SecurePlatform to Gaia, the size of the disk partitions does not change. To have larger disk partitions, you need to do a clean installation of Gaia.

You can upgrade from the SecurePlatform operating system to the Gaia operating system.

**To upgrade a SecurePlatform appliance:**

1. Upgrade product licenses to R75 or higher, and attach the licenses to the appliance.
2. Download the appliance upgrade package.
   
   `Check_Point_upg_WEBUI_and_SmartUpdate_R75.40.Gaia.tgz`

3. Connect to the SecurePlatform appliance from a Web browser to
   
   `https://<appliance_ip_address>`

4. In the login page, enter an administrator username and password.
5. Go to the **Upgrade** page.
6. Upload the appliance upgrade package to the appliance.
7. Ignore any warning messages.
8. Continue according to the on-screen instructions.
   
   After the upgrade is complete, the appliance boots to Gaia.

   **Note** - The connection to the SecurePlatform WebUI closes after Gaia is installed.

9. Install the Policy on the Security Gateway. This is highly recommended. The Security Gateway enforces the Initial Policy until you install the Policy:
   
   a) Using SmartDashboard of the correct version, connect to the Security Management Server.
   b) Open the **General Properties** page of the Gateway object.
   c) Click **Get** to update the **Platform** details.
   d) Install the policy on the Gateway.

**SecurePlatform to SecurePlatform**

Use the WebUI of the appliance to upgrade Security Management Server Smart-1 and 2012 Model appliances.

**To upgrade appliances using the WebUI:**

1. Open Internet Explorer and log in to the appliance.
2. Select **Appliance > Upgrade**.
3. Click **Check Point Download Center**.
   
   The Internet browser opens to the Check Point Support Center.
4. Search for and download the R75.40 upload package file.
5. In the WebUI, click **Upload upgrade package to appliance**.
   The **Upload Package to Appliance** window opens.
6. Select the upgrade file:
   Check_Point_upg_WEBUI_and_SmartUpdate_R75.40.SecurePlatform.tgz
7. Click **Upload**.
8. Click **Start Upgrade**.
9. Before the upgrade begins, an image is created of the system and is used to revert to in the event the upgrade is not successful.
   The **Save an Image before Upgrade** page, displays the image information.
   Click **Next**.
10. In the **Safe Upgrade** section, select **Safe upgrade** to require a successful login after the upgrade is complete. If no login takes place within the configured amount of time, the system will revert to the saved image.
    Click **Next**.
11. The **Current Upgrade File on Appliance** section displays the information of the current upgrade.
12. To begin the upgrade, click **Start**.

### IP Appliances

You must use a disk-based appliance. Flash-based IP appliances do not support Security Management Server installation.

### IPSO to IPSO

For the IP Appliance models that are supported for this release, see the **R75.40 Release Notes**. After you download the correct package to an FTP site or local disk, use Network Voyager to put the package on the appliance. In Network Voyager of the appliance, open **Configuration > System Configuration > Packages > Install Package**. Use the upload procedure that fits: FTP or local disk (the Network Voyager computer).

To upload from an FTP site:
1. In the Voyager **Install Package** window, select **FTP**.
2. Enter the name or IP address of the FTP server.
3. Enter the path to the directory on the FTP server where the packages are stored.
4. If necessary, enter the applicable user name and password.
5. Click **Apply**. The names of the available packages show in the **Site Listing** window.
6. Select the package and click **Apply**.
7. In the **Information** window, click **Install**.

To upload from a local disk:
1. In the Voyager **Install Package** window, select **Upload**.
2. Click **Browse** and navigate to the package .tgz file.
3. Click **Apply**.
4. Select the package .tgz file in the **Unpack Package** window and click **Apply**.
5. In the **Information** window, click **Upgrade**.

To upgrade Security Management Server with Network Voyager:
1. Click the **Click here to install/upgrade** link to continue with the installation.
2. In the **Package Installation and Upgrade** pane, select **Upgrade** and then click **Apply**.
3. Click the **Install Package** branch in the Voyager tree to see the installation progress.
4. Go to the **Manage Packages** page.
   - The R75.40 and Check Point CPInfo packages are automatically activated during installation (disk-based appliances only).
   - Enable other packages, with the compatibility packages, as needed for your deployment.
Upgrading Security Management Server and Security Gateways

**Important** - When you install a package using Network Voyager, this message shows:

Voyager environment has been updated with the latest package info.
The telnet session environment will be updated by: logging out and logging in again the telnet session.

This message can be misleading. Click **Manage Packages** to verify that the package is actually installed correctly. Refresh the page periodically until you see that the installation is complete.

5. Log out of Network Voyager and then log in again.

**To upgrade Security Management Server with clish:**
1. Access the CLI console, and log in.
2. Type `newpkg`, and press Enter.
3. Use the FTP menu option to transfer the R75.40 package. Choose the option:
   
   Upgrade from an old package.

4. Upgrade to the R75.40 package.
   
   Wait until a message informs you that the process is complete.

5. Type `reboot` and press Enter.
   
   The package is activated after the reboot.

**To verify that R75.40 is active and is the current version:**
1. Verify that R75.40 is active. Run `newpkg -q`
2. Verify that R75.40 is the current version. Run `fw ver` on a Security Gateway or `fwm ver` on a Security Management server.

**Upgrading Security Management Server on Open Servers**

A Security Management Server on any computer that meets the minimum requirements can be upgraded. You can upgrade from SecurePlatform to Gaia, or you can upgrade the SecurePlatform version. On a Windows Security Management Server, you can upgrade the installed Check Point products.

**Before you upgrade:**

It is recommended to back up your current configuration (see "Backing Up" on page 55).

**SecurePlatform to Gaia**

Use this procedure to upgrade the SecurePlatform operating system to Gaia, and to upgrade the installed products.

**Note** - When upgrading from SecurePlatform to Gaia, the size of the disk partitions does not change. To have larger disk partitions, you need to do a clean installation of Gaia.

**To upgrade Security Management Server on Gaia open servers:**
1. Upgrade product licenses to R75 or higher, and attach the licenses to the appliance.
2. Connect a DVD drive to the USB port on the computer.
3. Run: `patch add cd`
4. Select the Gaia upgrade package.
5. Confirm the MD5 checksum.
6. When prompted, create a backup image for automatic revert.
   
   After extracting files, the Installation program opens.

7. Accept the license agreement.
8. Select **upgrade**.
9. Configure your contract options.
   
   You can also continue without contract information and configure it later using SmartUpdate.
10. Select a source for the upgrade utilities.<br>   Wait for the pre-upgrade verifier to complete successfully.
11. Select **Stop Check Point processes**.
12. Select **Upgrade installed products**, or **upgrade installed products and add new products**, and confirm.
13. Wait while the required installation files are extracted.<br>   a) Part one of the upgrade procedure saves data and upgrades the operating system.<br>   b) Part two upgrades Check Point products.
14. After the upgrade completes successfully, remove the DVD from the drive.
15. Restart when prompted.
16. Install the Policy on the Security Gateway. This is highly recommended. The Security Gateway enforces the Initial Policy until you install the Policy:<br>   a) Using SmartDashboard of the correct version, connect to the Security Management Server.<br>   b) Open the **General Properties** page of the Gateway object.<br>   c) Click **Get** to update the **Platform** details.<br>   d) Install the policy on the Gateway.

**To upgrade a SecurePlatform Open Server using the WebUI:**
1. Open Internet Explorer and log in to the SecurePlatform WebUI.
2. Select **Device** > **Upgrade**.
3. Click **Check Point Download Center**.<br>   The Internet browser opens to the Check Point Support Center.
4. Search for and download the R75.40 file for upgrades via the WebUI.
5. Click **Browse** and select the upgrade file: Check_Point_upg_WEBUI_and_SmartUpdate_R75.40.Gaia.tgz
6. Click **Upload package to device**.<br>   The package is uploaded to the SecurePlatform computer.<br>   *After the Upgrade Status shows that the Uploading is Completed you can start the upgrade.*
7. **Recommended:** In the **Safe Upgrade** section, click **Save snapshot of the current system before the upgrade**. The snapshot is used to revert the system if the upgrade is not successful.
8. Click **Start Upgrade**.<br>   Follow the **Upgrade Status**. After the upgrade, the computer automatically reboots.
   *Note* - The connection to the SecurePlatform WebUI closes after Gaia is installed.

**Security Management Server Upgrade - SecurePlatform**
Upgrading to R75.40 on a SecurePlatform operating system requires updating both the operating system and the installed software products using the CLI.

For a list of supported upgrade paths, see the **R75 Release Notes** (http://supportcontent.checkpoint.com/documentation_download?ID=13079).

The process described in this section upgrades all of the components (Operating System and software packages) in a single upgrade process. No further upgrades are required. Refer to the **R75 SecurePlatform Administration Guide** (http://supportcontent.checkpoint.com/documentation_download?ID=11666) for additional information.

To go back to your previous configuration is required, see Reverting to Your Previous Deployment (see "Restoring Other Platforms" on page 58) for details.

**To upgrade SecurePlatform:**
1. Insert the R75.40 DVD into the optical drive.<br>2. At the command prompt, enter `patch add cd`.
3. Select **SecurePlatform R75.40 Upgrade Package** (CPspupgrade_<version_number>.tgz).
4. Enter \textit{y} to accept the checksum calculation.

5. When prompted, create a backup image for automatic revert.

\begin{itemize}
\item \textbf{Note} - Creating the snapshot image can take up to twenty minutes, during which Check Point products are stopped.
\end{itemize}

6. The \textbf{Welcome} message is displayed. Enter \textit{n}.

7. Accept the license agreement, and verify your contract information.

\begin{itemize}
\item \textit{Note} - Creating the snapshot image can take up to twenty minutes, during which Check Point products are stopped.
\end{itemize}

8. Three upgrade options are displayed: Upgrade, Export the configuration, and Perform pre-upgrade verification only.

\begin{itemize}
\item a) Run the pre-upgrade verification script, and follow the recommendations contained in the pre-upgrade verification results. Repeat the process until you see \textit{Your configuration is ready for upgrade}.
\item b) Export the configuration.
\item c) Upgrade the installation.
\end{itemize}

9. Select a source for the upgrade utilities.

Either download the most updated files from the Check Point website or use the upgrade tools contained on the DVD. The exported configuration is automatically imported during the upgrade process.

10. Open SmartUpdate and attach new licenses to the gateways.

\section*{Security Management Server Upgrade on Windows Platforms}

This section describes the upgrade process using the R75.40 DVD. It is recommended to back up your current configuration before you perform the upgrade process. For additional information, refer to: Backup and Revert for Security Gateways (see "Backing Up" on page 55). To go back to your previous configuration is required, see Reverting to Your Previous Deployment (see "Restoring Other Platforms" on page 58) for details.

To perform an upgrade on a Windows platform:

\begin{enumerate}
\item Insert the R75.40 DVD.
\item If the upgrade does not start automatically, run Setup.exe from the DVD.
\item Click \textit{Next} to start the installation wizard.
\item Accept the license agreement and click \textit{Next}.
\item Click \textit{Next} to check your license information.
\item From the Upgrade Options screen, select \textbf{Upgrade} and click \textit{Next}.
\item Follow the support contract and upgrade utility screens. For more information on contracts, see: Installing a Contract File on Security Management server (see "Installing a Contract File" on page 60).
\item When the pre-upgrade verification recommendation appears, select whether or not the Pre-upgrade verification tool should be executed (refer to Using the Pre-Upgrade Verification Tool). Pre-upgrade verification performs a compatibility analysis of the currently installed Security Management server and of its current configuration. A detailed report is provided, indicating appropriate actions that should be taken before and after the upgrade process. The tool can be used manually as well.
\item Indicate whether to add new products by selecting the \textbf{Add new products} checkbox and click \textit{Next}.
\item \textbf{Note} - When upgrading the Security Management server, SmartReporter is installed by default if it did not previously exist.
\item Depending on the components you have chosen to install, you many need to install other components. Follow the instructions.
\item A list of the products that will be upgraded appears. Click \textit{Next}.
\item The new components are installed and the Security Management server is upgraded. The progress of each component is indicated in the progress bar. Upon completion, a summary appears.
\end{enumerate}
Note - In Windows Server 2003, if Microsoft.Net framework 2.0 has not been installed on the machine, it will be installed automatically before installation of the Check Point components.

12. Follow the instructions for license management and fingerprint handling.
13. Click Finish.

Upgrading Security Gateways

You can upgrade Security Gateways using one of these methods:

- **SmartUpdate**: Centrally upgrade and manage Check Point software and licenses from a SmartConsole client.
- **Local Upgrade**: Do a local upgrade on the Security Gateway itself.

Upgrading Gateways using SmartUpdate

SmartUpdate is the primary tool used for upgrading Check Point gateways. The following features and tools are available in SmartUpdate:

- **Upgrade All Packages**: This feature upgrades all packages installed on a gateway. For IPSO and SecurePlatform, this feature also upgrades your operating system as a part of the upgrade procedure. The SmartUpdate "Upgrade all Packages" option supports HFAs, i.e., it will suggest upgrading the gateway with the latest HFA if a HFA package is available in the Package Repository. "Upgrade All" is the recommended method. In addition, there is an advanced method to install (distribute) packages one by one.

- **Add Package to Repository**: SmartUpdate provides three "helper" tools for adding packages to the Package Repository:
  - **From CD/DVD**: Adds a package from the Check Point DVD.
  - **From File**: Adds a package that you have stored locally.
  - **From Download Center**: Adds a package from the Check Point Download Center.

- **Get Check Point Gateway Data**: This tool updates SmartUpdate with the current Check Point or OPSEC third-party packages installed on a specific gateway or for your entire enterprise.

- **Check for Updates**: This feature, available from the SmartDashboard **Tools** menu, locates the latest HFA on the Check Point Download Center, and adds it to the Package Repository.

Configuring the Security Management Server for SmartUpdate

To configure the Security Management server for SmartUpdate:

1. Install the latest version of SmartConsole, including SmartUpdate.
2. Define the remote Check Point gateways in SmartDashboard (for a new Security Management server installation).
3. Verify that your Security Management server contains the correct license to use SmartUpdate.
4. Verify that the Administrator SmartUpdate permissions (as defined in the cpconfig configuration tool) are **Read/Write**.
5. To enable SmartUpdate connections to the gateways, make sure that Policy Global Properties > FireWall > Firewall Implied Rules > Accept SmartUpdate Connections (SmartUpdate) is selected. By default, it is selected.

Add Packages to the Package Repository

Use SmartUpdate to add packages to and delete packages from the Package Repository:

- directly from the Check Point Download Center website (**Packages > Add > From Download Center**),
- by adding them from the Check Point DVD (**Packages > Add > From CD/DVD**),
• by importing a file (Packages > Add > From File).

When adding the package to the Package Repository, the package file is transferred to the Security Management server. When the Operation Status window opens, you can verify the success of the operation. The Package Repository is then updated to show the new package object.

**Gateway Upgrade - SmartUpdate**

To update a gateway using SmartUpdate:

1. From SmartUpdate > Packages > Upgrade All Packages select one or more gateways and click Continue.
   The Upgrade All Packages window opens, and in the Upgrade Verification list you can see which gateways can or cannot be upgraded.
   • To see a list of which packages will be installed on the gateways that can be upgraded, select the gateway and click the Details button.
   • For an explanation as to why a gateway cannot be upgraded, select the relevant gateway and click the Details button.

2. From the list provided, select the gateways that can be upgraded and click Upgrade.

   **Note** - The Allow reboot option (selected by default) is required in order to activate the newly installed packages.

The Operation Status pane opens and shows the progress of the installation. Each operation is represented by a single entry. Double click the entry to open the Operation Details window, which shows the operation history.

The following operations are performed during the installation process:

- The Check Point Remote Installation Daemon connects to the Check Point gateway.
- Verification for sufficient disk space.
- Verification of the package dependencies.
- The package is transferred to the gateway if it is not already there.
- The package is installed on the gateway.
- Enforcement policies are compiled for the new version.
- The gateway is rebooted if the Allow Reboot option was selected and the package requires it.
- The gateway version is updated in SmartDashboard.
- The installed packages are updated in SmartUpdate.

**Upgrading Security Gateways on Appliances**

**UTM-1, Power-1, and 2012 Models**

*SecurePlatform to Gaia*

You can upgrade from the SecurePlatform operating system to the Gaia operating system.

**To upgrade a SecurePlatform appliance:**

1. Upgrade product licenses to R75 or higher, and attach the licenses to the appliance.
2. Download the appliance upgrade package.
   Check_Point_upg_WEBUI_and_SmartUpdate_R75.40.Gaia.tgz
3. Connect to the SecurePlatform appliance from a Web browser to https://<appliance_ip_address>.
4. In the login page, enter an administrator username and password.
5. Go to the Upgrade page.
6. Upload the appliance upgrade package to the appliance.
7. Ignore any warning messages.
8. Continue according to the on-screen instructions.
   After the upgrade is complete, the appliance boots to Gaia.
Note - The connection to the SecurePlatform WebUI closes after Gaia is installed.

9. Install the Policy on the Security Gateway. This is highly recommended. The Security Gateway enforces the Initial Policy until you install the Policy:
   a) Using SmartDashboard of the correct version, connect to the Security Management Server.
   b) Open the General Properties page of the Gateway object.
   c) Click Get to update the Platform details.
   d) Install the policy on the Gateway.

SecurePlatform to SecurePlatform

Use the WebUI to upgrade Security Gateways on appliances.

To upgrade appliances using the WebUI:
1. Open Internet Explorer and log in to the appliance.
2. Select Appliance > Upgrade.
3. Click Check Point Download Center.
   The Internet browser opens to the Check Point Support Center.
4. Search for and download the R75.40 upload package file.
5. In the WebUI, click Upload upgrade package to appliance.
   The Upload Package to Appliance window opens.
6. Select the upgrade file:
   Check_Point_upg_WEBUI_and_SmartUpdate_R75.40.SecurePlatform.tgz
7. Click Upload.
8. Click Start Upgrade.
9. Before the upgrade begins, an image is created of the system and is used to revert to in the event the upgrade is not successful.
   The Save an Image before Upgrade page, displays the image information.
   Click Next.
10. In the Safe Upgrade section, select Safe upgrade to require a successful login after the upgrade is complete. If no login takes place within the configured amount of time, the system will revert to the saved image.
    Click Next.
11. The Current Upgrade File on Appliance section displays the information of the current upgrade.
12. To begin the upgrade, click Start.

IP Appliances

IPSO to Gaia

You can upgrade an IPSO IP Appliance Security Gateway to Gaia with R75.40. If necessary, you can do a rollback from Gaia to IPSO.

The IPSO and Check Point configuration is imported into Gaia, including the SIC trust settings.
Preparing for Upgrade
Set up this environment.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | IP Appliance with  
   - IPSO  
   - IPSO to Gaia installation package or upgrade package. |
| 2    | FTP Server with a Gaia ISO image mounted. The ISO is copied to the IP Appliance as part of the installation or upgrade process. The FTP server can be Linux-based or Windows-based ("Step 2: Putting the Gaia ISO on an FTP Server" on page 21).  
   In this example, the FTP Server is at 192.0.2.2. |
| 3    | Optional: FTP Server used as a location for one or more of the following:  
   - Backup of IPSO and the Security Gateway configuration. (recommended)  
   - A special SmartUpdate package that can be to distribute the IPSO to Gaia installation and upgrade package to multiple Security Gateways.  
   - A special package that can be used to install or upgrade Security Gateways, one at a time, without having to answer any questions. This package is created using the answers supplied when running the installation and upgrade package.  
   You can use the same FTP server as for the Gaia ISO, or a different one. In this example, the FTP Server is at 192.0.2.3. |
| 4    | Computer with console access to the IP appliance and to the FTP server(s).  
   Console access is recommended because it allows you to keep the connection to the IP Appliance throughout the installation or upgrade. If you connect via SSH you lose the connection after the IP Appliance reboots, and you will not be able to track the installation or upgrade progress. |
## Upgrade Procedure Overview

**Important** - This is an overview of the steps, not the actual instructions. Detailed instructions follow.

### Step 1:
Get the IPSO to Gaia installation and upgrade package (tgz) and the Gaia ISO image.

### Step 2:
Put the Gaia ISO on an FTP server.

### Step 3:
Install the installation and upgrade package on the IP Appliance using Network Voyager or clish.

### Step 4:
Run the script:
- Clean install - run-install-gaia
- Upgrade - run-upgrade-to-Gaia

### Step 5:
Enter FTP server details and the ISO location. The script tests the FTP Server environment:
- a) Route to the FTP server
- b) Interface speed and duplex settings
- c) FTP access with the given credentials
- d) FTP access to the specified path
- e) Path contains the Gaia ISO and the user has Read/Write access to the directory
- f) Multiple simultaneous connections (>20) to the FTP server are allowed
- g) Timeout on FTP server is not too low
- h) FTP access to files downloaded by the Gaia boot manager

### Step 6: Optional, but recommended
Enter data for an FTP server to hold IPSO system and configuration backup.

### Step 7: Optional
Enter data to make a customized IPSO to Gaia upgrade package. Use this to upgrade multiple Security Gateways with SmartUpdate.
- a) Upgrade one Security Gateway with the standard IPSO to Gaia upgrade package. Enter the required data to create the special upgrade package.
- b) Upgrade all other Security Gateways simultaneously, using the special upgrade package, without more data. All IP Appliances must be able to access the same ftp servers as the first Security Gateway.

### Step 8:
Confirm your selections.

### Step 9:
The installation or upgrade package now runs automatically:
- a) If you made a backup package: The backup tar files are copied from the IP Appliance to the FTP server.
- b) If you made a customized installation or upgrade package: The package is copied from the IP Appliance to the FTP server.
- c) The Gaia image is copied from the FTP server to the IP Appliance.
- d) The Gaia image is installed.
- e) The Gaia boot manager is installed.
- f) The IP Appliance reboots.
You see the Gaia prompt on the IP Appliance.

### Step 10:
Make sure the upgrade succeeded.
Step 1: Getting the Upgrade Package and the Gaia Image

   You will see two packages:
   - Gaia ISO image
   - IPSO to Gaia installation and upgrade package. The file name is Check_Point_Install_and_Upgade_IPSO6.2_to_Gaia_R75.40.tgz

2. Prepare the installation and upgrade packages:
   Copy the packages to an FTP server, in a directory of your choice. Or transfer the packages by FTP to the IP Appliance.

Step 2: Putting the Gaia ISO on an FTP Server

Network Requirements

⚠️ Important - High network traffic or large transfers (more than 10/100 Mbps links) can interfere with the FTP transfers for installation.

- Make sure the appliance can reach the FTP server.
- Make sure there is no Firewall which blocks incoming FTP requests from the appliance to the FTP server.
- Configure the FTP server to allow more than 100 (or an unlimited number of) concurrent connections.
- Make sure the Gaia ISO file is mounted on a directory to which the user has access permissions.

On a Linux-based FTP Server:
1. Upload the Gaia ISO file to the FTP server
2. On the FTP server, run:
   ```bash
   mount -o loop -t iso9660 <ISO_filename> <mounting_destination_dir>
   ```

On a Windows-based FTP Server:
1. Upload the Gaia ISO file to the FTP server
2. Extract the Gaia ISO file to a folder on the FTP Server. Use 7-zip, Winzip, WinRAR or similar.
3. In the folder, run the file `copyrpms.bat`
   This batch file copies installation files, to give a required workaround to Windows’ inability to support soft links.
4. Give FTP credentials to the folder, so the folder can be accessed via FTP.

Step 3: Installing the Package on the IP Appliance

1. Log in to the IP Appliance using a console.
2. Run `clish`
3. Install the IPSO to Gaia installation and upgrade package on the IPSO appliance using `clish` or using Network Voyager (see the Network Voyager Reference Guide (http://supportcontent.checkpoint.com/documentation_download?ID=10293)).
   To use `clish`:
   - If the IPSO to Gaia package is on an FTP server, run:
     ```bash
     add package media ftp addr <FTP_IP> user <uname> password <pass> name <full_path>/Check_Point_Upgrade_Package_R75.40.IPSO6.2_to_Gaia.tgz
     ```
   - If using anonymous ftp, change `ftp` to `anonftp`.
   - If the IPSO to Gaia package is on the IP Appliance, go to the directory where the package is located, and run the `clish` command:
     ```bash
     add package media local name ./*Check_Point_Upgrade_Package_R75.40.IPSO6.2_to_Gaia.tgz
     ```
   The installation and upgrade package is installed.
Trying to install package: ./package_name.tgz

Package Information --
Name       : IPSO to Gaia Upgrade
Version    : <version>
Release    : <Release>
Description: IPSO to Gaia Upgrade Package (<package_version>)

Package will be installed under: /opt
Package installed and activated successfully.
End of package installation.

The installation success message is Package installed and activated successfully.

The package is reported to be activated, but there are no background processes running.

4. Show the installed and active packages:
   show package active

<table>
<thead>
<tr>
<th>Name</th>
<th>Ver</th>
<th>Rel</th>
<th>Dir</th>
<th>Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>{Check Point CPinfo }</td>
<td>10</td>
<td>00</td>
<td>/opt/CPinfo-10</td>
<td>{Check Point CPinfo}</td>
</tr>
<tr>
<td>{Check Point R70}</td>
<td>R70</td>
<td>00</td>
<td>/opt/CPsuite-R70</td>
<td>{Check Point R70}</td>
</tr>
<tr>
<td>{IPSO to Gaia Upgrade}</td>
<td>&lt;ver&gt;</td>
<td>&lt;rel&gt;</td>
<td>/opt/&lt;package_name&gt;</td>
<td>{IPSO to Gaia Upgrade Package (&lt;upgrade_package_version&gt;)}</td>
</tr>
</tbody>
</table>

5. Exit clish. Run: exit

**Step 4: Running the Installation and Upgrade Script**

1. Go to the location of the package
   cd /opt/<package_name>/

2. To upgrade, run
   ./run-upgrade-to-Gaia

   To do a clean installation, run
   ./run-install-Gaia

   If you are upgrading multiple appliances from a special upgrade package that was previously saved, the installation or upgrade runs automatically. Continue with Step 9 ("Step 9: Upgrade Runs Automatically" on page 81).

   If you are upgrading or installing one appliance, continue here.

   The script runs. The following shows an upgrade. If you do a clean installation, the IPSO configuration is not transferred to Gaia.
Welcome to the IPSO to Gaia Install/Upgrade procedure.

Checking platform...OK
Checking IPSO OS version ...OK
Checking hostname ...
Checking your configuration
Summary:
  Errors:      0
  Warnings:    0
  Information: 14
Total Grade: 94
Details in file "/var/tmp/verify-IPSO-for-Gaia.msgs".

A newer version of this script may be available.
Contact the Check Point UserCenter at https://usercenter.checkpoint.com
and see SK66569.

Do you want to continue with the upgrade ? [y] y

The following types of information are needed to prepare your IPSO appliance for the upgrade:

- info about downloading the Gaia image.
- info about transferring the verification reports (optional).
- info about transferring an IPSO backup (optional).
- info about transferring a special upgrade package with your answers (optional).

Answer the prompts for this info and then the upgrade is performed.

Hit 'Enter' to continue or Ctrl-C to exit

3. Supply the information for downloading the Gaia image

   Note - If you have run the upgrade script before, the previously entered values are shown in square brackets [ ]. Press Enter to accept the values, or type in the new values and press Enter.

Step 5: Verifying the FTP Server

Enter the requested FTP server data and the path to the Gaia installation file.

| Required Directory Value |
|-----------------------------------|---------------------------------------------------|
| If ISO is mounted to a non-FTP directory | Enter full path to ISO. A relative path or shortcut link will not work. Example: if /home/uname/gaia, ./gaia will not work. |
| If ISO is mounted to /var/ftp, and FTP user account is used to install | Enter path to ISO. A shortened path will work. Example: if /var/ftp/gaia, gaia will work. |
| If ISO is mounted to /var/ftp, and non-FTP user account is used to install | Enter full path to ISO. A relative path or shortcut link will not work. |

The script runs some tests to verify the FTP environment. If errors are detected, correct the FTP server configuration and then instruct the program to verify the FTP environment again.

Here is an example of a successful test:
Info for download of the Gaia image:
IP address of FTP server [192.0.2.2]:
User name [gwhite]:
Password [******]:
Directory [/mnt/fiber292]:
Performing tests of access to FTP server and Gaia ISO
Checking route to 192.0.2.2 ... OK
Interface: eth-s4p1 speed 100M, duplex full
Checking FTP access with given credentials ... OK
Checking FTP access to /mnt/fiber292 ... OK
Checking /mnt/fiber292 is Gaia ISO ... Yes
Checking multiple simultaneous connections to 192.0.2.2 ... OK
Checking timeout to 192.0.2.2 ... OK
Checking FTP access to files downloaded by Gaia boot-manager
    system/ramdisk.pxe ... OK
    system/base/stage2.img ... OK

Step 6 (Optional, Recommended): Supplying Reports and Backup Server Information

The script will request details of the FTP server to store reports and backup data. The same path-rules apply here as in Step 5 ("Step 5: Verifying the FTP Server" on page 23). The backup creates two tgz files, for:

- IPSO operating system configuration files, user directories, and log files.
- Security Gateway backup files.

Here is an example:

A complete backup of the IPSO system can performed including system configuration, user home directories, log files and files from packages.

Do you want to perform this backup? [y]

Use IP address '192.0.2.2' and user 'root' for the backup? [n]

Details for transferring the IPSO Backup:
IP address of FTP server []: 192.0.2.3
User name []: ftp
Password []: ***
Directory []: /backupdir

Checking FTP access to 192.0.2.3 (it may take a minute) ... done

Step 7: (Optional): Supplying Special Package Server Information

Enter data of the destination FTP server for the special upgrade package. Enter a destination directory, with the same rules as in Step 5 ("Step 5: Verifying the FTP Server" on page 23).

A package with your answers to the previous prompts can be created. This package can be used on other IPSO gateways for unattended conversion to Gaia.

Do you want to create such a package? [y]

Details for transferring the package with your answers:
IP address of FTP server [192.0.2.3]:
User name [ftp]:
Password [***]:
Directory [packagedir]:
Checking FTP access to 192.0.2.3 (it may take a minute) ... done

Step 8: Confirming Your Selections

You see a summary of all your answers.
Upgrading Security Management Server and Security Gateways

Information for download of the Gaia image:
- FTP Server IP Address = 192.0.2.2
- FTP Server user name = root
- Directory on FTP Server = /imagedir

Information for transferring the IPSO Backup:
- FTP Server IP Address = 192.0.2.3
- FTP Server user name = ftp
- Directory on FTP Server = /backupdir

Information for transferring the package with your answers:
- FTP Server IP Address = 192.0.2.3
- FTP Server user name = ftp
- Directory on FTP Server = /packagedir

Are these values correct? [y]

1. Click "n" to change the selections you made before, or type "y" to start the upgrade.
   The backup file and the special upgrade package file, if you chose to create them, are created.

   Writing values to file
   Performing IPSO backup (file <ipso_backup_file_name>.tgz) ... done
   Performing Check Point Security Gateway backup (file <Security Gateway_backup_file_name>.tgz) ... done
   Transferring IPSO and Check Point Security Gateway backup files ... done
   Creating a package with your answers (<package_name>_AUTO.tgz) ... done
   Transferring package with your answers ... done
   Installing Gaia Boot Manager ... done

2. You have 30 seconds to abort. To stop the upgrade, press Enter.
   IP appliance reboots in 30 seconds to complete the upgrade.
   Hit 'Enter' to abort.

   **Important** - If you want to make changes, press Enter now.
   This stops the upgrade to Gaia. To complete the upgrade to Gaia, reboot the IP Appliance.

Step 9: Upgrade Runs Automatically

The upgrade runs unattended.
- The IP Appliance reboots.
- The Gaia Boot Manager runs.

   **Important** - It is possible that after the reboot the system will show the Boot Manager prompt.
   To complete the upgrade, type INSTALL at the Boot Manager prompt, and provide the requested information. The upgrade should continue from this point.

- The Gaia image is installed.

   ![Gaia Installation Image]

- The IPSO and R75.40 configuration is imported into Gaia, including the SIC trust settings.
- You now see the Gaia prompt.

Congratulations. Gaia and R75.40 are installed on the IP Appliance.
Important - The HTTPS port for the WebUI is set to 443 after an installation or upgrade. To change this, you must use SmartDashboard > Gateway Properties > Portal Settings.

Step 10: Making Sure the Upgrade Succeeded

To check the Security Gateway configuration:

1. At the Gaia prompt, log in with your IPSO credentials.
   The system logs you in to the expert mode. That is, you will be in csh or bash depending on how the original IPSO system was configured.
2. Type clish to enter clish.
3. Run fw ver to see the Security Gateway version information.
4. Run fw stat to confirm that the default policy is enforced.
5. Launch R75.40 SmartDashboard.
6. In the Security Gateway object:
   a) Click Test SIC status. SIC status should be Trust Established.
   b) Change the version to R75.40.
   c) Install a policy on the Security Gateway.

Rollback from Gaia to IPSO

You can roll back from Gaia to IPSO 6.2. You can also restore the Check Point Security Gateway and/or Security Management Server configuration.

Before doing a rollback from Gaia to IPSO:

Make sure that:

1. The IPSO boot manager installer is available. Download it from the R75.40 home page (http://supportcontent.checkpoint.com/solutions?id=sk67581).
2. An IPSO image is available. Put the IPSO image on an FTP server, and make sure that the FTP server is accessible from the Gaia IP Appliance.
3. A backup of the Check Point Security Gateway on the Gaia IP Appliance is available. Put the backup tar file on an FTP server, and make sure the FTP server is accessible from the Gaia IP Appliance.

To roll back from Gaia to IPSO:

1. At the Gaia command line prompt, login as the administrator.
2. Go to expert mode. Type expert and supply the credentials.
3. Download the IPSO boot manager installer
   Check_Point_R75.40_Install_IPSOBootmanager.sh from the R75.40 home page on the Support Center.
4. Copy the IPSO boot manager installer to a location of your choice on the Gaia IP Appliance. For example, to /var/tmp.
5. Change file attributes to give executable permissions. Run
   chmod 777 Check_Point_R75.40_Install_IPSOBootmanager.sh
6. Install the IPSO boot manager. At the command prompt run
   ./Check_Point_R75.40_Install_IPSOBootmanager.sh /dev/hda
   The script asks if you want to roll back to
   1. IPSO 4.2
   2. IPSO 6.2
7. Choose 2
8. Type reboot
   After the reboot, the system is running the IPSO boot manager.
9. At the BootMgr> prompt, install the IPSO image. Run
   install
10. Enter this data:
   - IP address of the IP Appliance.
• Default gateway of the IP Appliance.
• IP address of the FTP server with the IPSO image.
• User credentials.
• Directory path.
• Various configuration questions (about the chassis serial number, whether the system is part of a VRRP cluster, and whether IGMP and BGP are enabled).

The system automatically reboots into IPSO.

11. Configure the IP Appliance:
• Hostname
• New password for admin
• Enable the management port physical interface
• IP address for the management interface
• Default gateway

To restore the Check Point Security Gateway configuration:
1. Log in to the newly installed and configured IPSO IP Appliance as admin
2. Use FTP to transfer the backup archive file containing the Check Point Security Gateway to the IP Appliance, and then uncompress the archive. In the following example,
   • The name of the backup archive is CP_archive_nms71_20101124.tgz
   • The IP address of the FTP server containing the backup archive is 192.0.2.3.

```
cd /tmp
ftp ftp://192.0.2.3>/pub/CP_archive_nms71_20101124.tgz
 tar xzf /tmp/CP_archive_nms71_20101124.tgz
```
3. Restore the IPSO backup file using the set restore CLI commands. In the following example,
   • The IP address of the FTP server containing the IPSO backup file is 192.0.2.2
   • The IPSO backup file is in the pub directory.

   ! Important - If the backup contains IPSO and Check Point configuration data, the Check Point packages must be installed first before trying to restore the backup; otherwise the restore will fail.

```
clish
set restore remote ftp-site ftp://192.0.2.2
set restore remote ftp-user <username e.g. anonymous>
set restore remote ftp-pass <password>
set restore remote ftp-dir pub
set restore remote filename i2g_backup_<hostname and timestamp>.tgz
```
IPSO automatically reboots.
4. Log out.
5. Log in as admin.
6. Verify the configuration has been restored.

**IPSO to IPSO**

Use the procedures in this section to:
• Add the new version of IPSO (also known as an IPSO image)
• Add the R75.40 release package
• Add other packages

These procedures do not remove the existing images, packages, or your configuration information. If you add a new version, you can revert to the earlier versions stored on the platform. When you revert, your IPSO configuration information is not affected.

You can add IPSO images, R75.40 and other packages to the IP Appliance with Network Voyager or with the CLI shell.
When you add an IPSO image, the IPSO boot manager is upgraded automatically if your system does not have the boot manager for the image you are adding (based network element management application). Use a console to perform the initial configuration.

**Adding and Activating Packages Using Network Voyager**

To install and activate an R75.40 package using Network Voyager:

1. Download the applicable release package for your platform to an FTP site or to your local disk.

   **Important** - Installing the incorrect package can damage your platform.

<table>
<thead>
<tr>
<th>IP Appliance Platform type</th>
<th>Package</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk based</td>
<td>Check_Point_R75.40.IPSO6.2.tgz</td>
</tr>
<tr>
<td>Flash based</td>
<td>Check_Point_R75.40_Security_Gateway_for_IPSO6_2.tgz</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> - This package does not include CPinfo. See sk30567 (<a href="http://supportcontent.checkpoint.com/solutions?id=sk30567">http://supportcontent.checkpoint.com/solutions?id=sk30567</a>) for download information.</td>
</tr>
</tbody>
</table>

1. Enter Network Voyager
2. Choose Configuration > System configuration > Packages > Install Packages
3. Choose the remote location of the package.
   - **FTP** to upload from an FTP server
   - **Upload** to upload from a local machine
4. For FTP, enter the FTP site location and credentials.
5. For both FTP and Upload method, choose the package.
6. Click Save.
7. Click the tgz you have uploaded.
8. Click Apply.
9. Click the link to upgrade the package:
   - Click here to install/upgrade /opt/packages/IPSO6_wrapper_R75.40.tgz
10. In the Package Installation and Upgrade window, select Upgrade, and select the package to Upgrade From
11. Click Apply.
    The upgrade begins.
12. To monitor progress, click the Install package link. The upgrade log is shown.
13. When an "Installation Completed" message appears, click Save.
    Reboot the system.
    After the reboot, R75.40 will be active.
14. To verify that R75.40 is active, run the CLI command: `newpkg -q`

**Adding and Activating an R75.40 Package Using the CLI Shell**

To install and activate the R75.40 package using the CLI shell:

Download the applicable release package for your platform to an FTP site or to your local disk.

**Important** - Installing the incorrect package can damage your platform.

<table>
<thead>
<tr>
<th>IP Appliance Platform type</th>
<th>Package</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk based</td>
<td>Check_Point_R75.40.IPSO6.2.tgz</td>
</tr>
<tr>
<td>Flash based</td>
<td>Check_Point_R75.40_Security_Gateway_for_IPSO6_2.tgz</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> - This package does not include CPinfo. See sk30567 (<a href="http://supportcontent.checkpoint.com/solutions?id=sk30567">http://supportcontent.checkpoint.com/solutions?id=sk30567</a>) for download information.</td>
</tr>
</tbody>
</table>
1. Access the CLI console, and log in.
2. Type `newpkg`, and press Enter.
3. Use the FTP menu option to transfer the R75.40 package. Choose the option:
   * Upgrade from an old package.
4. Upgrade to the R75.40 package.
   Wait until a message informs you that the process is complete.
5. Type `reboot` and press Enter.
   The package is activated after the reboot.
6. Verify that R75.40 is active by running the following command:
   `newpkg -q`
7. Verify that R75.40 is the current version. Run `fw ver` on a Security Gateway or `fwm ver` on a Security Management server.

### Updating the Security Gateway Version in SmartDashboard

At this point the IP Appliance enforces the Initial Policy which does not allow HTTP connections. It is therefore not possible to connect via Network Voyager. To enforce the Security Policy and make it possible to connect to the IP Appliance via Network Voyager, use SmartDashboard to install the Security Policy (that allows HTTP).

**To install the policy on the IP Appliance:**

1. Log in to the R75.40 SmartDashboard that controls the Security Management Server that manages the IP Appliance.
2. Edit the Check Point Security Gateway object of the IP Appliance.
4. Install the policy.

### Upgrading Security Gateways on Open Servers

**Before you upgrade:**

It is recommended to back up your current configuration (see "Backing Up" on page 55).

**SecurePlatform to Gaia**

You can upgrade Security Gateways on SecurePlatform to R75.40 Security Gateways on Gaia.

**To upgrade an open server using the DVD:**

1. Upgrade product licenses to R75 or higher, and attach the licenses to the computer.
2. Connect a DVD drive to the USB port on the computer.
3. Run: `patch add cd`
4. Select the Gaia upgrade package.
5. Confirm the MD5 checksum.
6. If relevant, when prompted, create a backup image for automatic revert.
7. After extracting files, the Installation program opens.
8. Accept the license agreement.
9. Select upgrade.
10. Configure your contract options.
    You can also continue without contract information and configure it later using SmartUpdate.
11. Select a source for the upgrade utilities.
    Wait for the pre-upgrade verifier to complete successfully.
12. Select Stop Check Point processes.
13. Select Upgrade installed products, or upgrade installed products and add new products, and confirm.
14. Wait while the required installation files are extracted.
    a) Part one of the upgrade procedure saves data and upgrades the operating system.
b) Part two upgrades Check Point products.

15. After the upgrade completes successfully, remove the DVD from the drive.
16. Restart when prompted.

17. Install the Policy on the Security Gateway. This is highly recommended. The Security Gateway enforces the Initial Policy until you install the Policy:
   a) Using SmartDashboard of the correct version, connect to the Security Management Server.
   b) Open the **General Properties** page of the Gateway object.
   c) Click **Get** to update the Platform details.
   d) Install the policy on the Gateway.

**To upgrade a SecurePlatform Open Server using the WebUI:**
1. Open Internet Explorer and log in to the SecurePlatform WebUI.
2. Select **Device > Upgrade**.
3. Click **Check Point Download Center**.
   The Internet browser opens to the Check Point Support Center.
4. Search for and download the R75.40 file for upgrades via the WebUI.
5. Click **Browse** and select the upgrade file:
   `Check_Point_upg_WEBUI_and_SmartUpdate_R75.40.Gaia.tgz`
6. Click **Upload package to device**.
   The package is uploaded to the SecurePlatform computer.
   After the **Upgrade Status** shows that the **Uploading** is **Completed** you can start the upgrade.
7. **Recommended**: In the **Safe Upgrade** section, click **Save snapshot of the current system before the upgrade**. The snapshot is used to revert the system if the upgrade is not successful.
8. Click **Start Upgrade**.
   Follow the **Upgrade Status**. After the upgrade, the computer automatically reboots.
   
   **Note** - The connection to the SecurePlatform WebUI closes after Gaia is installed.

9. Install the Policy on the Security Gateway. This is highly recommended. The Security Gateway enforces the Initial Policy until you install the Policy:
   a) Using SmartDashboard of the correct version, connect to the Security Management Server.
   b) Open the **General Properties** page of the Gateway object.
   c) Click **Get** to update the Platform details.
   d) Install the policy on the Gateway.

**SecurePlatform to SecurePlatform**

Use this procedure to upgrade a SecurePlatform installation on the same computer. Upgrade the operating system and the installed products.

**To upgrade a SecurePlatform Open Server using a DVD:**
1. Insert R75.40 DVD into the drive.
2. At the command prompt, enter: `patch add cd`
3. Select **SecurePlatform R75.40 Upgrade Package** (`CPspupgrade_<version_number>.tgz`).
4. Press `y` to accept the checksum calculation.
5. Optional: When prompted, create a backup image so that you can restore the old version.
   
   **Note** - Creating the snapshot image can take a long time. Check Point products are stopped during this time.
6. Press `N` at the welcome message.
7. Press `Y` to accept the license agreement.
8. In the next window, select **Upgrade** and then press `N`. 

---

Installation and Upgrade Guide R75.40 | 86
9. In the next window, press N to continue.

10. If prompted to download or import a valid support contract, select **Continue without contract information**. Press N to continue.

11. If a message shows that says your gateway is not eligible for upgrade, press N to continue.
    You can safely ignore this message and use SmartUpdate to update your service contract later.

12. In the next window, select **Download most updated files**.

13. In the Pre-Upgrade Verification Results window, press N to continue.
    If the Pre-Upgrade Verification fails, do the suggested steps to correct the problem. Start this procedure again from step 2.

14. When prompted, select **Stop Check Point processes and press** N to continue.

15. When prompted, select **Upgrade installed products** and press N to continue.

16. In the Validation window, press N.

17. When the upgrade completes successfully, restart the computer.

**To upgrade a SecurePlatform Open Server using the WebUI:**

1. Open Internet Explorer and log in to the SecurePlatform WebUI.

2. Select **Device > Upgrade**.

3. Click **Check Point Download Center**.
    The Internet browser opens to the Check Point Support Center.

4. Search for and download the R75.40 file for upgrades via the WebUI.

5. Click **Browse** and select the upgrade file:
   Check_Point_upg_WEBUI_and_SmartUpdate_R75.40.SecurePlatform.tgz

6. Click **Upload package to device**.
    The package is uploaded to the SecurePlatform computer.
    After the Upgrade Status shows that the Uploading is Completed you can start the upgrade.

7. Recommended: In the Safe Upgrade section, click **Save snapshot of the current system before the upgrade**. The snapshot is used to revert the system if the upgrade is not successful.
    Your browser will automatically try to perform the first login immediately after the upgrade. To allow this, do not close the browser window or browse to another page.

8. Click **Start Upgrade**.
    Follow the Upgrade Status. After the upgrade, the computer automatically reboots.

9. Install the Policy on the Security Gateway. This is highly recommended. The Security Gateway enforces the Initial Policy until you install the Policy:
   a) Using SmartDashboard of the correct version, connect to the Security Management Server.
   b) Open the **General Properties** page of the Gateway object.
   c) Click **Get** to update the **Platform** details.
   d) Install the policy on the Gateway.

**Windows**

This section describes the upgrade process using the R75.40 Installation DVD.

**To upgrade a gateway in a Windows platform:**

1. Insert the R75.40 DVD.

2. If the upgrade does not start automatically, run **Setup.exe** from the DVD.

3. Click Next to start the installation wizard.

4. Accept the license agreement and click Next.

5. Click Next to check your license information.

6. Select one of the license options and click Next.

7. To add Check Point products that were not installed previously, select **Install additional Check Point products** and click Next.

8. Select the new products to install.
9. A list of the products that will be upgraded or installed. Click Next to start the installation.
10. When the installation is finished, click Next to continue.
11. In Licenses and Contracts, select a licensing option and click Next.
12. In Secure Internal Communication, verify the SIC details and click Next.
13. In Clustering, select whether this Security Gateway is part of a cluster.
14. Click Finish to close the installation wizard.

When the upgrade process is complete:

1. Using SmartDashboard, log in to the R75.40 Security Management server that controls the upgraded gateway.
2. Open the gateway object properties window that represents the upgraded gateway and change the version to R75.40.
3. Install the policy on the upgraded gateway.

If necessary, you can restore the previous configuration (see "Restoring Other Platforms" on page 58).

**Upgrading Standalone Full High Availability**

**Full High Availability**: The server and the gateway are in a standalone configuration and each has High Availability to a second standalone machine. If there is a failure, the server and the gateway failover to the secondary machine. In the standalone configuration the server and gateway can failover independently of each other. For example, if only the server has an issue, only that server fails over. There is no effect on the gateway in the standalone configuration.

To upgrade Full High Availability for cluster members in standalone configurations, there are different options:

- Upgrade one machine and synchronize the second machine with minimal downtime.
- Upgrade with a clean installation on one machine and synchronize the second machine with system downtime.

**Upgrading with Minimal Downtime**

You can do a Full High Availability upgrade with minimal downtime to the cluster members.

**To upgrade Full High Availability with minimal downtime:**

1. Make sure the primary cluster member is active and the secondary is standby: check the status of the members.
2. Start failover to the second cluster member.
   - The secondary cluster member processes all the traffic.
3. Log in with SmartDashboard to the management server of the secondary cluster member.
4. Click Change to Active.
5. Configure the secondary cluster member to be the active management server.
   - **Note** - We recommend to export the database using the Upgrade tools (on page 54).
6. Upgrade the primary cluster member to the appropriate version.
7. Log in with SmartDashboard to the management server of the primary cluster member.
   - Make sure version of the SmartDashboard is the same as the server.
8. Upgrade the version of the object to the new version.
9. Install the policy on the cluster object.
   - The primary cluster member processes all the traffic.
   - **Note** - Make sure that the For Gateway Clusters install on all the members option is cleared. Selecting this option causes the installation to fail.
10. Upgrade the secondary cluster member to the appropriate version.
**Upgrading with a Clean Installation**

You can do a Full High Availability upgrade with a clean installation on the secondary cluster member and synchronize the primary cluster member. This type of upgrade causes downtime to the cluster members.

**To upgrade Full High Availability with a clean installation:**

1. Make sure the primary cluster member is active and the secondary is standby: check the status of the members.
2. Start failover to the second cluster member.
   The secondary cluster member processes all the traffic.
3. Log in with SmartDashboard to the management server of the secondary cluster member.
4. Click **Change to Active**.
5. Configure the secondary cluster member to be the active management server.
   
   **Note** - We recommend to export the database using the Upgrade tools (on page 54).
6. Upgrade the primary cluster member to the appropriate version.
7. Log in with SmartDashboard to the management server of the primary cluster member.
   Make sure version of the SmartDashboard is the same as the server.
8. Upgrade the version of the object to the new version.
9. Install the policy on the cluster object.
   The primary cluster member processes all the traffic.
   
   **Note** - Make sure that the **For Gateway Clusters install on all the members** option is cleared. Selecting this option causes the installation to fail.
10. Install the secondary member.
11. From SmartDashboard, configure the cluster object.
    a) Change the secondary details (if necessary).
    b) Establish SIC.
   The primary management database synchronizes to the secondary management database.
Chapter 6
Upgrading Multi-Domain Security Management

In This Chapter
- Upgrade Multi-Domain Security Management Tools
- Upgrade Best Practices
- Upgrading a High Availability Deployment
- Restarting Domain Management Servers
- Restoring Your Original Environment
- Removing Earlier Version Multi-Domain Server Installations
- Changing the Multi-Domain Server Interfaces
- IPS with Multi-Domain Security Management

This section includes procedures for upgrading Multi-Domain Security Management to R75.40.

Upgrade Multi-Domain Security Management Tools

This section describes the different upgrade and migrate utilities, and explains when and how each of them is used.

Pre-Upgrade Verifiers and Correction Utilities

Before performing the upgrade the Multi-Domain Security Management upgrade script, UnixInstallScript, runs a list of pre-upgrade utilities. The utilities search for well-known upgrade problems that might be present in your existing installation. The output of the utilities is also saved to a log file. Three types of messages are generated by the pre-upgrade utilities:

- **Action items before the upgrade**: These include errors and warnings. Errors have to be repaired before the upgrade. Warnings are left for the user to check and conclude whether they should be fixed or not. In some cases, it is suggested that fixing utilities should be run during the pre-upgrade check, but in most cases the fixes are done manually from SmartDashboard. An example of an error to be fixed before the upgrade is when an invalid policy name is found in your existing installation. In this case, you must rename the policy.

- **Action items after the upgrade**: These include errors and warnings, which are to be handled after the upgrade.

- **Information messages**: This section includes items to be noted. For example, when a specific object type that is no longer supported is found in your database and is converted during the upgrade process, a message indicates that this change is going to occur.

Container2MultiDomain

In versions prior to Multi-Domain Security Management R75, you had the option of dividing functionality between two physical Multi-Domain Server platforms:

- Multi-Domain Server Containers hosted the Domain Management Server (formerly CMA) databases.
- Multi-Domain Server Managers hosted the system and Global Object databases.
The current version no longer uses this architecture. All Multi-Domain Servers host all management databases.

Versions R75 and later use a different licensing model. All converted Multi-Domain Servers must have the appropriate new licenses.

Check Point developed the **Container2MultiDomain** utility to help administrators convert their old Multi-Domain Server Containers to the new single platform architecture.

- You can still use your old Multi-Domain Server Containers in a R75 deployment without conversion. Appropriate licenses are required.
- You must attach the appropriate R75 licenses to the upgraded Multi-Domain Server Container before using the **Container2MultiDomain** utility.
- **Container2MultiDomain** is applicable only to versions R75 and later.
- You can only use **Container2MultiDomain** if all of these conditions are true:
  - The Multi-Domain Server must have a license that includes the CPSB-GLBP or CPSB-BASE blades.
  - The Multi-Domain Server must be a Container.
  - The Multi-Domain Server must be running.
- You must restart all Multi-Domain Servers in your deployment after using **Container2MultiDomain**. You do not need to restart your Domain Management Servers.

**Running Container2MultiDomain**

After upgrading an old Multi-Domain Server Container, this message shows to remind you that you can use **Container2MultiDomain** to do the conversion.

The installation has indicated that this server is a Container MDS. When converting this server to a Multi-Domain Server, after logging in again to the shell, please add the required Software Blade.

Run the **Container2MultiDomain** utility and follow the instructions.

Converting a Multi-Domain Server is optional.

**To use the utility:**
1. Run Container2MultiDomain from the Multi-Domain Server command line.
2. When this message opens, enter yes.
3. This message opens when the process completes.

**Export**

The **UnixInstallScript Export** option extracts the database and configuration settings from a Multi-Domain Server and its associated Domain Management Servers. It then stores this data in a single tgz file. You can import this tgz file to a newly installed Multi-Domain Server.

In a High Availability deployment, you must export the primary Multi-Domain Server. If the target Multi-Domain Server uses a different leading IP address than the source server, you must change the Multi-Domain Server IP address and the external interface.
You can include the log files in the exported tgz file. These log files are likely to be very large.

**migrate export**

The `migrate export` command exports the content of a single Domain Management Server or Security Management Server database into a TGZ archive file. This archive file serves as the source for the migration tools described below. The `migrate` utility is included on the Multi-Domain Security Management distribution DVD.

**Note** - Before you migrate, delete all secondary management objects from the primary Security Management server.

**To install the migrate utility:**

1. Locate the `pl_upgrade_tools.tgz` archive file in the `upgrade_tools` subdirectory under the relevant operating system parent directory.
2. Extract the contents of the archive into a folder on the source computer (the computer hosting the Domain Management Server or Security Management Server).

**Installation example:**

Install from CD:

```
# gtar xvfz /mnt/cdrom/linux/upgrade_tools/linux/pl_upgrade_tools.tgz -C /var/opt/export_tools
```

Install from DVD:

```
# gtar xvfz /mnt/cdrom/Linux/linux/upgrade_tools/linux/pl_upgrade_tools.tgz -C /var/opt/export_tools
```

The database to import is the database belonging to the primary Domain Management Server/Security Management server. Before you import, make sure that the database is synchronized.

If you want to migrate your current High Availability environment to a Domain Management Server High Availability on a different Multi-Domain Server, export the database. Then continue with a High Availability deployment (see the High Availability chapter in the R75.40 Multi-Domain Security Management Administration Guide) (http://supportcontent.checkpoint.com/solutions?id=sk67581).

**To export the management database:**

```
<fully qualified path to command> migrate export [-l] <output file>
```

The optional `-l` flag includes closed log files from the source Domain Management Server in the output archive.

- The `migrate` command works on the current Domain Management Server. You must use the `mdsenv <Domain Management Server name>` command to set environment to the current Domain Management Server (or to the Multi-Domain Server environment for the global policy) before you run the `migrate` command.
- The output file must be specified with the fully qualified path. Make sure there is sufficient disk space for the output file.
- Run a "log switch" immediately before you export the Domain Management Server to export the log files.

**Example:**

```
# cd /opt/CPsuite-R75.40/fw1/bin/upgrade_tools/
# mdsenv dms1
# migrate export -l /var/opt/dms1_exported.tgz
```

This example assumes that you are upgrading using the distribution CD or DVD.
**cma_migrate**

The `cma_migrate` command imports an existing Domain Management Server management database into a Multi-Domain Server. If the imported Domain Management Server is from a version earlier than that of the Multi-Domain Server, the upgrade process occurs automatically during the import.

You must run `cma_migrate` to import Domain Management Servers exported using the `migrate export` command. Copy the exported management database archive file to target Multi-Domain Server prior to using the `cma_migrate` command. Bear in mind that the source and target platforms may be different.

Before running `cma_migrate`, create a new Domain and a new Domain Management Server. Do not start the Domain Management Server.

If you are migrating a Domain Management Server to a new Domain Management Server with a different IP address, it is a different procedure ("Completing Migration to a New IP Address" on page 125).

**Syntax:**

```bash
cma_migrate <source management tgz> <target Domain Management Server FWDIR directory>
```

**Example:**

```bash
cma_migrate /tmp/exported_smc.tgz /opt/CPmds-r71/domains/dms2/CPsuite-R71/fw1
```

The first argument `<source management tgz>` specifies the path, on the Multi-Domain Server, to the source management data as obtained by the migrate utility. The second argument `<target Domain Management Server FWDIR directory>` is the FWDIR of the newly created Domain Management Server.

**Note** - You can run `mdscmd migratecma` to import files to a Domain Management Server, or you can use the SmartDomain Manager.

To run the `cma_migrate` utility from the SmartDomain Manager:

1. Right-click a Domain Management Server and select Options > Import Domain Management Server.
2. When you enter the path to the exported database file, include the name of the exported database file at the end of the path.

**cma_migrate and Certificates**

When running `cma_migrate`, pre-upgrade verification takes place. If no errors are found, then the migration continues. If errors are found, certain modifications must be implemented on the original Security Management server, after which you must re-export the source.

**Certificate Authority Information**

The original Certificate Authority and `putkey` information is maintained when using `cma_migrate`. This means that the Security Management server that was migrated using `cma_migrate` should not re-generate certificates to gateways and SIC should continue to work with gateways. However, if the IP of the Domain Management Server is different than that of the original management, then `putkey` should be repeated between the Domain Management Server and entities that connect to it using `putkey` information. Use `putkey -n` to re-establish trust. For additional information on `putkey`, refer to the Check Point Command Line Interface documentation.

If your intent is to split a Domain Management Server into two or more Domain Management Servers, reinitialize their Internal Certificate Authority so that only one of the new Domain Management Servers employs the original ICA:

To reinitialize a Domain Management Server Internal Certificate Authority:

1. Run: `mdsstop_customer <Domain Management Server NAME>`
2. Run: `mdsenv <Domain Management Server NAME>`
3. Remove the current Internal Certificate Authority by executing the `fwm sic_reset` command. This may require some preparation that is described in detail from the command prompt and also in the Secure Knowledge solution sk17197.
4. Create a new Internal Certificate Authority by executing:
   mdsconfig -ca <Domain Management Server NAME> <Domain Management Server IP>
5. Run the command: mdsstart_customer <Domain Management Server NAME>

For more about CA on Multi-Domain Security Management, see sk17197

Resolving Issues with IKE Certificates

When migrating a management database that contains a gateway object that takes part in a VPN tunnel
with an externally managed third-party gateway, an issue with the IKE certificates arises. After migration,
when such a gateway presents its IKE certificate to its peer, the peer gateway uses the FQDN of the
certificate to retrieve the host name and IP address of the Certificate Authority that issued the certificate. If
the IKE certificate was issued by a Check Point Internal CA, the FQDN will contain the host name of the
original management. In this case, the peer gateway will try to contact the original management for the CRL
information, and failing to do so will not accept the certificate.

There are two ways to resolve this issue:

- Update the DNS server on the peer side to resolve the host name of the original management to the IP
  address of the relevant Domain Management Server.
- Revoke the IKE certificate for the gateway(s) and create a new one. The new certificate will contain the
  FQDN of the Domain Management Server.

migrate_global_policies

The migrate_global_policies command imports (and upgrades, if necessary) a global policies
database from one Multi-Domain Server to another.

Note - migrate_global_policies is blocked if there are global policies assigned to
Domains. Do not assign any Global Policy to Domains before you run
migrate_global_policies.

If the global policy database on the target Multi-Domain Server contains policies that are assigned to
Domains, the migrate_global_policies command stops. This is to make sure that the Global Policy
used by those Domains is not deleted.

Note - When executing the migrate_global_policies utility, the Multi-Domain Server
will be stopped. The Domain Management Server can remain up and running.

Syntax:
migrate_global_policies <path to exported Multi-Domain Server tgz archive>

$<path to exported Multi-Domain Server tgz archive>$: specifies the fully qualified path to the archive
file created by the migrate export command.

Note - migrate_global_policies is blocked if there are global policies assigned to
Domains. Do not assign any Global Policy to Domains before you run
migrate_global_policies.

Backup and Restore

The purpose of the backup/restore utility is to back up a whole Multi-Domain Server, including all the
Domain Management Servers that it maintains, and to restore it when necessary. The restoration procedure
brings the Multi-Domain Server to the state it was when the backup procedure was executed. The backup
saves both user data and binaries.

Note - Backup and restore cannot be used to move the Multi-Domain Server installation
between platforms.
Restoration can be performed on the original machine or, if your intention is to upgrade by replicating your Multi-Domain Server for testing purposes, to another machine. When performing a restoration to another machine, if the machine's IP address or interface has changed, refer to Changing the Multi-Domain Server IP Address and External Interface for instructions on how to adjust the restored Multi-Domain Server to the new machine.

During backup, you can view data but cannot make changes. If the Multi-Domain Security Management system consists of several Multi-Domain Servers, the backup procedure takes place manually on all the Multi-Domain Servers concurrently. Likewise, when the restoration procedure takes place, it should be performed on all Multi-Domain Servers concurrently.

**mds_backup**

The `mds_backup` command backs up binaries and data from your Multi-Domain Server to the working directory. This command requires Superuser privileges.

`mds_backup` executes the `gtar` command on product root directories containing data and binaries, and backs up all files except those specified in the `mds_exclude.dat` file. The collected information is stored in a single `.tgz` file. This `.tgz` file name consists of the backup date and time, which is saved in the current working directory. For example: `13Sep2002-141437.mdsbk.tgz`

To perform a backup:

1. Execute `mds_backup` from any location outside the product directory tree to be backed up. This becomes the working directory.
2. Upon completion of the backup process, copy the backup `.tgz` file, together with the `mds_restore`, `gtar` and `gzip` command files, to your external backup location.

**Syntax**

```
mds_backup [-g -b {-d <target dir name>} -v -h]
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-g</code></td>
<td>Executes without prompting to disconnect GUI clients.</td>
</tr>
<tr>
<td><code>-b</code></td>
<td>Batch mode - executes without asking anything (<code>-g</code> is implied).</td>
</tr>
<tr>
<td><code>-d</code></td>
<td>Specifies a directory store for the backup file. When not specified, the backup file is stored in the current directory. You cannot store the backup file in any location inside the product root directory tree.</td>
</tr>
<tr>
<td><code>-v</code></td>
<td>Verbose mode - lists all files to be backed up, but do not perform the backup operation.</td>
</tr>
<tr>
<td><code>-l</code></td>
<td>Exclude logs from the backup.</td>
</tr>
<tr>
<td><code>-h</code></td>
<td>Help - displays help text.</td>
</tr>
</tbody>
</table>

**Comments** When using the `-g` or `-b` options, make sure that no GUI clients or SmartReporter servers are connected. Otherwise, the backup file may contain inconsistencies due to database changes made during the backup process.

It is important not to run `mds_backup` from any of the directories that will be backed up. For example, when backing up a Multi-Domain Server, do not run `mds_backup` from `/opt/CPmds-R70` since it is a circular reference (backing up directory that you need to write into).

Active log files are not backed up, in order to avoid read-during-write inconsistencies. It is recommended to perform a log switch prior to the backup procedure.

**Further Info.** The Multi-Domain Server configuration can be backed up without backing up the log files. Such a backup will usually be significantly smaller in size than a full backup with logs. To back up without log files, add the following line to the file `MDSDIR/conf/mds_exclude.dat`:

```
log/*
```
mds_restore

**Description**  
Restores a Multi-Domain Server that was previously backed up with mds_backup. For correct operation, mds_restore should be restored onto a clean Multi-Domain Server installation.

> **Note** - The mds_restore command must use the script that was created in the directory into which the backup file was created.

**Syntax**  
./mds_restore <backup file>

> **Important** - In Gaia, you have to run this command in expert mode and in the same directory as the backup file itself.

Upgrade Best Practices

**Multi-Domain Server In-Place Upgrade**

The in-place upgrade process takes place on an existing Multi-Domain Server machine. The Multi-Domain Server, together with all Domain Management Servers, are upgraded in one procedure.

> **Note** - When upgrading Multi-Domain Security Management, all SmartUpdate packages on the Multi-Domain Server (excluding Edge firmware packages) are deleted from the SmartUpdate Repository.

**Before doing an in-place upgrade to R75.40:**

1. Run the Pre-upgrade verification only option from UnixInstallScript. In a multi-Multi-Domain Server environment, do this on all Multi-Domain Servers.
2. Make the changes required by the pre-upgrade verification, and if you have High Availability, start synchronizations.
3. Test your changes:
   a) Assign the global policy
   b) Install policies to Domain Management Servers
   c) Verify logging using SmartView Tracker
   d) View status using the SmartDomain Manager or SmartView Monitor
4. Run mds_backup to back up your system.

**SecurePlatform to SecurePlatform**

Use a DVD to upgrade Multi-Domain Server on SecurePlatform.

Safe Upgrade automatically takes a snapshot of the entire system so that the entire system (operating system and installed products) can be restored if something goes wrong during the Upgrade process (for example, hardware incompatibility). If the Upgrade process detects a malfunction, it automatically reverts to the Safe Upgrade image.

When the Upgrade process is complete, upon reboot you are given the option to start the SecurePlatform operating system using the upgraded version image or using the image prior to the Upgrade process.

**To upgrade Multi-Domain Server on SecurePlatform:**

1. If necessary, create an upgrade DVD and do these steps:
   a) Download the R75.40 Multi-Domain Server ISO file
   b) Burn the ISO file on a DVD.
   c) Connect an external DVD drive to the USB socket on the server.
      Make sure that the DVD with the R75.40 ISO file is in the DVD drive.
2. Log in to SecurePlatform (expert mode is necessary only for Smart-1 appliances).
3. Run: `patch add cd`  
The SecurePlatform upgrade package is installed.
4. Select the **SecurePlatform R75.40 Upgrade Package** and press **Enter**.
5. Type **yes** to verify the MD5 checksum.
6. If necessary, type **yes** to do a Safe Upgrade.
   Multi-Domain Server is upgraded to R75.40.
7. Remove the DVD from the drive.
8. Restart the server.
9. Run this command to update the version of all Domain Management and Log Server objects located on this server: `/opt/CPmds-R75.40/scripts/mds_fix_cmas_clms_version -c ALL -n <Multi-Domain Server name>`

### Exporting and Importing a Multi-Domain Server

You can upgrade to the current version by replicating a deployment from existing (source) Multi-Domain Servers to target Multi-Domain Servers. This process combines a simplified methodology for upgrading a Multi-Domain Security Management deployment with the ability to thoroughly test the deployment prior to implementation.

Use the `UnixInstallScript` command, with the **Export** option, to extract database and configuration settings from a Multi-Domain Server, together with its Domain Management Servers, and then stores this data in a single TGZ file. If you are working with a high availability deployment, you must export the primary Multi-Domain Server.

Use the `mds_import` command to import the contents of a saved TGZ file to a separate, newly installed Multi-Domain Server.

These commands export and import the following information:

- Global Multi-Domain Server database
- All Domain Management Servers
- GUI Clients
- Administrators and permissions
- Licenses
- Log files (optional)

### Planning the Upgrade

Before you start the upgrade, consider these points:

- Make sure that the target Multi-Domain Server meets the minimum hardware and operating system requirements and is configured identically to the source Multi-Domain Server.
- If the target Multi-Domain Server uses a different leading IP address than the source Multi-Domain Server, you must change the Multi-Domain Server IP address and the external interface.
- You must upgrade all Multi-Domain Servers in your deployment, including high availability and load sharing members.
- The target Multi-Domain Server should be on an isolated network segment so the gateways associated with the source Multi-Domain Server are not affected until the process is complete and fully tested.

### Exporting a Multi-Domain Server Deployment

After you begin to export from the source Multi-Domain Server, avoid making configuration changes on that Multi-Domain Server. Changes made after export starts are not included in the tgz file. You will need to make such changes manually on the target after you complete the upgrade.

To export a Multi-Domain Server to a TGZ file:

1. Mount the Multi-Domain installation media to a subdirectory.
2. Change the directory to the mounted directory.
3. Browse to the directory which has the name of the operating system of your Multi-Domain Server.
4. Run: UnixInstallScript
5. Select the Export option.
6. Follow the instructions on the screen.
7. When prompted, choose whether or not you wish to save the log files to the tgz file.
   
   Note - Exporting log files can significantly increase the tgz file size and the time required to complete the upgrade.

**Importing a Multi-Domain Server deployment**

To import a Multi-Domain Server deployment onto a target machine:
1. Perform a clean Multi-Domain Server installation on the target machine, according to the instructions for your specific platform.
2. Copy the appropriate exported tgz file from the source Multi-Domain Server to the new target Multi-Domain Server. The tgz file conforms to the following naming convention: exported_mds_<time & date stamp>.tgz
3. Run the mds_import command on the target Multi-Domain Server. Follow the instructions on the screen.
4. Run mdsstart on the target Multi-Domain Server.
5. Test to confirm that the replication has been successful:
   a) Start the Multi-Domain Server.
   b) Verify that all Domain Management Servers are running and that you can connect to the Multi-Domain Server using the SmartDomain Manager and Global SmartDashboard.
   c) Connect to the Domain Management Servers using SmartDashboard.

**Replicate and Upgrade**

Choose this type of upgrade if you intend to change hardware as part of the upgrade process, or if you want to test the upgrade process first. The existing Multi-Domain Server installation is copied to another machine (referred to as the target machine) by using the mds_backup and mds_restore commands.

To perform the Replicate and Upgrade process:
1. Back up your existing Multi-Domain Server. Run one of these:
   - mds_backup
   - UnixInstallScript and select the Backup option
2. Install a fresh Multi-Domain Server on the target machine.
   To restore your existing Multi-Domain Server, first install a fresh Multi-Domain Server on the target machine that is the same version as the existing Multi-Domain Server.
   
   Note - Make sure the target machine is on an isolated network segment, so that gateways connected to the original Multi-Domain Server are not affected until you switch to the target machine.
3. Restore the Multi-Domain Server on the target machine. Copy the files created by the backup process to the target machine and run: mds_restore.
   
   Important - In Gaia, run this command from expert mode and exit after running the command. You must run this command from the folder that contains the backup file.
   1. Go to the folder that contains the backup file.
   2. Enter ./mds_restore
4. If your target machine and the source machine have different IP addresses, change the IP Address of the restored Multi-Domain Server to the new IP address. If your target machine and the source machine have different interface names (for example: hme0 and hme1), change the interface of the restored Multi-Domain Server to the new interface name.
5. Test to confirm that the replication is successful:
   a) Start the Multi-Domain Server.
b) Make sure that all Domain Management Servers are running and that you can connect to the Multi-Domain Server with SmartDomain Manager and Global SmartDashboard.

c) Connect to Domain Management Servers using SmartDashboard.

6. Stop the Multi-Domain Server on the target machine and upgrade.

7. Run: `Container2MultiDomain`

8. Start the Multi-Domain Server.

**Gradual Upgrade to Another Computer**

In a gradual upgrade, you export Domain Management Servers one at a time from the source Multi-Domain Server to a target Multi-Domain Server of the latest version.

The gradual upgrade does not keep all data.

<table>
<thead>
<tr>
<th>Data Not Exported</th>
<th>To get this data in the new environment:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-Domain Security Management Administrators and management consoles</td>
<td>Redefine and reassign to Domains after the upgrade.</td>
</tr>
<tr>
<td>Policy assignment to Domains</td>
<td>Assign policies to Domains after the upgrade.</td>
</tr>
<tr>
<td>Status of global communities</td>
<td>Run: <code>mdsenv; fwm mds rebuild_global_communities_status all</code></td>
</tr>
</tbody>
</table>

**To run a gradual upgrade:**

1. Install the Multi-Domain Server on the target machine.

2. On the target Multi-Domain Server, create a Domain and Domain Management Server. Do not start the Domain Management Server.

3. Run: `migrate export`
   
   The migrate export command exports the Domain Management Server database to a .tgz file on the Multi-Domain Server. It also transfers the licenses for the Domain Management Server.

4. Run: `cma_migrate <src tgz> <FWDIR on target>`

5. The `cma_migrate` (on page 93) command imports the Domain Management Server database (using the TGZ created by the migrate export command) to the Multi-Domain Server.


7. Run: `mdsenv; mdsstart`

8. Use `migrate_global_policies` to import the global policies.

**Gradual Upgrade with Global VPN Communities**

The gradual upgrade process for a Multi-Domain Server using Global VPN Communities is not fundamentally different from the gradual upgrade process described above, with the following exceptions:

1. Global VPN community setup involves the Global database and the Domain Management Servers that are managing gateways participating in the global communities. When gradually upgrading a GVC environment, split the upgrade into two parts:
   
   - one for all Domain Management Servers that do not participate in the Global VPN Community
   - one for Domain Management Servers that do participate with the Global VPN Community

2. If some of your Domain Management Servers have already been migrated and some have not and you would like to use the Global Policy, make sure that it does not contain gateways of non-existing Domains. To test for non-existing Domains, assign this Global Policy to a Domain. If the assignment operation fails and the error message lists problematic gateways, you have at least one non-existing Domain. If this occurs:
   
   a) Run the `where used` query from the Global SmartDashboard > Manage > Network Objects > Actions to identify where the problematic gateways are used in the Global Policy. Review the result set, and edit or delete list items as necessary. Make sure that no problematic gateways are in use.
b) The gateways must be disabled from global use:
   
   (i) From the **General View**, right-click a gateway and select **Disable Global Use**.

   (ii) If the globally used gateway refers to a gateway of a Domain that was not migrated, you can remove the gateway from the global database by issuing a command line command. First, make sure that the Global SmartDashboard is not running, and then execute the command:

   \`
   mdsenv; remove_globally_used_gw <Global name of the gateway>
   \`

3. When issuing the command: `migrate_global_policies` where the existing Global Policy contains Global Communities, the resulting Global Policy contains:

   - Global gateways from the existing database
   - Global gateways from the migrated database

   As a result of the migration, the Global Communities are overridden by the migrated database.

4. The gradual upgrade does not restore the Global Communities statuses, therefore, if either the existing or the migrated Global Policy contains Global Communities, reset the statuses from the command line with the Multi-Domain Server started.

   \`
   mdsenv; fwm mds rebuild_global_communities_status all
   \`

---

**Migrating from Security Management Server to Domain Management Server**

This section describes how to migrate the Security Management Server product of a standalone deployment to a Domain Management Server. Then you manage the former-standalone computer as a Security Gateway only from the Domain Management Server.

**Note** - To later undo the separation of the Security Management Server and Security Gateway on the standalone, back up the standalone computer before you migrate.

**Before migrating:**

1. Make sure that the target Domain Management Server IP address can communicate with all gateways.

2. Add an object representing the Domain Management Server (name and IP address) and define it as a Secondary Security Management Server.

3. Install policy on all managed gateways.

4. Delete all objects or access rules created in steps 1 and 2.

5. If the standalone computer already has Security Gateway installed:
   - Clear the Firewall option in the Check Point Products section of the gateway object. You may have to first remove it from the Install On column of your Rule Base (and then add it again).
   - If the gateway participates in a VPN community, remove it from the community and erase its certificate. Note these changes, to undo them after the migration.

6. Save and close SmartDashboard. Do not install policy.

**To migrate the management database to the Domain Management Server:**

1. Go to the fully qualified path of the migrate export command.

2. Run: `migrate export [-l] <output file>`

3. Create a new Domain Management Server on the Multi-Domain Server, but do not start it.

4. Migrate the exported database into the Domain Management Server. Use the `cma_migrate` command or the import operation from the SmartDomain Manager, specifying as an argument the database location you specified in step 2.

   **Note** - To run the `cma_migrate` utility from the SmartDomain Manager, right-click a Domain Management Server and select **Options > Import Domain Management Server**. In the Import window, when you enter the path to the exported database file, include the name of the exported database file at the end of the path.

   You can also run `mdscmd migratcma` to import files to a Domain Management Server.
5. Restart the Domain Management Server and launch SmartDashboard.
6. In SmartDashboard, under **Network Objects**, locate:
   - An object with the Name and IP address of the Domain Management Server primary management object (migrated). Previous references to the standalone management object now refer to this object.
   - An object for each gateway managed previously by Security Management Server.
7. Edit the Primary Management Object and remove all interfaces (*Network Object > Topology > Remove*).
8. Create an object for the Security Gateway on the standalone machine (from *New > Check Point > Gateway*), and:
   - Assign a Name and IP address for the gateway.
   - Select the appropriate Check Point version.
   - Enabled the installed Software Blades.
   - If the Security Gateway belonged to a VPN Community, add it back.
   - Do not initialize communication.
9. Run Domain Management Server on the primary management object and, in each location, consider changing to the new gateway object.
10. Install the policy on all other gateways, not the new one. If you see warning messages about this gateway because it is not yet configured, ignore them.
11. Uninstall the standalone deployment.
12. Install a Security Gateway on the previous standalone machine.
13. From the Domain Management Server SmartDashboard, edit the gateway object, define its topology, and establish trust between the Domain Management Server and the Security Gateway.

**Upgrading a High Availability Deployment**

- **Note** - The current version supports multiple Domain Management Servers for each Domain.

Multi-Domain Security Management High Availability gives uninterrupted management redundancy for all Domains. Multi-Domain Security Management High Availability operates at these levels:

- **Multi-Domain Server High Availability** - Multiple Multi-Domain Servers are, by default, automatically synchronized with each other. You can connect to any Multi-Domain Server to do Domain management tasks. One Multi-Domain Server is designated as the **Active** Multi-Domain Server. Other Multi-Domain Servers are designated as **Standby** Multi-Domain Servers.
  - You can only do Global policy and global object management tasks using the active Multi-Domain Server. In the event that the active Multi-Domain Server is unavailable, you must change one of the standby Multi-Domain Servers to active.

- **Domain Management Server High Availability** - Multiple Domain Management Servers give Active/Standby redundancy for Domain management. One Domain Management Server for each Domain is **Active**. The other, fully synchronized Domain Management Servers for that Domain, are standbys. In the event that the Active Domain Management Server becomes unavailable, you must change one of the standby Domain Management Servers to active.
  - You can also use ClusterXL to give High Availability redundancy to your Domain Security Gateways. You use SmartDashboard to configure and manage Security Gateway High Availability for Domain Management Servers.

**Pre-Upgrade Verification and Tools**

Run the pre-upgrade verification on all Multi-Domain Servers before upgrading any Multi-Domain Servers. Select the **Pre-Upgrade Verification Only** option from *UnixInstallScript*. Upgrade the primary Multi-Domain Server only after you have fixed all errors and reviewed all warnings for all Multi-Domain Servers.
**Multi-Domain Server High Availability**

Multi-Domain Servers can only communicate and synchronize with other Multi-Domain Servers running the same version. If your deployment has more than one Multi-Domain Server, make sure they are upgraded to the same version.

**To upgrade multiple Multi-Domain Servers:**
1. Upgrade the primary Multi-Domain Server.
2. Upgrade the other Multi-Domain Servers.

During the upgrade process, we recommend that you do not use any of the Multi-Domain Servers to make changes to the databases. This can cause inconsistent synchronization between Multi-Domain Servers.

**Note** - You must upgrade your Multi-Domain Log Servers to the same version as the Multi-Domain Servers.

**Upgrading Multi-Domain Servers and Domain Management Servers**

**To upgrade Multi-Domain Server and Domain Management Server:**
1. Run pre-upgrade verification for all Multi-Domain Servers.
2. If a change to the global database is necessary, synchronize the Multi-Domain Servers immediately after making these changes. Update the database on one Multi-Domain Server and start synchronization. The other Multi-Domain Servers will get the database changes automatically.
3. If global database changes affect a global policy assigned to a Domain, assign the global policy again to all affected Domains.
4. If the verification command finds Domain Management Server level errors (for example, gateways that are no longer supported by the new version):
   a) Make the required changes on the Active Domain Management Server.
   b) Synchronize the Active Domain Management Server with all Standby Domain Management Servers.
5. If a Domain has Log Servers:
   a) In the Domain SmartDashboard, manually install the new database: select Policy > Install Database.
   b) Select all Log Servers.
   c) Make sure that the change to the Domain Log Server is successful.

**Note** - When synchronizing, make sure that you have only one active Multi-Domain Server and one active Domain Management Server for each Domain.

Change the active Multi-Domain Server and Domain Management Server, and then synchronize the Standby computers.

**Updating Objects in the Domain Management Server Databases**

After upgrading the Multi-Domain Servers and Domain Management Servers, you must update the objects in all Domain Management Server databases. This is necessary because upgrade does not automatically update the object versions attribute in the databases. If you do not manually update the objects, the standby Domain Management Servers and Log Servers will show the outdated versions.

Update the objects with these steps on each Multi-Domain Server.

**To update Domain Management Server and Domain Log Server objects:**
1. Make sure that all Domain Management Servers are up: mdsstat
   If a Domain Management Server is down, resolve the issue, and start the Domain Management Server: mds_startcustomer
2. Go to the top-level CLI: mdserv
3. Run: `$MDSDIR/scripts/mds_fix_cmas_clms_version -c ALL`
   
   **Optional:** Update one Domain Management Server or Domain Log Server at a time with this command:
   `$MDSDIR/scripts/mds_fix_cmas_clms_version -c ALL -n <server_name>`

4. Synchronize all standby Domain Management Servers.

### Managing Domain Management Servers During the Upgrade Process

The best practice is to avoid making any changes to Domain Management Server databases during the upgrade process. If your business model cannot support management down-time during the upgrade, you can continue to manage Domain Management Servers during the upgrade process.

This creates a risk of inconsistent Domain Management Server database content between instances on different Multi-Domain Servers. The synchronization process cannot resolve these inconsistencies.

After successfully upgrading one Multi-Domain Server, you can set its Domain Management Servers to **Active** while you upgrade the others. Synchronization between the Domain Management Servers occurs after all Multi-Domain Servers are upgraded.

If, during the upgrade process, you make changes to the Domain Management Server database using different Multi-Domain Servers, the contents of the two (or more) databases will be different. Because you cannot synchronize these databases, some of these changes will be lost. The Domain Management Server High Availability status appears as **Collision**.

You must decide which database version to retain and synchronize it to the other Domain Management Servers. You then must re-enter the lost changes to the synchronized database.

### Restarting Domain Management Servers

After completing the upgrade process, start Domain Management Servers: `mdsstart`

### Restoring Your Original Environment

**Before the upgrade:**

Pre-upgrade utilities are an integral part of the upgrade process. In some cases, you are required to change your database before the actual upgrade can take place or the Pre-Upgrade Verifier suggests you execute utilities that perform the required changes automatically. Even if you decide to restore your original environment, keep the changes you made as a result of the pre-upgrade verification.

Prepare a backup of your current configuration using the `mds_backup` utility from the currently installed version. Prepare a backup as the first step of the upgrade process and prepare a second backup right after the Pre-Upgrade Verifier successfully completes with no further suggestions.

**To restore your original environment:**

1. Remove the new installation:
   a) For a **SecurePlatform** server, manually remove the new software packages. It can be easier to remove all installed Check Point packages and install the original version.
   b) For all other servers, run the `mds_remove` utility.

2. Run the `mds_restore` command with the backup file.

3. The original environment is restored.

**Important** - In Gaia, run the `mds_restore` command from expert mode and exit after running the command. You must run this command from the folder that contains the backup file:

1. Go to the folder that contains the backup file.
2. Enter `./mds_restore`
Removing Earlier Version Multi-Domain Server Installations

After upgrading your Multi-Domain Server to the latest version, earlier version files are not automatically deleted from the disk. This lets you revert to the old version in the event there are problems with the upgrade. These files can take up a lot of disk space and cause performance degradation.

After you complete testing your upgrade, we recommend that remove these earlier version files. You can use the `mds_remove_version` tool to automatically remove old installations with no effect on the installed version.

**To remove old installations:**
1. Backup your system.
2. Download the tool.
3. Copy the `mds_remove_version.sh` script to the Multi-Domain Server.
4. Run `mds_remove_version.sh`.
   There are no parameters or arguments.
5. Confirm when prompted.
6. Make sure that the old files were successfully removed.

**Important** - This tool removes major releases and all minor releases installed over a major release. For example, if R71.50 is installed on your Multi-Domain Server, and you upgraded to R75.40, the tool removes R71 and R71.50 files.

Changing the Multi-Domain Server Interfaces

If your target machine and the source machine have different IP addresses, follow the steps listed below it to change the restored Multi-Domain Server to the new IP address.

**To change the IP address:**
1. Stop the Multi-Domain Server by running `mdsststop`.
2. Change the IP address in `$MDSDIR/conf/LeadingIP` file to the new IP address.
3. Edit the `$MDSDIR/conf/mdsdb/mdss.C` file. Find the Multi-Domain Server object that has the source Multi-Domain Server IP address and change its IP address to the new IP address. Do not change the Multi-Domain Server name.
4. Install a new license on the target Multi-Domain Server with the new Multi-Domain Server IP address.
5. For multiple Multi-Domain Server environments, repeat steps 1 to 4 for each Multi-Domain Server that has a changed IP address.

If your target machine and the source machine have different interface names (e.g., `hme0` and `hme1`), follow the steps listed below to adjust the restored Multi-Domain Server to the new interface name.

**To change the interface:**
1. Change the interface name in file `$MDSDIR/conf/external.if` to the new interface name.
2. For each Domain Management Server, replace the interface name in `$FWDIR/conf/vip_index.conf`.

IPS with Multi-Domain Security Management

- When upgrading to R75.40, the previous Domain IPS configuration is overridden when you first assign a Global Policy.
  We recommend that you save each Domain policy, so that you can restore the settings after the upgrade. To do so, go to the Domain Configuration window > Assign Global Policy tab, and enable Create database version.
- If you manage IPS globally, you must reassign the global policy before installing the policy on Security Gateways.
- Customers upgrading to the current version should note that the IPS subscription has changed.
- All Domains subscribed to IPS are automatically assigned to an "Exclusive" subscription
- "Override" and "Merge" subscriptions are no longer supported.

Chapter 7

Upgrading with SmartUpdate

Introducing SmartUpdate

SmartUpdate automatically distributes applications and updates for Check Point and OPSEC Certified products, and manages product licenses. It provides a centralized means to guarantee that Internet security throughout the enterprise network is always up to date. SmartUpdate turns time-consuming tasks that could otherwise be performed only by experts into simple point and click operations.

SmartUpdate extends your organization’s ability to provide centralized policy management across enterprise-wide deployments. SmartUpdate can deliver automated software and license updates to hundreds of distributed security gateways from a single management console. SmartUpdate ensures security deployments are always up-to-date by enforcing the most current security software. This provides greater control and efficiency while dramatically decreasing maintenance costs of managing global security installations.

SmartUpdate enables remote upgrade, installation and license management to be performed securely and easily. A system administrator can monitor and manage remote gateways from a central location, and decide whether there is a need for software upgrade, new installations and license modification. It is possible to remotely upgrade:

- Check Point Security Gateways
- Hotfixes, Hotfix Accumulators (HFAs) and patches
- Third party OPSEC applications
- UTM-1 Edge
- Check Point IPSO Operating System
- SecurePlatform

All operations that can be performed via SmartUpdate can also be done via the command line interface. See The SmartUpdate Command Line (on page 118) for more information.
Understanding SmartUpdate

SmartUpdate installs two repositories on the Security Management server:

- **License & Contract Repository**, which is stored on all platforms in the directory `$FWDIR\conf`.
- **Package Repository**, which is stored:
  - on Windows machines in `C:\SUroot`.
  - on UNIX machines in `/var/suroot`.

  The Package Repository requires a separate license, in addition to the license for the Security Management server. This license should stipulate the number of nodes that can be managed in the Package Repository.

Packages and licenses are loaded into these repositories from several sources:

- the Download Center web site (packages)
- the Check Point DVD (packages)
- the User Center (licenses)
- by importing a file (packages and licenses)
- by running the `cplic` command line

Of the many processes that run on the Check Point Security Gateways distributed across the corporate network, two in particular are used for SmartUpdate. Upgrade operations require the `cprid` daemon, and license operations use the `cpd` daemon. These processes listen and wait for the information to be summoned by the Security Management server.

From a remote location, an administrator logged into the Security Management server initiates operations using the SmartUpdate tool. The Security Management server makes contact with the Check Point Security Gateways via the processes that are running on these gateways in order to execute the operations initiated by the system administrator (e.g., attach a license, or upload an upgrade). Information is taken from the repositories on the Security Management server. For instance, if a new installation is being initiated, the information is retrieved from the Package Repository; if a new license is being attached to remote gateway, information is retrieved from the License & Contract Repository.

This entire process is Secure Initial Communication (SIC) based, and therefore completely secure.
**SmartUpdate - Seeing it for the First Time**

SmartUpdate has two tabs:

- **Packages** tab shows the packages and Operating Systems installed on the Check Point Security Gateways managed by the Security Management server. Operations that relate to packages can only be performed in the **Packages** tab.

- **Licenses** tab shows the licenses on the managed Check Point Security Gateways. Operations that relate to licenses can only be performed in the **Licenses** tab.

These tabs are divided into a tree structure that displays the packages installed and the licenses attached to each managed Security Gateway.

The tree has three levels:

- Root level shows the name of the Security Management server to which the GUI is connected.
- Second level shows the names of the Check Point Security Gateways configured in SmartDashboard.
- Third level shows the Check Point packages (in the **Packages** tab) or installed licenses (in the **Licenses** tab) on the Check Point Security Gateway.

Additionally, the following panes can be displayed:

- **Package Repository** - shows all the packages available for installation. To view this pane, select **Packages > View Repository**.
- **License & Contract Repository** - shows all licenses (attached or unattached). To view this pane, select **Licenses > View Repository**.
- **Operation Status** - shows past and current SmartUpdate operations. To view this pane, select **Operations > View Status**. In this pane you can read about:
  - Operations performed (e.g., *Installing package <X> on Gateway <Y>*, or *Attaching license <L> to Gateway <Y>.*).
  - The status of the operation being performed, throughout all the stages of its development (for instance, operation started, or a warning).
  - A progress indicator.
  - The time that the operation takes to complete.

**Common Operations**

- **Drag and Drop** - Packages and licenses can be dragged and dropped from the Repositories onto the Security Gateways in the **Package/Licenses Management** tree. This drag and drop operation will invoke the *distribute* or *attach* operation respectively.

- **Search** - To search for a text string: select **Tools > Find**. In **Find what**, enter a string to search for. Select **search location**: **Network Objects License & Contract** tab or **Package Repository**.

- **Sort** - To sort in ascending or descending order, click the column title in the **Licenses** or **Packages** tab.

- **Expand or Collapse** - To expand or collapse the Check Point Security Gateways tree structure, right-click on the tree root and choose **Expand/Collapse**.

- **Change view** - To change the Repository view, right-click on a blank row or column in the **Repository** window and select an option. For example, in the **Licenses Repository** you can select to see only the attached licenses.

- **Clear Repository of completed operations** - To clear a single operation, select the line in the **Operation Status** window and press the **Delete** key, or right-click and select **Clear**. To clear all completed operations from the **Operation Status** window, select **Status > Clear all completed operations**.

- **See operation details** - To view operation details, in the **Operation Status** window, double-click the operation entry. The **Operation Details** window shows the operation description, start and finish times, and progress history. The window is resizable. To copy the Status lines to the clipboard, select the line, right-click and choose **Copy**.
**Print views** - To print a view, select File > Print. The Choose Window is displayed. Select the window that you would like to print, e.g., Operation Status or License & Contract Repository. Optionally, you can adjust the print setup settings, or preview the output.

**See logs** -
- Log of SmartUpdate package operations - $SUROOT\log\suelog.
- Audit log of SmartUpdate operations - SmartView Tracker Audit View.

## Upgrading Packages

The latest management version can be applied to a single Check Point Security Gateway, or to multiple Check Point Security Gateways simultaneously. Use the Upgrade all Packages operation to bring packages up to the most current management version.

When you perform Upgrade all Packages all products are upgraded to the latest Security Management server version. This process upgrades both the software packages and its related HFA (that is, the most up to date HFA is installed). Once the process is over, the software packages and the latest HFA will exist in the Package Repository.

To upgrade Check Point packages to versions earlier than the latest available version, they must be upgraded one-by-one. Use the Distribute operation to upgrade packages to management versions other than the most current, or to apply specific HFAs.

In addition, SmartUpdate recognizes gateways that do not have the latest HFA. When you right-click an HFA in the Package Repository and select Distribute for that specific HFA, you will receive a recommendation to install a new HFA on the gateways that do not have it.

## Prerequisites for Remote Upgrades

- Make sure that SmartUpdate connections are allowed. Go to SmartDashboard > Policy > Global Properties > FireWall Implied Rules, and make sure that Accept SmartUpdate Connections is selected.
- Secure Internal Communication (SIC) must be enabled between the Security Management server and remote Check Point Security Gateways.

## Retrieving Data from Check Point Security Gateways

In order to know exactly what OS, vendor and management version is on each remote gateway, you can retrieve that data directly from the gateway.

- To retrieve data on a specific Check Point Security Gateway, right-click on the gateway in the Package Management window and select Get Gateway Data.
- If you are installing or upgrading multiple Check Point Security Gateways, from the Packages menu select Get Data From All.

## Adding New Packages to the Package Repository

To distribute (that is, install) or upgrade a package, you must first add it to the Package Repository. You can add packages to the Package Repository from the following three locations:

### Download Center

1. Select Packages > New Package > Add from Download Center.
2. Accept the Software Subscription Download Agreement.
3. Enter your user credentials.
4. Select the packages to be downloaded. Use the Ctrl and Shift keys to select multiple files. You can also use the Filter to show just the packages you need.
5. Click Download to add the packages to the Package Repository.
User Center
Use this procedure for adding OPSEC packages and Hotfixes to the Package Repository.
1. Open a browser to the Check Point Support Center (http://supportcenter.checkpoint.com).
2. Select the package you want to upgrade.
3. Enter your user credentials.
4. Accept the Software Subscription Download Agreement.
5. Choose the appropriate platform and package, and save the download to the local disk.
7. In the Add Package window, navigate to the desired .tgz file and click Open to add the packages to the Package Repository.

Check Point DVD
1. Select Packages > New Package > Add from CD/DVD.
2. Browse to the optical drive, and click OK.
   A window opens, showing the available packages on the DVD.
3. Select the packages to add to the Package Repository (Ctrl-select for more than one package).
4. Click OK.

Verifying the Viability of a Distribution
Verify that the distribution (that is, installation) or upgrade is viable based upon the Check Point Security Gateway data retrieved. The verification process checks that:
- the Operating System and currently distributed packages are appropriate for the package to be distributed,
- there is sufficient disk space,
- the package is not already distributed,
- the package dependencies are fulfilled.
To manually verify a distribution, select Packages > Pre-Install Verifier....

Transferring Files to Remote Devices
When you are ready to upgrade or distribute packages from the Package Repository, it is recommended to transfer the package files to the devices to be upgraded. Placing the file on the remote device shortens the overall installation time, frees Security Management server for other operations, and reduces the chance of a communications error during the distribute/upgrade process. Once the package file is located on the remote device, you can activate the distribute/upgrade whenever it is convenient.
Transfer the package file(s) to the directory $SUROOT/tmp on the remote device. If this directory does not exist, do one of the following:
- For Windows gateways, place the package file in the directory SYSTEMDRIVE\temp (SYSTEMDRIVE is usually C:)
- For UNIX gateways, place the package file in the directory /opt/.

Distributions and Upgrades
You can upgrade all packages on one remote gateway, or you can distribute specific packages one-by-one for all gateways.

Upgrading All Packages on a Check Point Remote Gateway
All Check Point packages on a single remote gateway, other than the operating system, can be remotely upgraded in a single operation. The Upgrade All Packages function allows you to simultaneously distribute or upgrade multiple packages to the latest management version. Proceed as follows:
1. Select **Packages > Upgrade all Packages**.

2. From the **Upgrade All Packages** window, select the Check Point Security Gateways that you want to upgrade. Use the **Ctrl** and **Shift** keys to select multiple devices.

   ```
   Note - The **Reboot if required...** option (checked by default) is required in order to activate the newly distributed package.
   ```

3. If one or more of the required packages are missing from the **Package Repository**, the **Download Packages** window opens. Download the required package directly to the **Package Repository**.

4. Click **Upgrade**.

   The installation proceeds only if the upgrade packages for the selected packages are available in the **Package Repository**.

**Updating a Single Package on a Check Point Remote Gateway**

Use this procedure to select the specific package that you want to apply to a single package. The **distribute** function allows you to:

- Upgrade the OS on an IP appliance or on SecurePlatform
- Upgrade any package to a management version other than the latest
- Apply Hot Fix Accumulators (HFAs)

Proceed as follows:

1. In the **Package Management** window, click the Check Point Security Gateway you want to upgrade.

2. Select **Packages > distribute**.

3. From the **distribute Packages** window, select the package that you want to distribute. Use the **Ctrl** and **Shift** keys to select multiple packages, and then click **distribute**.

   The installation proceeds only if the upgrade packages selected are available in the **Package Repository**.

**Upgrading UTM-1 Edge Firmware with SmartUpdate**

The UTM-1 Edge gateway firmware represents the software that is running on the appliance. The UTM-1 Edge gateway's firmware can be viewed and upgraded using SmartUpdate. This is a centralized management tool that is used to upgrade all gateways in the system by downloading new versions from the download center. When installing new firmware, the firmware is prepared at the Security Management server, downloaded and subsequently installed when the UTM-1 Edge gateway fetches for updates. Since the UTM-1 Edge gateway fetches at periodic intervals, you will notice the upgraded version on the gateway only after the periodic interval has passed.

If you do not want to wait for the fetch to occur you can download the updates with the **Push Packages Now (UTM-1 Edge only)** option in the **Packages** menu. With this option it is possible to create a connection with UTM-1 Edge in order to access new (that is, the latest) software package(s). The distribution is immediate and avoids the need to wait for the fetch to get the package.

**Canceling and Uninstalling**

You can stop a distributed installation or upgrade while in progress.

**To cancel a SmartUpdate operation:**

- Select **Status > Stop Operation**.

At a certain point in any operation, the **Stop Operation** function becomes unavailable. You can cancel the operation after this point. This will uninstall changes made. Use this also to uninstall distributed installations or upgrades.

**To uninstall:**

1. Wait for the operation to complete.

2. Select **Packages > Uninstall**.

   ```
   Note - Uninstallation restores the gateway to the last management version distributed.
   ```
Upgrading with SmartUpdate

**Restarting the Check Point Security Gateway**

After you distribute an upgrade or uninstall, reboot the gateway.

**To restart the gateway:**

- Select **Reboot if required** at the final stage of upgrade or uninstall.
- Select **Packages > Reboot Gateway**.

**Recovering from a Failed Upgrade**

If an upgrade fails on SecurePlatform, SmartUpdate restores the previously distributed version.

**SecurePlatform Automatic Revert**

If an upgrade or distribution operation fails on a SecurePlatform device, the device will reboot itself and automatically revert to the last version distributed.

**Snapshot Image Management**

Before performing an upgrade, you can use the command line to create a Snapshot image of the SecurePlatform OS, or of the packages distributed. If the upgrade or distribution operation fails, you can use the command line to revert the disk to the saved image.

- To create a Snapshot file on the gateway, type:
  
  `cprinstall snapshot <object name> <filename>`

- To show the available Snapshot files, type:
  
  `cprinstall show <object name>`

- To revert to a given Snapshot file, type:
  
  `cprinstall revert <object name> <filename>`

  **Note** - Snapshot files are stored at `/var/CPsnapshot` on the gateway.

**Deleting Packages from the Package Repository**

To clear the **Package Repository** of extraneous or outdated packages, select a package, or Ctrl-select multiple packages and select **Packages > Delete Package**. This operation cannot be undone.

**Managing Licenses**

With SmartUpdate, you can manage all licenses for Check Point packages throughout the organization from the Security Management server. SmartUpdate provides a global view of all available and installed licenses, allowing you to perform such operations as adding new licenses, attaching licenses and upgrading licenses to Check Point Security Gateways, and deleting expired licenses. Check Point licenses come in two forms, Central and Local.

- The **Central** license is the preferred method of licensing. A Central license ties the package license to the IP address of the Security Management server. That means that there is one IP address for all licenses; that the license remains valid if you change the IP address of the gateway; and that a license can be taken from one Check Point Security Gateway and given to another with ease. For maximum flexibility, it is recommended to use Central licenses.

- The **Local** license is an older method of licensing, however it is still supported by SmartUpdate. A Local license ties the package license to the IP address of the specific Check Point Security Gateway, and cannot be transferred to a gateway with a different IP address.

When you add a license to the system using SmartUpdate, it is stored in the **License & Contract Repository**. Once there, it must be installed to the gateway and registered with the Security Management server. Installing and registering a license is accomplished through an operation known as **attaching a**
Upgrading with SmartUpdate

license. Central licenses require an administrator to designate a gateway for attachment, while Local licenses are automatically attached to their respective Check Point Security Gateways.

Licensing Terminology

- **Add**
  Licenses received from the User Center should first be added to the License & Contract Repository. Adding a local license to the License & Contract Repository also attaches it to the gateway. Licenses can be conveniently imported to the License & Contract Repository via a file and they can be added manually by pasting or typing the license details.

- **Attach**
  Licenses are attached to a gateway via SmartUpdate. Attaching a license to a gateway involves installing the license on the remote gateway, and associating the license with the specific gateway in the License & Contract Repository.

- **Central License**
  A Central License is a license attached to the Security Management server IP address, rather than the gateway IP address. The benefits of a Central License are:
  - Only one IP address is needed for all licenses.
  - A license can be taken from one gateway and given to another.
  - The new license remains valid when changing the gateway IP address. There is no need to create and install a new license.

- **Certificate Key**
  The Certificate Key is a string of 12 alphanumeric characters. The number is unique to each package. For an evaluation license your certificate key can be found inside the mini pack. For a permanent license you should receive your certificate key from your reseller.

- **CPLIC**
  A command line for managing local licenses and local license operations. For additional information, refer to the R75.40 Command Line Interface Reference Guide (http://supportcontent.checkpoint.com/solutions?id=sk67581).

- **Detach**
  Detaching a license from a gateway involves uninstalling the license from the remote gateway and making the license in the License & Contract Repository available to any gateway.

- **State**
  Licenses can be in one of the following states:
  The license state depends on whether the license is associated with the gateway in the License & Contract Repository, and whether the license is installed on the remote gateway. The license state definitions are as follows:
  - **Attached** indicates that the license is associated with the gateway in the License & Contract Repository, and is installed on the remote gateway.
  - **Unattached** indicates that the license is not associated with the gateway in the License & Contract Repository, and is not installed on any gateway.
  - **Assigned** is a license that is associated with the gateway in the License & Contract Repository, but has not yet been installed on a gateway.

- **Upgrade Status** is a field in the License & Contract Repository that contains an error message from the User Center when the Upgrade process fails.

- **Get**
  Locally installed licenses can be placed in the License & Contract Repository, in order to update the repository with all licenses across the installation. The Get operation is a two-way process that places all locally installed licenses in the License & Contract Repository and removes all locally deleted licenses from the License & Contract Repository.

- **License Expiration**
  Licenses expire on a particular date, or never. After a license has expired, the functionality of the Check Point package may be impaired.
- **Local License**  
  A **Local License** is tied to the IP address of the specific gateway and can only be used with a gateway or a Security Management server with the same address.

- **Multi-License File**  
  Licenses can be conveniently added to a gateway or a Security Management server via a file, rather than by typing long text strings. **Multi-license files** contain more than one license, and can be downloaded from the Check Point User Center (http://usercenter.checkpoint.com). **Multi-license files** are supported by the `cplic put` and `cplic add` command-line commands.

- **Features**  
  A character string that identifies the features of a package.

### License Upgrade

One of the many SmartUpdate features is to upgrade licenses that reside in the License & Contract Repository. SmartUpdate will take all licenses in the License & Contract Repository, and will attempt to upgrade them with the use of the Upgrade tool.

### The License Attachment Process

#### Introducing the License Attachment Process

When a Central license is placed in the **License & Contract Repository**, SmartUpdate allows you to attach it to Check Point packages. Attaching a license installs it to the remote gateway and registers it with the Security Management server.

New licenses need to be attached when:

- An existing license expires.
- An existing license is upgraded to a newer license.
- A Local license is replaced with a Central license.
- The IP address of the Security Management server or Check Point Security Gateway changes.

Attaching a license is a three step process.

1. Get real-time license data from the remote gateway.
2. Add the appropriate license to the **License & Contract Repository**.
3. Attach the license to the device.

The following explains the process in detail.

#### Retrieving License Data from Check Point Security Gateways

To know exactly what type of license is on each remote gateway, you can retrieve that data directly from the gateway.

- To retrieve license data from a single remote gateway, right-click on the gateway in the **License Management** window and select **Get Check Point Security Gateway Licenses**.
- To retrieve license data from multiple Check Point Security Gateways, from the **Licenses** menu and select **Get All Licenses**.

#### Adding New Licenses to the License & Contract Repository

To install a license, you must first add it to the **License & Contract Repository**. You can add licenses to the **License & Contract Repository** in the following ways:

**Download From the User Center**

1. Select **Network Objects License & Contract** tab > **Add License** > **From User Center**
2. Enter your credentials.
3. Perform one of the following:
   - Generate a new license - if there are no identical licenses, the license is added to the License & Contract Repository.
   - Change the IP address of an existing license, that is, Move IP.
   - Change the license from Local to Central.

**Importing License Files**
2. Browse to the location of the license file, select it, and click Open.

A license file can contain multiple licenses. Unattached Central licenses appear in the License & Contract Repository, and Local licenses are automatically attached to their Check Point Security Gateway. All licenses are assigned a default name in the format SKU@time date, which you can modify at a later time.

**Add License Details Manually**
You may add licenses that you have received from the Licensing Center by email. The email contains the license installation instructions.

1. Locate the license:
   - If you have received a license by email, copy the license to the clipboard. Copy the string that starts with cplic putlic... and ends with the last SKU/Feature. For example: cplic putlic1.1.1.1 06Dec2002 dw59Ufa2-eLLQ9NB-gPuyHzvQ-WKreSo4Zx CPSUITE-EVAL-3DES-NGX CK-1234567890
   - If you have a hard copy printout, continue to step 2.
2. Select the Network Objects License & Contract tab in SmartUpdate.
4. Enter the license details:
   - If you copied the license to the clipboard, click Paste License. The fields will be populated with the license details.
   - Alternatively, enter the license details from a hard-copy printout.
5. Click Calculate, and make sure the result matches the validation code received from the User Center.
6. You may assign a name to the license, if desired. If you leave the Name field empty, the license is assigned a name in the format SKU@ time date.
7. Click OK to complete the operation.

**Attaching Licenses**
After licenses have been added to the License & Contract Repository, select one or more licenses to attach to a Check Point Security Gateway.

1. Select the license(s).
2. Select Network Objects License & Contract tab > Attach.
3. From the Attach Licenses window, select the desired device.

If the attach operation fails, the Local licenses are deleted from the Repository.

**Detaching Licenses**
Detaching a license involves deleting a single Central license from a remote Check Point Security Gateway and marking it as unattached in the License & Contract Repository. This license is then available to be used by any Check Point Security Gateway.

To detach a license, select Network Objects License & Contract tab > Detach and select the licenses to be detached from the displayed window.

**Deleting Licenses from the License & Contract Repository**
Licenses that are not attached to any Check Point Security Gateway and are no longer needed can be deleted from the License & Contract Repository.
To delete a license:
1. Right-click anywhere in the License & Contract Repository and select View Unattached Licenses.
2. Select the unattached license(s) to be deleted, and click Delete.

Viewing License Properties
The overall view of the License & Contract Repository displays general information on each license such as the name of the license and the IP address of the machine to which it is attached. You can view other properties as well, such as expiration date, SKU, license type, certificate key and signature key.
To view license properties, double-click on the license in the Licenses tab.

Checking for Expired Licenses
After a license has expired, the functionality of the Check Point package will be impaired; therefore, it is advisable to be aware of the pending expiration dates of all licenses.
To check for expired licenses, select Licenses > ShowExpired Licenses.
To check for licenses nearing their dates of expiration:
1. In the License Expiration window, set the Search for licenses expiring within the next \(x\) days property.
2. Click Apply to run the search.
To delete expired licenses from the License Expiration window, select the detached license(s) and click Delete.

Exporting a License to a File
Licenses can be exported to a file. The file can later be imported to the License & Contract Repository. This can be useful for administrative or support purposes.
To export a license to a file:
1. In the Licenses Repository, select one or more licenses, right-click, and from the menu select Export to File....
2. In the Choose File to Export License(s) To window, name the file (or select an existing file), and browse to the desired location. Click Save.

All selected licenses are exported. If the file already exists, the new licenses are added to the file.

Managing Licenses Using SmartUpdate
To manage licenses using SmartUpdate, select the SmartUpdate view in the SmartDomain Manager Selection Bar. If you loaded SmartUpdate, you can also right-click a Multi-Domain Server object and select Applications > SmartUpdate from the Options menu. Licenses for components and blades are stored in a central repository.

To view repository contents:
1. Select SmartUpdate from the SmartDomain Manager Main menu.
2. Select SmartUpdate > Network Objects License & Contract > View Repository. The repository pane shows in the SmartUpdate view.

To add new licenses to the repository:
1. Select SmartUpdate from the SmartDomain Manager Main menu.
2. Select SmartUpdate > Network Objects License & Contract > Add License.
3. Select a method for adding a license:
   - From User Center - Obtain a license file from the User Center.
   - From file - Import a license file to the repository.
   - Manually - Open the Add License window and enter licenses information manually. You can copy the license string from a file and click Past License to enter the data.
You can now see the license in the repository.

To attach a license to a component:
1. Select SmartUpdate from the SmartDomain Manager Main menu.
2. Select **SmartUpdate** > **Network Objects License & Contract** > **Attach License**.
3. Select a license from the **Attach Licenses** window. The license shows as attached in the repository.

You can do a variety of other license management tasks using SmartUpdate. Refer to the **R75 Security Management Administration Guide** (http://supportcontent.checkpoint.com/documentation_download?ID=13953) for details.

**Web Security License Enforcement**

A gateway or gateway cluster requires a **Web Security** license if it enforces one or more of the following protections:
- Malicious Code Protector
- LDAP Injection
- SQL Injection
- Command Injection
- Directory Listing
- Error Concealment
- ASCII Only Request
- Header Rejection
- HTTP Methods

**Service Contracts**

Before upgrading a gateway or Security Management server, you need to have a valid support contract that includes software upgrade and major releases registered to your Check Point User Center account. The contract file is stored on Security Management server and downloaded to Check Point Security Gateways during the upgrade process. By verifying your status with the User Center, the contract file enables you to easily remain compliant with current Check Point licensing standards.

For more on service contracts, see the Service Contract Files Web page (http://www.checkpoint.com/ngx/upgrade/contract/index.html).

**Generating CPInfo**

CPInfo is a support tool that gathers into one text file a wide range of data concerning the Check Point packages in your system. When speaking with a Check Point Technical Support Engineer, you may be asked to run CPInfo and transmit the data to the Support Center. Download the tool from the Support Center (http://supportcontent.checkpoint.com/solutions?id=sk30567).

To launch CPInfo, select **Tools > Generate CPInfo**.
1. Choose the directory to which you want to save the output file.
2. Choose between two methods to name the file:
   - based on the SR number the technician assigns you, or
   - a custom name that you define.
3. Optionally, you may choose to add:
   - **log files** to the CPInfo output.
   - the **registry** to the CPInfo output.
The SmartUpdate Command Line

All management operations that are performed via the SmartUpdate GUI can also be executed via the command line. There are three main commands:

- `cppkg` to work with the Packages Repository.
- `cprinstall` to perform remote installations of packages.
- `cplic` for license management.

For details on how to use these commands, see the *R75.40 Command Line Interface Reference Guide* (http://supportcontent.checkpoint.com/solutions?id=sk67581).
Chapter 8

Advanced Upgrade and Database Migration

In This Chapter

Overview 119
Migration Workflow 120
Migrate Command Reference 128

Overview

Advanced Upgrade lets you move the management database from one server (source) to a new server (target). The source and target can be different versions, to make this part of the upgrade. Or they can be the same version, to move the Security Management Server to a different platform. You can use Advanced Upgrade to test the upgrade version before putting it into production.

Important -

- The set of products installed on the target computer must be equal to or greater than the set of products installed on the source.

- The version of the Security Management Server on the target must be equal to or greater than the version of the Security Management Server on the source.

Before Database Migration

1. Source computer
2. Management database migration path
3. R75.40 target computer, not connected to the network

After Database Migration

1. Target R75.40 computer connected to network

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Source computer</td>
<td>1</td>
<td>Target R75.40 computer connected to network</td>
</tr>
<tr>
<td>2</td>
<td>Management database migration path</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>R75.40 target computer, not connected to</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>the network</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Supported Upgrade Paths, Platforms and Products

Make sure that the upgrade from the version on the source computer is a supported. For a list of supported upgrade paths, platforms and products, see the R75.40 Release Notes (http://supportcontent.checkpoint.com/solutions?id=sk67581).

Migration Workflow

In this section:

- General Workflow
- Preparing the Source Server for New IP Address
- Getting the Migration Tools Package
- Using the Pre-Upgrade Verification Tool
- Exporting the Database
- Importing the Database
- Migrating the Database of a Secondary Security Management Server
- Completing Migration to a New IP Address
- Migrating to a Server with a Different Platform
- SmartReporter Database Migration
- SmartEvent Events Database Migration

This section includes a procedural overview for database migration and continues with detailed procedures for each platform. Also included are special procedures for migrating:

- A secondary Security Management Server
- To a server with a different IP address
- SmartReporter
- SmartEvent

General Workflow

First read the Release Notes to make sure that your upgrade path is supported.

If the target Security Management Server will not use the IP address of the source, prepare the environment to recognize the new IP address ("Preparing the Source Server for New IP Address" on page 121). Do this before you do the steps below.

On the source server:

1. Get the migration tools package ("Getting the Migration Tools Package" on page 122).
2. Extract the downloaded package.
**Important** - Put all extracted files in the same directory, and run the tools from this directory.

3. Make sure the files have executable permissions. For example, In the temporary directory, run `chmod 777 *`.

4. Run `fw logswitch` to close the SmartView Tracker log files. Only closed logs are migrated.

5. Close all Check Point GUI clients that are connected to the Security Management Server. Alternatively, if this is a computer that is not in production, run `cpstop` on the source computer.

**Important** - If you do not close the GUI clients or run `cpstop`, the exported management database can become corrupted.

6. Make sure the source server and the target server have network access.
   - The source and target servers must be connected to a network.
   - The connected network interface must have an IP address.
   - On SecurePlatform, the `ifconfig` command output must show that the interface is UP.
   - On Windows, the interface must be enabled in the Network Connections window.

7. Run the `pre_upgrade_verifier` command (see "Using the Pre-Upgrade Verification Tool" on page 122).

8. Correct all errors before continuing.

9. If the target server must have a different IP address than the source server, make the necessary changes on the source server (see "Completing Migration to a New IP Address" on page 125).

10. Export the management database ("Exporting the Database" on page 123).
    - If SmartReporter is installed on the source server, export the Log Consolidation database ("Exporting the SmartReporter Database" on page 126).
    - If SmartEvent is installed on the source server, export the Events database ("SmartEvent Events Database Migration" on page 127).

**On the target server:**

1. Install the R75.40 Security Management Server or a standalone deployment. Configure as required.

2. Get the most updated migration tools package ("Getting the Migration Tools Package" on page 122) for the target platform (recommended) or use the installed migration tools in `FWDIR/bin/upgrade_tools` on Unix platforms or `%FWDIR%/bin\upgrade_tools` on Windows.

3. Import the management database from the source server to the target ("Importing the Database" on page 124).
    - If SmartReporter is installed on the source server, import the Log Consolidation database (see "Importing the SmartReporter Database" on page 126).
    - If SmartEvent is installed on the source server, import the SmartEvent Events database ("SmartEvent Events Database Migration" on page 127).

4. If the target server has a different IP address than the source server, make the necessary changes to the license and target computer ("Completing Migration to a New IP Address" on page 125).
    - If the target server is a different platform that the source server, edit the database ("Migrating to a Server with a Different Platform" on page 125).

5. Test the target installation.

6. Disconnect the source server from the network.

7. Connect the target server to the network.

**Preparing the Source Server for New IP Address**

Licenses are related to the Security Management Server IP address. If you migrate the Security Management Server database to a server with a new IP address, licensing issues can arise. We recommend that you keep the same IP address for the target Security Management Server. If this is not possible, you must prepare the source database before the export and edit the target database after the import ("Completing Migration to a New IP Address" on page 125).

There are additional steps for a Security Management Server that manages VSX Gateways in these configurations:
- From a Security Management Server to a new Domain Management Server or Security Management Server
- From a Domain Management Server to a new Domain Management Server

**On the source computer before migration:**
1. Create a new host object in SmartDashboard with the IP address of the target Security Management Server.
2. Define a firewall rule that lets this new Security Management Server connect to Security Gateways.

<table>
<thead>
<tr>
<th>Source</th>
<th>Destination</th>
<th>Service</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>new server</strong></td>
<td>any</td>
<td>FW1 (TCP 256)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CPD (TCP 18191)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FW1_CPRID (TCP 18208)</td>
</tr>
</tbody>
</table>

3. Install the new security policy on all gateways.
4. For configurations that include VSX Gateways, to these steps:
   a) Define the previous firewall rule again for the VSX policy.
   b) Install the policy on the VSX Gateways.

**Getting the Migration Tools Package**

It is important that you use the correct migration tools package. Download the latest version of the migration tools from the Support Center (http://supportcenter.checkpoint.com). This is the best way to make sure that you get the most recent version.

Alternatively, you can get the migration tools package from the target computer.

**To get the migration tools package from the target computer:**
1. Install R75.40 on the target computer.
2. Copy the complete directory from the target computer to the source computer:
   - SecurePlatform / Gaia: $FWDIR/bin/upgrade_tools
   - Windows: %FWDIR%\bin\upgrade_tools

   Use FTP, SCP or similar. The source directory can be anywhere, such as /var/tmp.

The migration tool files are contained in a compressed package. The files in the package are:
- migrate
- migrate_conf
- upgrade_export
- upgrade_import

**Using the Pre-Upgrade Verification Tool**

We recommend that you run the pre-upgrade verifier (see "Using the Pre-Upgrade Verifier Tool" on page 54) on the Security Management Server source computer before exporting the management database. The pre-upgrade verifier does a compatibility analysis of the Security Management Server database and its current configuration. A detailed report shows the steps to do before and after the upgrade.

The pre-upgrade verifier can only verify a database that is intended for import into a different major version of the Security Management Server. It cannot be used on a database that is intended for import into the same major version of the Security Management Server.

**The pre_upgrade_verifier command**

Go to the migration tools directory. The pre_upgrade_verifier tool is in the downloaded package, and is in the extracted directory. All files from the package must be in the same extracted directory.
Run pre_upgrade_verifier without arguments to see its syntax and options.
Action Items

- **Errors** - Issues that must be resolved before you can continue with the upgrade. If you proceed without correcting these errors, the upgrade may fail, or you may have problems after upgrade.
- **Warnings** - Issues that are recommended to resolve before or after the upgrade.

**Exporting the Database**

**On Gaia and SecurePlatform - CLI**

To create a management database export file on the source computer:

1. Log in to the **expert** mode.
2. Get the R75.40 migration tools.
3. Run:
   ```
   <path to migration tools directory>/migrate export <exported database name>.tgz.
   ```
4. Do the instructions shown on the screen. This creates the `<exported database name>.tgz` file.

**On Gaia and SecurePlatform - GUI on DVD**

To create a management database export file on the source computer:

1. Insert the R75.40 DVD into source computer drive.
2. At the command prompt, run: `patch add cd`
3. Select **SecurePlatform R75.40 Upgrade Package**.
4. Enter `y` to confirm the checksum calculation.
5. You are prompted to create a backup image for automatic revert. There is no need to create a backup image now because exporting the management database does not change the system.
   
   **Note** - Creating a backup image can take up to twenty minutes, during which time Check Point products are stopped.
7. The **welcome** screen opens. Press `n`.
8. Press `Y` to accept the license agreement.
10. Select a source for the upgrade utilities. We recommend that you select **Download the most updated files from the Check Point website** to get the latest files. You can also select **Use the upgrade tools contained on the CD**. Press `N` to continue.
11. If the **Pre-Upgrade Verification** fails, correct the errors and restart this procedure from the step 2. Otherwise, press `N` to continue.
12. In the **Export** window, press `N` to continue. The management database is saved in `/var/tmp/cpexport.tgz`.
13. Press `E` to exit the installation program.

**On IP Appliance**

To create a management database export file on the source computer:

1. Get the R75.40 migration tools.
2. Run:
   ```
   <path to migration tools directory>/migrate export <exported database name>.tgz.
   ```
3. Do the instructions shown on the screen. This creates the `<exported database name>.tgz` file.

**On Windows - CLI**

To create a management database export file on the source computer:

1. Get the R75.40 migration tools.
2. From the Windows command prompt, run:
   `<path to migration tools directory>\migrate.exe export <exported database name>.tgz`

3. Do the instructions shown on the screen. This creates the `<exported database name>.tgz` file.

### On Windows - GUI on DVD

**To create a management database export file on the source computer:**

1. Log in to Windows using **Administrator** credentials.
2. Insert the R75.40 DVD in the optical drive.
   - If the wizard does not start automatically, run `setup.exe` from the DVD.
3. Click **Next** in the **Thank you** window.
4. Accept the terms of the **License Agreement** and click **Next**.
5. Select **Export**.
6. Use one of these options to get the upgrade utilities.
   - Download the most recent upgrade utilities from the Support center (`https://support.checkpoint.com`).
   - Use the upgrade utilities that you downloaded to your local disk.
   - Use the upgrade utilities on the DVD.
7. When prompted, **do not disable** the **Perform Pre-Upgrade verification now** option.

8. If there are pre-upgrade verification errors, correct them and start this procedure again from step 3. Otherwise, click **Next** to continue.

9. Enter path and management database export file name. The default is: `c:\temp\cp_db_configuration.tgz`

10. When the export completes, click **OK**.

### Importing the Database

#### To SecurePlatform

**To import the management database file to the target computer:**

1. Log in to the **expert** mode.
2. Copy the management database file that you exported from the source computer to a directory of your choice on the target computer. Use FTP, SCP or similar.
3. Run:
   `<path to migration tools directory>/migrate import <path to the file>/<exported database name>.tgz`
4. Do the instructions on the screen to import the management database.

#### To IP Appliance

**To import the management database file to the target computer:**

1. Copy the management database file that you exported from the source computer to a directory of your choice on the target computer. Use FTP, SCP or similar.
2. Run:
   `<path to migration tools directory>/migrate import <path to the file>/<exported database name>.tgz`
3. Do the instructions on the screen to import the management database.
To Windows

To import the management database file to the target computer:
1. Copy the management database file that you exported from the source computer to a directory of your choice on the target computer. Use FTP, SCP or similar.
2. From the Windows command prompt, run:
   `<path to migration tools directory>\migrate.exe import <path to the file><exported database name>.tgz`.
3. Do the instructions on the screen to import the management database.

Migrating the Database of a Secondary Security Management Server

To do an advanced upgrade for a Secondary Security Management server:
1. Export the management database file from the primary Security Management Server.
   If the primary Security Management Server is not available, convert the secondary Security Management Server to a primary Security Management Server. To get assistance with this step, contact Check Point Technical Support or your vendor.
2. Install a new primary Security Management Server.
3. Import the management database file to the new primary Security Management Server.
5. Establish SIC with the secondary Security Management Server.

Completing Migration to a New IP Address

Licenses are related to the Security Management Server IP addresses. You must update the license and configure the environment to recognize the new Security Management Server.
1. Update the Security Management Server licenses with the new IP address. If you use central licenses, they must also be updated with the new IP Address.
2. Run `cpstop`
3. Run `cpstart`
4. Connect to the new IP address with SmartDashboard.
   a) Remove the host object and the rule that you created before migration ("Preparing the Source Server for New IP Address" on page 121).
   b) Update the primary Security Management Server object to make the IP Address and topology match the new configuration.
   c) Reset SIC for all SmartEvent distributed servers.
5. Run `evstop` and `evstart` on SmartEvent and SmartReporter distributed servers.
6. On the DNS, map the target Security Management Server host name to the new IP address.

Migrating to a Server with a Different Platform

If you migrate the management database to a server with a platform or operating system that is different from the source server, you must update the primary management object's properties accordingly.

⚠️ Warning - Failure to do so may cause security issues.

After migration:
1. Connect with the SmartDashboard to the target Security Management Server.
2. Edit the primary object:
   - Update the target computer platform.
Update the target computer operating system.

Example:
If you migrate from a Windows Security Management Server to an appliance:
1. Change OS from Windows to SecurePlatform.
2. Change Hardware from Open server to UTM-1.

**SmartReporter Database Migration**

While the database migration procedure automatically migrates the SmartReporter *management* database to the target server, it does not migrate the SmartReporter database. If you have SmartReporter installed on the source server, you must do several additional steps to migrate the database to the target.

**Exporting the SmartReporter Database**

To create the SmartReporter database export file on the source server:
1. Run cpstop.
2. Find and open the MySQL configuration file using a text editor:
   - On Windows: %RTDIR%\Database\conf\my.ini
   Use this file to locate directory names for use in the next steps.
3. Delete the contents of the directory specified in the `innodb_log_group_home_dir= <xxx>` setting.
4. Create the database export file. Assign the name `datadir.tgz` to this file.
   a) Go to the directory specified by the `datadir= <xxx>` parameter in the MySQL configuration file.
      This directory contains the database files.
   b) Use GNU tar/gzip utilities to create an archive file containing all files in the directory specified by the `datadir=<xxx>` setting. For example on SecurePlatform use:
      `tar zcvf datadir.tgz <datadir setting>`
5. Backup these items to a different device (USB drive, CD, FTP server, network location, etc.):
   - The `datadir` export file (datadir.tgz).
   - The MySQL configuration file (my.cnf or my.ini). After copying the file to a backup device, rename the file by appending a .old suffix to the file name. For example, rename file `my.cnf` to `my.cnf.old`. (Import scripts require this suffix.)
   - Company logo image files located in the $RTDIR/bin (%RTDIR%\bin on Windows) directory.
   - Custom distribution scripts located in $RTDIR/DistributionScripts (%RTDIR%\DistributionScripts on Windows).

**Importing the SmartReporter Database**

On the target server:
1. If you have not already done so, install R75.40 and SmartReporter, on the target server.
2. Run cpstop.
3. Copy:
   - For SecurePlatform: `my.cnf.old` to $RTDIR/Database/conf/
   - For Windows: `my.ini.old` to %RTDIR%\Database\conf.

   **Note** - If you are migrating to a platform where the name of configuration file is different (for example, migrating from Windows to SecurePlatform) rename the configuration file accordingly.
4. Copy these files from the backup device to the target server:
• The SmartReporter exported database file (datadir.tgz) to the one of these locations:
  ▪ SecurePlatform: $RTDIR/bin
  ▪ Windows: %RTDIR%\bin
• Company logo image files to the $RTDIR/bin (%RTDIR%\bin on Windows) directory.
• Custom distribution scripts to the $RTDIR/DistributionScripts (%RTDIR%\DistributionScripts on Windows) directory.

Completing the SmartReporter Upgrade
To complete the SmartReporter upgrade:
1. Run:
   EVR_DB_Upgrade -mysql "<absolute path to file>/<SmartReporter database export file>.tgz"
   For example, if datadir.tgz is located in $RTDIR/bin, run:
   EVR_DB_Upgrade -mysql "$RTDIR/bin/datadir.tgz"
2. If you are not using the default directory paths, change these fields in the MySQL configuration file to
   match the locations of these directories:
   datadir=
   innodb_log_group_home_dir=
   innodb_data_file_path=
3. Run cpstart

SmartEvent Events Database Migration
While the database migration procedure automatically migrates the SmartEvent management database to
the target computer, it does not migrate the SmartEvent events database. If you have SmartEvent installed
on the source server, you must do more to migrate the events database to the target.

Note - The Events Database can be very large, and the manual migration take time.

These steps explain how to use the eva_db_backup and eva_db_restore scripts with the default options. By default, the commands are run without options. You must have write permissions for the current directory.

To see more options:
• On SecurePlatform, run: $RTDIR/bin/eva_db_backup.csh --help
• On Windows, run: %RTDIR%\bin\eva_db_backup.exe --help

When upgrading from R70.20 and higher:
1. On the source machine, go to $RTDIR/bin or %RTDIR%\bin.
2. Run the backup tool:
   • On SecurePlatform, run: ./eva_db_backup.csh
   • On Windows, run: eva_db_backup.exe
3. Copy the backup file created by the tool to the destination machine. By default, the name of a backup file is: <current date>-events_db.backup.
4. Run cpopstop on the destination machine.
5. Run the restore tool:
   • On SecurePlatform, run: $RTDIR/bin/eva_db_restore.csh -filename <path to the backup file>
   • On Windows, run: %RTDIR%\bin\eva_db_restore.exe -filename <path to the backup file>
6. Open the eventia_upgrade.C file in $RTDIR/conf or %RTDIR%\conf.
   If it has DONE in online_status or background_status attribute of the Database section, delete DONE
   and save the file.
7. Run: cpstart
When upgrading from a version older than R70.20:

On Source server:
Copy the database file ($RTDIR/events_db/events.sql or %RTDIR%/events_db/events.sql file by default) from source machine to the destination machine.

On Destination server:
1. Run: cpstop
2. Run the PostgreSQL daemon:
   - SecurePlatform: $CPDIR/database/postgresql/util/PostgreSQLCmd start
   - Windows: "%CPDIR\database\postgresql\util\PostgreSQLCmd.exe" start
3. Drop the previous PostgreSQL database content.
   a) Log in to the postgres database:
      - SecurePlatform: $CPDIR/database/postgresql/bin/psql -U cp_postgres -p 18272 postgres
      - Windows: "%CPDIR\database\postgresql\bin\psql.exe" -U cp_postgres -p 18272 postgres
   b) Run: drop database events_db;
      If you get an error that the database does not exist, ignore it.
   c) Run "\q" to exit the database.
4. Run the database upgrade tool twice:
   - DbUpgradeSqliteToPostgres online <full path to events.sql file>
   - DbUpgradeSqliteToPostgres background <full path to events.sql file>
      The second action may take a long time, depending on the Source machine database size.
5. Stop the PostgreSQL daemon:
   - SecurePlatform: $CPDIR/database/postgresql/util/PostgreSQLCmd stop
   - Windows: "%CPDIR\database\postgresql\util\PostgreSQLCmd.exe" stop
6. Open the eventia_upgrade.C file in $RTDIR/conf or %RTDIR%\conf
   If it shows DONE in the online_status or background_status attribute of the Database section, delete DONE and save the file.
7. Run: cpstart
8. Delete the events.sql file from destination machine.

Migrate Command Reference

The migrate command exports a source Security Management Server database to a file, or imports the database file to a target Security Management Server. Use absolute paths in the command, or relative paths from the current directory.

Before you run this command for export, close all SmartConsole clients or run cpstop on the Security Management Server.

Before you run this command for import, run cpstop on the Security Management Server.

Syntax:
migrate (export | import) [-l] [-n] <filename>

Parameters:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>export</td>
<td>One of these actions must be used. Make sure services are stopped.</td>
</tr>
<tr>
<td>import</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><code>-l</code></td>
<td>Optional. Export or import SmartView Tracker logs. Only closed logs are exported. Use the <code>fw logswitch</code> command to close the logs before you do the export.</td>
</tr>
<tr>
<td><code>-n</code></td>
<td>Optional. Run silently (non-interactive) using the default options for each setting. <strong>Important note:</strong> If you export a management database in this mode, to a directory with a file with the same name, it will be overwritten without prompting. If you import using this option, the command runs <code>cpstop</code> automatically.</td>
</tr>
<tr>
<td><code>filename</code></td>
<td>Required. Enter the name of the archive file that contains the Security Management Server database. The path to the archive must exist.</td>
</tr>
</tbody>
</table>
Chapter 9

Upgrading ClusterXL Deployments

In This Chapter

- Planning a Cluster Upgrade  130
- Minimal Effort Upgrade on a ClusterXL Cluster  131
- Zero Downtime Upgrade on a ClusterXL Cluster  131
- Zero Downtime Upgrade of SecurePlatform ClusterXL to Gaia ClusterXL  132
- Full Connectivity Upgrade on a ClusterXL Cluster  132

Planning a Cluster Upgrade

When upgrading ClusterXL, the following options are available to you:

- **Minimal Effort Upgrade**: Select this option if you have a period of time during which network downtime is allowed. The minimal effort method is much simpler because the clusters are upgraded as gateways and therefore can be upgraded as individual gateways.

- **Zero Downtime**: Select this option if network activity is required during the upgrade process. The zero downtime method assures both inbound and outbound network connectivity at all time during the upgrade. There is always at least one active member that handles traffic.
  
  **Note** - During the upgrade procedure, standby members are upgraded first. When upgrade on the final active member begins, the active member fails over to the standby member (or members, depending on the deployment: High Availability or Load Sharing). At this point, since connection tables between cluster members are not synced, all open connections are lost. Only a full connectivity upgrade (between minor versions) preserves open connections.

- **Full Connectivity Upgrade**: Choose this option if your gateway needs to remain active and all open connections must be maintained. There is always at least one active member that handles traffic and open connections are maintained during the upgrade.
  
  **Note** - Full Connectivity Upgrade is supported between minor versions only. For further information, refer to Full Connectivity Upgrade on a ClusterXL Cluster (on page 132) and the R75.40 Release Notes (http://supportcontent.checkpoint.com/solutions?id=sk67581).

Permanent Kernel Global Variables

When upgrading each cluster member, verify that changes to permanent kernel global variables are not lost (see: sk26202). For example, if fwha_mac_magic and fwha_mac_forward_magic were set to values other than the default values, then verify these values remain unchanged after the upgrade.

Ready State During Cluster Upgrade/Rollback Operations

When cluster members of different versions are present on the same synchronization network, cluster members of the previous version become active while cluster members of the new (upgraded) version remain in a special state called **Ready**. In this state, the cluster members with the new version do not process any traffic destined for the cluster IP address. This behavior is the expected behavior during the upgrade process.

To avoid such behavior during an upgrade or rollback, physically or using `ifconfig`, disconnect the cluster interfaces and the synchronization network of that cluster member before beginning.
Upgrading OPSEC Certified Cluster Products

- When upgrading IP appliance clusters (VRRP and IP Clusters), use the Zero Downtime or the Minimal Effort procedure.
- When upgrading third-party clustering products, use the Minimal Effort procedure.
- If the third party vendor has an alternative for a zero downtime upgrade, refer to their documentation before upgrading.

Minimal Effort Upgrade on a ClusterXL Cluster

If you choose to perform a Minimal Effort Upgrade, meaning you can afford to have a period of time during which network downtime is allowed, each cluster member is treated as an individual gateway. In other words, each cluster member can be upgraded in the same way as you would upgrade an individual gateway member. For additional instructions, refer to Upgrading a Distributed Deployment.

Zero Downtime Upgrade on a ClusterXL Cluster

This section includes the procedure doing a zero downtime upgrade. Zero Downtime is supported on all modes of ClusterXL, including IPSO's IP clustering and VRRP. For additional third-party clustering solutions, consult your third-party solution guide.

To perform a zero downtime upgrade, first upgrade all but one of the cluster members. We recommend that you do not install a new policy on the cluster until the last member is upgraded. If you must do this, see Installing a Policy during Cluster Upgrade (on page 132).

To upgrade all but one of the cluster members:

1. To avoid possible problems with switches around the cluster, it is recommended to switch the CCP protocol to Broadcast mode on all cluster members. Run `cphaconf set_ccp broadcast` on all cluster members.

   **Note** - `cphaconf set_ccp` starts working immediately. It does not require a reboot, and it will survive the reboot. If you want to switch the CCP protocol back to Multicast mode on all cluster members after the upgrade, then run `cphaconf set_ccp multicast` on all cluster members.

2. Assume cluster member A is the active member, and members B and C are standby members.
   
   a) In **Load Sharing** mode, randomly choose one of the cluster members to upgrade last.
   
   b) Make sure that the previously upgraded software blade licenses are attached to members B and C.

3. Attach the previously upgraded licenses to all cluster members (A, B and C) as follows:
   
   - On the SmartConsole GUI machine, open SmartUpdate, and connect to the Security Management server. The updated licenses are displayed as **Assigned**.
   
   - Use the **Attach assigned licenses** option to Attach the Assigned licenses to the cluster members.

4. Upgrade cluster members B and C in one of the following ways:
   
   - Using SmartUpdate
   
   - In Place
   
   When the upgrade of B and C is complete, reboot them.

5. In SmartDashboard:
   
   a) From the **Install Policy** window, clear the **For Gateway Clusters, install on all the members, if it fails do not install at all** option located under the **Install on each selected Module independently** option.

   b) In the **Gateway Cluster General Properties** window, change the Cluster version to the new version.

   c) Install the security policy on the cluster.

   The policy successfully installs on cluster members B and C. Policy install fails on member A and generates a warning. The warning can be safely ignored.
6. Using the cphaprob stat command (executed on a cluster member), verify that the status of cluster member A is Active or Active Attention. The remaining cluster members will have a Ready status. The status Active Attention is given if member A’s synchronization interface reports that its outbound status is down, because it is no longer communicating with other cluster members.

7. Upgrade Cluster member A by:
   - Using SmartUpdate
   - In Place
   During the upgrade, cpstop runs automatically, causing A to fail over to members B and/ or C depending on whether this is a Load Sharing or High Availability configuration.

8. Reboot cluster member A.

9. Run cphaconf set_ccp multicast on all cluster members. This returns the cluster control protocol to multicast (instead of broadcast).
   This step can be skipped if you prefer to remain working with the cluster control protocol in the broadcast mode.

**Installing a Policy during Cluster Upgrade**

Installing a new policy on a cluster before the last member is upgraded is not recommended. A policy installation on a member that is not upgraded can cut connections for services that do not survive the policy installation.

If you must install a new policy:

1. Run cpstop on un-upgraded Check Point gateways.
2. Set the Check Point Gateway > Advanced > Connection Persistence tab to Keep all connections or Keep data connections.
   Do not change cluster parameters from the current policy at this time. For example, if the cluster is running in New High Availability mode, do not change it to Load Sharing. Changes can be made after the upgrade process is complete.
3. Run fw ctl set int fwha_conf_immediate 1 on all new Check Point gateways.
4. Install the policy.

   **Important** - Minimize the time that cluster members are running different versions!

**Zero Downtime Upgrade of SecurePlatform ClusterXL to Gaia ClusterXL**

In this procedure, the gateway cluster has an active member (A), and two backup members (B and C). First upgrade B and C, and then upgrade A.

**To do a zero down-time upgrade of a ClusterXL gateway cluster:**

1. Upgrade the backup members (B and C). See Upgrading an Open Server from SecurePlatform to Gaia or Upgrading an Appliance from SecurePlatform to Gaia.
2. Verify that active member (A) is Active, and that B and C are Ready: On each member, run the command cphaprob stat.
3. Transfer traffic to members B and C by stopping traffic on A. On A, run cphastop
4. Upgrade member A, as above.
5. Install the policy on A.

**Full Connectivity Upgrade on a ClusterXL Cluster**

ClusterXL clusters can be upgraded while at the same time maintaining full connectivity between the cluster members.
Understanding a Full Connectivity Upgrade

The Full Connectivity Upgrade (FCU) method assures that synchronization is possible from old to new cluster members without losing connectivity. A full connectivity upgrade is only supported from R75.40 to a future minor version that specifically supports FCU.

Connections that have been opened on the old cluster member will continue to “live” on the new cluster member.

In discussing connectivity, cluster members are divided into two categories:

- **New Members (NMs):** Cluster members that have already been upgraded. NMs are in the “non-active” state.
- **Old Members (OMs):** Cluster members that have not yet been upgraded. These cluster members are in an “active state” and carry all the traffic.

Supported Modes

FCU is supported on all modes of ClusterXL, including IPSO's IP clustering and VRRP. Legacy High Availability is not supported in FCU. For other third-party support, refer to the third-party documentation.

Full Connectivity Upgrade Prerequisites

Make sure that the new member (NM) and the old member (OM) have the same policy and product installation. During the upgrade, do not change the policy from the last policy installed before this upgrade.

Full Connectivity Upgrade Limitations

- This upgrade procedure is equivalent to a failover in a cluster where both members are of the same version. Therefore, whatever would not normally survive failover, will not survive a Full Connectivity Upgrade. This includes:
  - Security servers and services that are marked as non-synced
  - Local connections
  - TCP connections that are TCP streamed
- The exact same products must be installed on the OM and on the NM.
  Verify the installed products by running the command `fw ctl conn` on both cluster members.
  An example output on the NM:

```
Registered connections modules:
No. Name             Newconn  Packet   End      Reload   Dup Type Dup Handle
0: Accounting       00000000 00000000 d08ff920 00000000 Special d08fed58
1: Authentication   d0976098 00000000 00000000 00000000 Special d0975e7c
3: NAT              00000000 00000000 d0955370 00000000 Special d0955520
4: SeqVerifier      d091e670 00000000 00000000 d091e114 Special d091e708
6: Tcpstreaming     d0913da8 00000000 d09732d8 00000000 None
7: VPN              00000000 00000000 d155a8d0 00000000 Special d1553e48
```
  Verify that the list of Check Point Gateway names is the same for both cluster members.
- All the Gateway configuration parameters should have the same values on the NM and the OM. The same rule applies to any other local configurations you may have set.
  For example, having the attribute `block_new_conns` with different values on the NM and on the OM might cause the FCU to fail since gateway behavior cannot be changed during the upgrade.
- A cluster that performs static NAT using the gateway's automatic proxy ARP feature requires special considerations: `cpstop` the old Check Point Gateway right after running `cphastop`. Run `cphastop` as part of the upgrade procedure described in Zero Downtime Upgrade on a ClusterXL Cluster (on page 131). Otherwise, some of the connections that rely on proxy ARP may fail and cause other connections that rely on proxy ARP not to open until the upgrade process completes. Note that running `cpstop` on the old Check Point Gateway rules out the option to roll back to the OM while maintaining all live connections that were originally created on the OM.
Performing a Full Connectivity Upgrade

The procedure for updating a cluster with full connectivity varies according to the number of members in the cluster.

To upgrade a cluster with two members:

Do the steps outlined in Zero Downtime Upgrade on a ClusterXL Cluster (on page 131). Before you do step 7 in this section, run this command on the upgraded member:

fw fcu <other member ip on sync network>

(e.g. fw fcu 172.16.0.1).
Then continue with step 8 of Supported Modes.

To upgrade a cluster with three or more members, do one these:

- Upgrade the two New Members (NMs) by doing the steps in Zero Downtime Upgrade on a ClusterXL Cluster (on page 131). Before you do the "Upgrade cluster member A" step, run this command on all upgraded members:
  
  fw fcu <other member ip on sync network>

  Continue with the Upgrade cluster member A step on the single Old Member (OM).
  
  or

- First upgrade one member by doing the steps in Zero Downtime Upgrade on a ClusterXL Cluster (on page 131). Before you do the "Upgrade cluster member A" step, run this command on all upgraded members:
  
  fw fcu <other member ip on sync network>.

  Continue with Upgrade cluster member A on the remaining Old Members (OMs).

For more than three members, divide the upgrade of your members so that the active cluster members can handle the amount of traffic during the upgrade.

Note - cphastop can also be executed from the Cluster object in the SmartConsole. After cphastop is executed, do not run cpstart or cphastart and do not reboot the machine.

Displaying Upgrade Statistics (cphaprob fcustat)

cphaprob fcustat displays statistical information regarding the upgrade process. Run this command on the new member. Typical output looks like this:

During FCU......................... yes
Number of connection modules..... 23
Connection module map (remote -->local)
  0 --> 0 (Accounting)
  1 --> 1 (Authentication)
  2 --> 3 (NAT)
  3 --> 4 (SeqVerifier)
  4 --> 5 (SynDefender)
  5 --> 6 (Tcpstreaming)
  6 --> 7 (VPN)
Table id map (remote-->local)..... (none or a specific list, depending on configuration)
Table handlers ..................
  78 --> 0xF98EFFD0 (sip_state)
  8158 --> 0xF9872070 (connections)
Global handlers ................... none

The command output includes the following parameters:

**During FCU:** This should be "yes" only after running the fw fcu command and before running cphastop on the final OM. In all other cases it should be "no".

**Number of connection modules:** Safe to ignore.

**Connection module map:** The output reveals a translation map from the OM to the NM. For additional information, refer to Full Connectivity Upgrade Limitations (see "Supported Modes" on page 133).
Table id map: This shows the mapping between the gateway's kernel table indices on the OM and on the NM. Having a translation is not mandatory.

Table handlers: This should include a sip_state and connection table handlers. In a security gateway configuration, a VPN handler should also be included.

Global handlers: Reserved for future use.

Display the Connections Table

This command displays the "connection" table. If everything was synchronized correctly the number of entries in this table and the content itself should be approximately the same in the old and new cluster members. This is an approximation because during time that you run the command on the old and new members, new connections may have been created or old connections were deleted.

Note - Not all connections are synchronized. For example, local connections and services marked as non-synchronized.

Syntax:
fw tab -t connections -u [-s]

Options:
-t - table
-u - unlimited entries
-s - (optional) summary of the number of connections

For more on the fw tab -t connections command, see the Command Line Interface Guide.

You can run the fw fcu command more than once. Be sure to run both cpstop and cpstart on the NM before re-running the fw fcu command. The table handlers that deal with the upgrade are only created during policy installation, and cpstart installs policy.
Index

A
Action Items • 123
Add License Details Manually • 115
Add Packages to the Package Repository • 72
Adding and Activating an R75.40 Package
Using the CLI Shell • 84
Adding and Activating Packages Using Network
Voyager • 84
Adding Licenses using the SmartDomain
Manager • 53
Adding New Licenses to the License & Contract
Repository • 114
Adding New Packages to the Package
Repository • 109
Advanced Upgrade and Database Migration • 119
Attaching Licenses • 115

B
Backing Up • 55
Backup and Restore • 94
Basic Architecture • 47

C
Canceling and Uninstalling • 111
Certificate Authority Information • 93
Changing the Multi-Domain Server Interfaces • 104
Check Point DVD • 110
Checking for Expired Licenses • 116
cma_migrate • 92
cma_migrate and Certificates • 93
Common Operations • 108
Compatibility Tables • 12
Completing Migration to a New IP Address • 125
Completing the SmartReporter Upgrade • 127
Configuring Standalone Full High Availability • 45
Configuring the Security Management Server for SmartUpdate • 72
Container2MultiDomain • 90
Contract Verification • 54

D
Deleting Licenses from the License & Contract
Repository • 115
Deleting Packages from the Package
Repository • 112
Demo Mode • 53
Deployment Options • 14
Detaching Licenses • 115
Disk Space • 13
Display the Connections Table • 135
Displaying Upgrade Statistics (cphaprob fcusstat) • 134
Distributions and Upgrades • 110
Download Center • 109
Download From the User Center • 114
Downloading R75.40 • 10

E
Export • 91
Exporting a License to a File • 116
Exporting a Multi-Domain Server Deployment • 97
Exporting and Importing a Multi-Domain Server • 97
Exporting the Database • 123
Exporting the SmartReporter Database • 126

F
For New Check Point Customers • 10
Full Connectivity Upgrade Limitations • 133
Full Connectivity Upgrade on a ClusterXL
Cluster • 132
Full Connectivity Upgrade Prerequisites • 133

G
Gaia • 17, 18, 29, 32, 34, 37, 39
Gaia Appliances • 42
Gaia Automatic Software Updates • 13
Gateway Upgrade - SmartUpdate • 73
General Workflow • 120
Generating CPInfo • 117
Getting Started • 9
Getting the Migration Tools Package • 122
Glossary • 10
Gradual Upgrade to Another Computer • 99
Gradual Upgrade with Global VPN
Communities • 99

I
ICA Considerations • 59
Important Information • 3
Importing a Multi-Domain Server deployment • 98
Importing License Files • 115
Importing the Database • 124
Importing the SmartReporter Database • 126
Installation Procedure Overview • 20
Installing a Contract File • 60
Installing a Policy during Cluster Upgrade • 132
Installing Full High Availability Appliances • 42
Installing Gateway & Management Features • 30
Installing Log Server • 36
Installing Multi-Domain Security Management • 47
Installing Multi-Domain Security Management
GUI Clients • 51
Installing Multi-Domain Server • 49
Installing SecurePlatform Using the DVD • 30
Installing Security Gateway • 37
Installing Security Gateway on Appliances • 37
Installing Security Gateway on Open Servers • 39
Installing Security Management Server • 32
Installing Security Management Server and
Security Gateways • 15
Installing Security Management Server on
Appliances • 32